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Introduction

 

This preliminary draft of the 

 

Be User’s Guide 

 

accompanies Developer Release 8 of the 
Be™  operating system: DR8 of the BeOS.™  This guide shows you how to set up a 
BeBox,™  it teaches you the basics of the BeOS, the Be user interface, and the Be 
applications, and it introduces you to the process of developing Be applications.

• Chapter 1, “Assembling the BeBox,” shows you how to assemble the BeBox and 
connect a variety of internal and external devices to it.

• Chapter 2, “Learning BeOS Basics,” teaches you the basics of working with the 
BeBox and the BeOS, including turning it on and off, using the keyboard and 
mouse, and managing your files.

• Chapter 3, “Learning Be Application Basics,” introduces you to tasks common to 
most Be applications, such as starting them up, creating and saving files, and 
switching among running applications.

• Chapter 4, “Using Be Applications,” provides instructions for using most of the 
applications that come with the Be software.

• Chapter 5, “Customizing the BeOS,” shows you how to configure the BeOS and to 
set your preferences for a number of its features. It also shows you how to add files, 
such as TrueType™ fonts, that add functionality to the BeOS.

• Chapter 6, “Developing Be Applications,” introduces you to BeIDE, the Be 
development environment, and the procedures you use to develop and debug Be 
applications.

• Chapter 7, “The BeBox Ports,” provides diagrams, pin-out tables, and other 
technical information about the many BeBox ports, from the industry-standard disk 
drive connectors to the unique Be GeekPort.™
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• Appendix A, “Creating Screen Dumps,” shows you how to capture images of the Be 
screen and convert them to a format you can open on other computers.

• Appendix B, “Transferring Files to and from the BeOS,” describes some techniques 
for moving files from the BeOS to other platforms over a network or using floppy 
disks.

• Appendix C, “Troubleshooting,” describes some symptoms of problems users have 
experienced with the BeBox and the BeOS and offers some suggestions for solving 
them.

In addition to this guide, you’ll also want to refer to:

•

 

Installing Developer Release 8 of the BeOS

 

, the booklet that accompanies this user’s 
guide.

•

 

The Be Book

 

, the reference to the Be API, now available in HTML format in the 

 

/documentation/The Be Book

 

 folder, and in PostScript and a variety of archive 
formats on the 

 

BeOS

 

 CD-ROM.

•

 

CodeWarrior Documents for Be

 

, a collection of Metrowerks documentation for the 
Be development environment. These are available in HTML format in the 

 

/documentation/Metrowerks/HTMLDocs

 

 folder.

• The Be world-wide web site: 

 

http://www.be.com

 

, where you’ll find advice on and 
support for developing Be applications, additions and corrections to this guide and 

 

The Be Book

 

, and a great deal of other information about Be, Inc. and the Be 
hardware and software.

• The “Release Notes” and any other last-minute notes that accompany this guide.
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1

 

Assembling the 
BeBox

 

The BeBox comes in a number of configurations, but at a minimum, you need:

• A PC or Microsoft keyboard with 101 or more keys

• A PS/2 or serial mouse

• A high-quality “multisync” monitor

• A PC floppy disk drive

• An IDE or SCSI hard disk drive

• A graphics card (for a list of compatible cards, see “Adding a Graphics Card” on 
page 5)

• 8 megabytes of RAM

• For software installation, a SCSI CD-ROM drive

• An NE2000, 3Com 3C503, DEC 21040, DEC 21041, or compatible network 
adapter (if you want to connect the BeBox to an Ethernet network)

This chapter shows you how to assemble a BeBox with these and other devices. For 
details on the connectors and ports both inside the BeBox and on the back panel, see 
Chapter 7, “The BeBox Ports.”
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Adding Internal Devices

 

To add memory, a graphics card, a network adapter, or internal disk drives, you need to 
open the BeBox.

 

Opening the BeBox

 

Opening the BeBox is easy:

 

1

 

Make sure the BeBox isn’t plugged in and you don’t have any devices connected 
to the external ports.

 

2

 

Unscrew the two thumbscrews on either side of the back panel.

 

3

 

Move the cover forward about two inches and then lift it up and off the internal 
chassis.

 

Working Inside

 

Once the cover is off, it’s easiest to add devices to the inside of the BeBox if you set it 
flat on its side, with the large opening facing up.

If the back panel is to your left, you can see the steel housing of the power supply on the 
upper left, next to the back panel. The drive bays are to the right of the power supply: 
One bay hangs from the top of the BeBox, the other is connected to the front. The 

 

motherboard

 

 is the large circuit board on the bottom, with the I/O board plugged into it 
perpendicularly, on the left side.
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The motherboard has slots for 3 PCI cards, 5 ISA cards, IDE drives, SCSI drives, floppy 
disk drives, and 8 SIMMs (Single In-line Memory Modules). Take a moment to find 
these connectors on the motherboard, using the following diagram:
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Adding Memory

 

You can add up to 256 MB of RAM to the BeBox by inserting identical pairs of 2, 4, 8, 
16, 32, 64, or 128 MB, 60-nanosecond or faster, 72-pin SIMMs in memory slots 0 and 1, 
2 and 3, 4 and 5, or 6 and 7.While each pair of SIMMs must be made up of identical 
twins, no two sets of twins must be alike: For example, you could insert 32 MB SIMMs 
in slots 0 and 1 and 2 MB SIMMs in slots 2 and 3. Add SIMMs to the slots in order—
start with slots 0 and 1 and don’t leave a gap between the slots. The BeBox can use 
parity SIMMs, but it doesn’t yet support parity-checking.

To add a SIMM module, start with the top empty SIMM slot (the one with the lowest 
number). With the notch on the SIMM’s connector edge to the left (nearer the back 
panel), slide the SIMM into the slot at a 45-degree vertical angle—that is, with the 
connector edge of the SIMM closer to the top of the BeBox than the edge nearer to you. 
When the SIMM is all the way into the slot, lift up the edge nearer you so the SIMM 
snaps into place (it’s held in the slot by a pair of metal clips).

To remove a SIMM module, start with the bottom SIMM (the one in the slot with the 
highest number). Release the SIMM by pushing the two metal clips away from the 
SIMM while gently pushing down on the edge of the SIMM. When it’s free from the 
clips, lift it out.

 

Inserting ISA and PCI Cards

 

You can add up to 5 ISA and 3 PCI cards to the BeBox. The ISA and PCI slots are on the 
motherboard, as shown in the diagram on page 3. You can insert cards in any slot: Order 
and slot number make no difference.

 

1

 

Unscrew the metal plate that covers an unused slot’s opening through the back 
panel. Save the screw—you’ll need it in a moment.

Store the metal plate someplace safe, in case you ever remove the card from the 
slot. The plate helps keep dust out of the BeBox and reduces electromagnetic 
interference.
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2

 

Insert the card in the slot.

It’s best to start by lining up the gold “fingers” on the connecting edge of the card 
with the slot, and the metal connector plate with the opening through the back 
panel. Make sure the card is started into the slot correctly. Then firmly push the 
card all the way into the slot.

 

3

 

Replace the screw you removed in step 1.

The screw keeps the card from coming loose, particularly when you’re connecting 
a cable to the card.

 

Adding a Graphics Card

 

Currently, the BeBox works with a number of PCI graphics cards based on graphics 
chips manufactured by Cirrus Logic and S3. You can insert a graphics card into any one 
of the three PCI slots.

For the most current list of supported graphics cards, visit the Be products area on the 
Be web site (

 

http://www.be.com/products

 

).

At the time this guide is being written, you can use any graphics card based on the 
Cirrus 5430, 5434, 5436, and 5440 family of chips. For example, the BeBox has been 
tested with the Orchid Kelvin 32 (based on the 5430), the Orchid Kelvin 64 (based on 
the 5434), the Diamond SpeedStar Pro SE (based on the 5430), and the STB Nitro 64 
(based on the 5434). Cards that are based on the Cirrus 5434 or 5436 and have 2 MB of 
RAM can display the BeOS with 8 or 32 bits of color data per pixel. Cards that are based 
on the other two Cirrus chips or that only have 1 MB or RAM can display the BeOS 
with 8 bits of color data per pixel.

You can also use a graphics card based on the S3 Vision 864 (combined with the 
ATT21C498 RAMDAC chip) and S3 Vision 964 (combined with the TVP3025 
RAMDAC chip). For example, the BeBox has been tested with the #9 GXE64 (based on 
the Vision 864) and the #9 GXE64 Pro (based on the Vision 964). With 2 MB of RAM, 
these cards display the BeOS with 8 or 32 bits of color data per pixel. With 1 MB of 
RAM, the #9 GXE can display the BeOS with 8 bits of color data per pixel.
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You set the number of colors per pixel, the resolution (the number of pixels on the 
screen), and other settings for how the BeOS is displayed with the Screen preferences 
application. See “Screen” on page 135.

Third-parties are writing drivers, so you can expect to see support for more graphics 
cards soon. For more information about writing drivers, see 

 

The Be Book

 

, the “ReadMe” 
file that accompanies the S3 sample project (

 

/develop/projects/s3/ReadMe

 

), and the Be 
web site (

 

http://www.be.com

 

). The “ReadMe” file also provides additional information 
about features supported by cards based on S3 chips.

 

Adding a Network Adapter

 

You can add one or more Ethernet network adapters to the BeBox. With a network 
connection, you can use the 

 

ftp

 

 and 

 

telnet

 

 utilities to connect to other computers on a 
network and transfer files. If the Ethernet network has a connection to the Internet, you 
can even surf the world-wide web.

You use the Network preferences application to configure the BeBox to use the network 
adapters you add. You can also use Network to configure the BeBox to communicate 
with another computer using a modem or a direct serial connection. See “Network” on 
page 128.

Three kinds of Ethernet network adapters work with the BeBox: The NE2000, 3Com 
3C503, and the DEC 21040 or 21041. You can also use any of the many models of 
network adapters that are compatible with the NE2000.

Most ISA network adapter cards come set to IRQ 3 and I/O port 300. The BeBox serial 
ports use IRQ 3, so you must change the network adapter’s IRQ before you install it. 
The default value in the Be networking software is IRQ 5 and port 300, but you can use 
IRQ 5, 9, 10, 11, 13 or 15 and I/O port 220, 240, 280, 2A0, 2C0, 300, 320, 340, or 3C0. 
If you add more than one network adapter, you must set each to a unique IRQ and I/O 
port.

For information on changing network adapter settings, see the owner’s guide that came 
with the adapter.
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Adding an Internal Disk Drive

 

The BeBox has two internal 

 

drive bays

 

—metal frames where you can mount disk drives. 
One drive bay hangs from the top of the BeBox’s internal chassis, the other bay is 
connected to the front. You can mount up to two 3.5-inch drives in the top bay. You can 
mount a floppy disk drive in the bottom section of the front bay, plus either one full-
height 5.25-inch or two half-height drives in the front bay. If you have the appropriate 
mounting brackets, you can also mount 3.5-inch drives in the 5.25-inch area of the front 
bay.

You add an internal disk drive by removing a bay, mounting the drive in the bay, 
replacing the bay, and then connecting the drive to the motherboard.

 

Removing a Drive Bay

 

1

 

Disconnect any cables connected to drives already mounted in the bay you want to 
remove.

 

2

 

Remove the screws that hold the bay in place.

The top bay is held in place by screws through the top of the BeBox’s internal 
chassis.

The front bay is held in place by screws through the front of the BeBox’s internal 
chassis.

Support the bay with your hand as you remove the last screw, so it doesn’t fall.

 

3

 

Remove the bay.

Once the screws are removed, the top bay is held only by metal flanges hanging 
from the top of the BeBox. You tilt the bay down a bit and slide it out.

The front bay slides straight out of the front of the BeBox.
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Mounting a Drive in the Top Drive Bay

 

Remove the drive bay from the chassis, as described above. Then slide the drive into 
either the left or right side of the bay, with the circuit-board face of the drive facing 
down. Align the screw holes on the circuit-board face of the drive with the mounting 
holes on the bottom of the bay. Then screw the drive to the bay, using the screws that 
came with the drive.

 

Warning:

 

 Some 3.5-inch drives have components that stick so high above the circuit-
board face of the drive that they will form an electrical connection that will likely 
destroy the drive if you mount it without insulating these components from the drive 
bay. If you’re not sure how to insulate components, get advice from someone with 
experience assembling computers.

 

Mounting a Drive in the Front Drive Bay

 

Remove the drive bay from the chassis, as described above. Slide the drive into the bay. 
Align the screw holes on the side of the drive with one of the sets of mounting holes on 
the sides of the bay. Then screw the drive to the bay, using the screws that came with the 
drive. If you installed a floppy disk drive, CD-ROM drive, or another drive that uses 
removable media, remove the corresponding cover plate from the 

 

bezel

 

, the plastic cover 
on the front of the cover of the BeBox. If the panel is attached to the cover with screws, 
remove the screws first. Then simply push the panel in until it’s free.

 

Replacing a Drive Bay

 

Reverse the steps you followed to remove the drive bay. Be sure to replace the screws 
that secure the bay to the internal chassis.
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Connecting a Drive to the BeBox Motherboard and Power Supply

 

After you mount a drive in a drive bay and replace the bay in the chassis, you can use the 
cables that come with the BeBox to connect the drive to the BeBox motherboard and 
power supply.

 

1

 

Use one of the provided ribbon cables to connect the drive to the appropriate drive 
connector on the motherboard.

Ribbon cables must be connected with the correct orientation: Make sure pin 1 in 
the connectors on the motherboard and on the drive are aligned with pin 1 on the 
cable. On most cables, the edge of the ribbon carrying the signal for pin 1 is 
marked with a line or with stripes.

If you’re connecting a SCSI device, use the connectors at both ends of the SCSI 
ribbon cable first, and only use the connectors in the middle of the cable to attach 
additional devices. Make sure the device at the end of the ribbon cable is 
terminated. Also make sure that each SCSI device has a unique SCSI ID, from ID 
0 through 6 (ID 7 is reserved for the SCSI controller on the motherboard). For 
instructions on terminating a SCSI device and setting its SCSI ID, see its owner’s 
guide.

 

2

 

Plug one of the plastic power supply connectors into the drive.

 

Connecting a CD-ROM Drive to the I/O Board

 

You can use a “pass-though cable” to connect an internal CD-ROM drive to the BeBox 
I/O board. With a pass-through cable, you can listen to audio CDs on the BeBox’s 
internal speaker and through the line-out and headphone ports. You can also save 
sections of CD audio tracks as disk files. (For more information on listening to CDs, see 
“CDPlayer” on page 80.) 

Pass-through cables are available at larger electronics supply stores. (One source is TTS 
Multimedia Systems, 2045 San Elijo Ave., Cardiff, CA 92007, (800) 887-4968.) Make 
sure you buy a pass-through cable that has a connector for your brand of CD-ROM drive 
at one end, and a connector compatible with a MediaVision ProAudio Spectrum 16 card 
at the other (this is the end you connect to the I/O board).
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Connect the pass-through cable’s ProAudio Spectrum 16 connector to the connector on 
the I/O board: The connector is on the corner of the card farthest from the power supply 
and the motherboard. Then connect the other end of the pass-through cable to the CD-
ROM drive.

 

Closing the BeBox

 

When you’re done adding internal devices, put the cover back on. This protects you and 
the internal components from each other, and reduces electromagnetic interference.

 

1

 

With the cover positioned over the internal chassis, but about two inches farther 
forward, lower the cover into place.

 

2

 

Make sure the floppy disk drive and the corresponding opening in the bezel are 
aligned. Then slide the cover back until it’s closed.

 

3

 

Tighten the thumbscrews in the back panel.
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Connecting External Devices

 

You can refer to the following diagram to identify the ports on the back of the BeBox:

Be, Inc.
Menlo Park, CA



 

Connecting External Devices
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1

 

Make sure the switch between the two power sockets on the back of the BeBox is 
set to the correct voltage.

 

Warning: 

 

The voltage switch has two settings: 115 volts and 230 volts. The switch 
is initially set to 115 volts, which is the correct setting in North America. Outside 
of North America, make sure the switch matches the voltage in your area. If the 
voltage switch is set incorrectly when you turn on the BeBox, you risk destroying 
the BeBox.

 

2

 

Plug one end of the power cable into the back panel of the BeBox and the other 
end into a grounded, three-prong electrical outlet.

 

Warning: 

 

You must electrically ground the BeBox using the power cable provided 
by Be. The power cable includes a three-prong plug—a plug with a grounding 
pin—that will only fit in a three-prong grounded outlet. The grounding pin is for 
the safety of the BeBox and—more important—for your safety. If you don’t have 
a grounded outlet, hire a licensed electrician to install one. Do not circumvent the 
three-prong plug by finding a way to plug it into an outlet that isn’t grounded!

 

3

 

Connect the keyboard to the keyboard port on the back panel.

 

4

 

Connect the mouse to the appropriate port on the back panel.

You can connect a serial mouse to any one of the four serial ports.

You connect a PS/2 mouse to the Mouse port.

When you turn on the BeBox, it finds the mouse wherever you connected it.

 

5

 

Plug the monitor’s power cord into a grounded outlet or—if you have the 
appropriate plug—into the socket on the back of the BeBox. Then connect the 
monitor to the port on the graphics card in a PCI slot. 

 

6 If you installed a network adapter card, use an Ethernet cable to connect it to your 
network.

If you don’t maintain the network at your location, be sure to check with your 
system administrator before connect the BeBox to the network. (Configuring the 
BeBox to communicate over the network is described in “Network” on page 128.)
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Connecting a SCSI CD-ROM Drive

To install the Be operating system from the BeOS CD-ROM, you need to connect a 
SCSI CD-ROM drive to the BeBox’s external or internal SCSI port. (IDE CD-ROM 
drives are not currently supported.) The external SCSI port is just below the On/Off 
switch on the back panel. Follow the directions that came with the CD-ROM drive to 
terminate the drive properly (as a rule, terminate the drive if it’s the only SCSI device 
connected to the internal or external SCSI port on the BeBox, or if it’s at the end of a 
chain of SCSI devices). You can set the CD-ROM drive to any SCSI ID, except SCSI 
ID 7, but remember that if you connect more than one SCSI device to the BeBox, each 
device must have a unique SCSI ID.

Connecting Joysticks

You can connect up to 4 standard PC joysticks to the two BeBox joystick ports. You can 
connect one joystick directly to each port, or use a standard Y connector to connect two 
joysticks to each port.

Connecting a Printer

If you have an HP LaserJet IIp or compatible printer, you can connect it to the BeBox 
parallel port. A few applications in DR8 support basic printing. Look for support for 
more printers in future releases of the BeOS.

Finishing Up

Once you’ve assembled the BeBox, you can install the BeOS on its hard disk. Installing 
Be software is described in Installing Developer Release 8 of the BeOS, the booklet that 
accompanies this user’s guide.

If the BeBox already has DR8 installed, you can simply turn on the power switch and 
start using it. The next chapter starts with instructions for turning the BeBox on and off 
safely. Then it shows you the basics of using the BeOS.
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2 Learning BeOS 
Basics

This chapter shows you the basics of working with the BeBox and the BeOS: Turning 
the BeBox on and off, working with the mouse and keyboard, and mastering the 
fundamentals of the user interface. The next chapter picks up where this one leaves off, 
showing you the basic techniques you use with Be applications. Subsequent chapters 
show you how to use the applications that come with the BeOS.

Turning the BeBox On and Off

Once you’ve set up the BeBox and installed the BeOS, you can turn on the BeBox and 
start using it.

Note: As soon as you’re comfortable with the BeOS and Be application basics, it’s a 
good idea to use the Time preferences application to set the BeBox’s internal clock to 
the correct time, as described in “Time” on page 140.

Turning On the BeBox and Starting the BeOS

1 Make sure there’s no floppy disk or CD-ROM that contains Be system software 
inserted in a drive connected to the BeBox.

When you turn on the BeBox, it tries to find system software on removable disks 
first. Then it looks for system software on a hard disk. For more information, see 
“Selecting a Boot Disk” on page 16.
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2 Turn on any peripheral devices, such as the monitor or external disk drives.

3 Turn on the BeBox.

The BeBox On/Off switch is a toggle-style switch on the top of the back panel. 
Pushing the toggle up turns on the BeBox; pushing it down turns it off.

When you turn on the BeBox, the Be logo appears for a moment. Then the BeBox loads 
the BeOS system software from the startup disk (this is often called “booting”). As the 
BeOS boots, it performs some housekeeping tasks, which it may inform you about. 
Then the BeOS starts the Browser application. The Browser is where you manage the 
work you do on the BeBox: Arranging and opening files, starting applications, and so on 
(the Browser is described in detail in “Working with the Browser” on page 41). 

When the BeBox is on, two columns of LEDs (Light-Emitting Diodes) become active 
on the front of the BeBox. The green LEDs at the bottoms of the columns act as power 
indicators: They glow whenever the BeBox is turned on. The upper LEDs show the 
relative load on the BeBox’s two PowerPC processors: The more LED’s are lit, the 
harder the PowerPCs are working. (The Pulse application provides a similar display, as 
described in “Pulse” on page 113.) The amber LED at the bottom of the right column is 
a disk activity light: Whenever the BeOS uses an IDE or SCSI disk, the amber LED 
glows.

Selecting a Boot Disk

When you turn on the BeBox, it looks in a fixed order for a disk to start up (or “boot”) 
from. First, it looks for system software on a floppy disk. If it doesn’t find a floppy disk 
with system software, it then looks for any other kind of removable disk, such as a CD-
ROM. If it doesn’t find a removable disk with system software, it checks the “boot 
preference”—a setting stored in a chip on the motherboard—to determine what disk you 
prefer to use as the boot disk. The BeBox then tries to boot from the disk specified in the 
boot preference. If for some reason the preferred disk isn’t available or doesn’t contain 
system software, the BeBox tries to boot from any other available disk with system 
software on it.

The boot preference is initially set to the master IDE disk. (If the BeBox comes with the 
BeOS installed on a SCSI disk, the boot preference is set to that disk.) If you install the 
BeOS on another disk, the Installer asks if you want to change the boot preference to 
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that disk. You can change the boot preference at any time with the Boot preferences 
application, as described in “Boot” on page 119.

Regardless of the boot preference and what disks are inserted or attached, you can select 
the disk you want to boot from by pressing and holding down any key right after you 
turn on the BeBox—as soon as you see the Be logo start to appear. The boot selection 
screen opens, complete with instructions for how to use it:

Each bootable disk is listed by its device name as well as by the name it has in the 
Browser. Disks that don’t have Be system software on them aren’t included in the list.

Caution: Don’t select the “Erase their databases” option without first reading 
“Rebuilding the Database” on page 205.

For more information about SCSI IDs and IDE disks, see “Adding an Internal Disk 
Drive” on page 7 and “Connecting a SCSI CD-ROM Drive” on page 13.

Select boot options and press Enter.
Or press Escape to use current boot preferences.

Use the up and down arrow keys to select options.
Use the Tab key to switch sets of options.

Select a boot disk:
>> /dev/ide_disk_master (Be disk ‘Boot Disk’)
   /dev/scsi_disk_000 (Be disk ‘Data Disk’)
   Rescan for bootable disks

After booting from selected disk:
>> Mount other disks
   Don’t mount other disks

When mounting these disks:
>> Preserve their databases
   Erase their databases
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Shutting Down the BeOS and Turning Off the BeBox

Before you turn off the BeBox, you must first shut down the BeOS. Shutting down 
ensures that any open files—including system files—are saved to disk correctly. If you 
turn off the BeBox without first shutting down, you risk losing information.

1 Save any open files and quit any running applications.

Saving files and quitting applications are described in the next chapter.

2 Choose Shut Down from the Browser’s main menu.

The main menu is just to the right of the application list, at the top-left corner of 
the screen. For more information about menus, see “Working with Menus” on 
page 36.

If you just want to restart the BeBox instead of turning it off, choose Restart from 
the main menu instead.

If the Browser is busy copying or moving files or emptying the trash when you 
choose Shut Down or Restart, a panel asks you to confirm that you want to shut 
down or restart the BeOS when these tasks are complete.

3 When a panel tells you it’s safe to turn off the BeBox, turn it off. You can also 
click the Restart button in the panel (or press the Enter key) to restart the BeBox 
right away, without turning it off.

4 After you’ve shut down the BeOS and turned off the BeBox, turn off any 
peripheral devices that have their own power switches, such as the monitor or 
external disk drives.
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Resetting the BeBox

If the BeOS crashes, or if the Shut Down and Restart commands don’t work, you can 
restart the BeBox (without turning it off and on) by resetting it.

There are two ways to reset the BeBox. The nostalgic way is to press “Control-Alt-
Delete.” In other words, to press the following three keys at the same time: The key 
labeled “Ctrl” at the bottom left of the keyboard (not the one next to the arrow keys); 
either one of the two keys labeled “Alt” on either side of the space bar; and either the key 
labeled “Del” on the numeric keypad or the key labeled “Delete” above the arrow keys. 
(For more information about the keyboard, see “Using the Keyboard” on page 23.) The 
other way to reset the BeBox is to press the Reset and Interrupt buttons at the same time. 
The Reset and Interrupt buttons are built into the BeBox front bezel, on the horizontal 
surface below the floppy disk drive.

Caution: If you restart the BeBox without choosing Shut Down first, you risk losing 
data. In particular, you’ll lose any changes you’ve made to open files since you last 
saved them. You also risk corrupting the Be database. If you corrupt the Be database, 
you may need to rebuild it. For details, see “Rebuilding the Database” on page 205.

Interrupting the BeBox

Caution: In the prerelease version of the BeOS, the interaction between the Interrupt 
button and the Debugger is broken, so you shouldn’t use the Interrupt button.

If you’re using the Be Debugger, you can interrupt the BeBox and open a debugger 
window. (Using the Debugger is described in “Using the Be Debugger” on page 167.)

To interrupt the BeBox, press up on the Interrupt button. The Interrupt button is on the 
horizontal surface underneath the right side of the floppy disk drive, just above the right 
LED array.

If you press the Interrupt button accidentally, type g and press Enter to tell the BeBox to 
continue doing what it was doing when you interrupted it. Then close the Debugger 
window.
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Getting to Know the BeOS Workspace

When you start the BeOS, the Browser starts up and the dock appears along the left side 
of the Be workspace. The background of the workspace is called the desktop—initially a 
solid blue area where windows open and you do your work.

The 
dock

The application list

The main menu

A window

The desktop

The cursor
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Take a moment to identify the following features of the Be workspace:

• The cursor is the hand-shaped icon that moves when you move the mouse. 
Working with the mouse and using the cursor are described in “Using the Mouse” 
on page 22.

• The dock is a convenient place to keep icons for applications, files, and other 
items you use often. See “Working with the Dock” on page 51.

• The application list lists all running applications. You use it to switch 
applications, as described in “Switching Applications” on page 60.

• The main menu contains menu items for the active application—the application 
you’re currently working with. For more information, see “Working with Menus” 
on page 36.

• Windows are where you view and work with files, text, pictures, and other 
information. See “Working with Windows” on page 25.

• The BeBox icon, at the top of the dock, opens a window that lists mounted disks. 
See “Working with Disks” on page 45.

• The Mailbox icon opens a window that lists the e-mail you’ve received. For more 
information, see “BeMail” on page 74.

• The Queries icon opens a window with the Be database queries you’ve created, as 
described in “Opening a Query” on page 57.

• The People icon opens a window that lists “people” entities in the Be database. 
Initially, there’s only one person in the database, but you can add people and their 
e-mail addresses as described in “Creating E-Mail” on page 79.

Though most of this guide concentrates on showing you how to work in this initial 
workspace, you can create up to 32 workspaces and switch among them using the 
Workspaces application. For details, see “Workspaces” on page 117.
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Using the Mouse

You use the mouse to control the cursor, to select items, to manipulate the controls in 
windows and panels, to choose menu items, and to perform many other tasks. When you 
move the mouse, a small icon called the cursor moves across the screen. The cursor 
changes shape depending on what you’re doing: A hand  for selecting items and 
choosing from menus, an I-beam  for selecting text, and so on.

You use the mouse buttons to manipulate the items on screen that are underneath the 
cursor. The BeBox can take advantage of one-, two-, and three-button mice. On a three-
button mouse, the left mouse button is initially the primary mouse button, the button you 
click to perform the most common tasks; the right button is the secondary mouse button; 
and the middle button is the tertiary mouse button. You can change the role of the mouse 
buttons with the Mouse preferences application. For example, if you’re left-handed, you 
can make the right mouse button the primary mouse button. For details, see “Mouse” on 
page 127.

There are a few basic techniques (and terms that describe them) for using the mouse that 
you should learn before continuing with this guide:

Move Move the mouse without pressing a mouse button

Click Press and quickly release a mouse button without 
moving the mouse

Press Press and hold down a mouse button without moving 
the mouse

Drag Press and hold down a mouse button while you 
move the mouse

Double-click Press and quickly release a mouse button twice 
in quick succession

Triple-click Like double-clicking, but thrice

Double-click and drag Like double-clicking, but hold down a mouse button 
instead of releasing it the second time, then move 
the mouse

You can adjust how the BeOS interprets multiple clicks and how rapidly the cursor 
moves across the screen when you move the mouse (see “Mouse” on page 127).
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Using the Keyboard

In addition to using the keyboard to type text, you also use it to modify the action of the 
mouse, to select items, to choose menu items, and to perform many other tasks. The 
keyboard has two main parts: The main keyboard and the keypad. Along the top of the 
keyboard are the Escape key and function keys. Between the main keyboard and the 
keypad are more function keys, plus the arrow keys.

Cmd Option

Shift

Enter

Backsp.

Ctrl Cmd

Shift

Caps

Tab

Esc

Num

The right “Ctrl” key is 
actually the Option key, for 
typing special characters.

You can use either Command 
key (usually labeled “Alt”) to 
choose menu items.

Arrow keys

KeypadFunction keysMain keyboard
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Most of the keyboard keys should be familiar to you from typing class. However, the 
BeBox uses some of the keys in ways you might not guess:

Key Label Key Name Function

Alt Command Used in conjunction with other 
keys as a shortcut to choosing 
menu items.

Ctrl (on left) Control Used to type special characters, 
particularly when you’re 
working in the Terminal 
application.

Ctrl (on right) Option Used to type special characters, 
such as symbols and accented 
characters.

Enter (or arrow) Enter Used to end a paragraph when 
you’re typing. Also used as a 
shortcut for clicking on-screen 
buttons, opening files, and other 
common tasks.

Esc Escape Used as a shortcut to clicking
Cancel in many panels and to 
close open menus.

Tab Tab Used to type the tab character. 
Also used to select objects in
windows and panels so you 
can manipulate them from
the keyboard.

(arrows) arrow keys Used to move the cursor in text, 
to select items, and so on.

Using the keyboard is described throughout this guide. In particular, see “Typing 
Special Characters” on page 67, “Navigating Menus from the Keyboard” on page 40, 
and “Navigating Windows and Panels from the Keyboard” on page 70. For information 
about how the BeBox maps the characters you see on screen to the layout of the keys on 
the keyboard, see “Keymap” on page 124 and “FontChart” on page 97.
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Working with Windows

The BeOS displays information in windows, areas on the screen with some of all of the 
following features:

Close 
button

Window
 title

Menu titles in 
a menu bar

Scroll arrows

Scroll knob

Resize knob

Scroll bar

Window tab

Window 
content 
area

Zoom 
button
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Most windows have a tab at the top, with the title of the window and one or more 
buttons. In the Browser, the title usually tells you the name of the folder whose contents 
are shown in the window. (For details, see “Working with the Browser” on page 41.)

You can have one or many windows open at a time, but only the active window responds 
to your actions. For example, pressing keys on the keyboard only affects the active 
window. Even when windows aren’t overlapping, you can tell which is the active 
window by its tab: The active window has a yellow tab.

You make a window the active window by clicking its border or (for most windows) 
anywhere in it. When you start up a new application or switch applications, the 
frontmost window in the new application becomes the active window.

Moving a Window

You move a window by dragging it by its border. The border includes the tab and the 
gray area on the edges of windows where there’s no scroll bar. For most Browser 
windows, this means you can drag the window by its left and top borders, including the 
tab. You can drag other windows, panels, and palettes by any border.

When you drag a window by its tab, take care not to click the close or zoom button 
accidentally.
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Resizing a Window

You can change the size and dimensions of a window by dragging its resize knob. The 
resize knob can be a box-shaped area or just a special part of the bottom-right corner of 
the window’s border—depending on whether the window has scroll bars.

You can also click a window’s zoom button (the  icon the window’s title bar) to make 
it as big as need be to show all that it contains—or at least as big as the screen. Clicking 
the zoom button again restores the window to its previous size.

In the Browser, choosing the Resize to Fit command from a window’s Window menu 
has the same effect as clicking its zoom button.

Scrolling the Items in a Window

Sometimes a window contains more icons, more text, or a bigger picture than can fit in 
the window. You can move the contents of the window within the window to see the 
items or parts of the document that aren’t visible. This is called scrolling.

When a window contains more than you can see in it, its scroll bars become active to 
show that you can scroll to see more. Initially, BeBox windows have proportional scroll 
bars, so called because their scroll knobs change size to give you a rough idea of what 
proportion of the contents of a window is visible: When you can see almost everything 
the window contains, the scroll knob is almost as long as the scroll bar; but when you 
can only see a tiny part of what the window contains, the scroll knob becomes small in 

Drag either kind of resize 
knob to resize a window.
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relation to the whole scroll bar. You can turn off proportional scroll bars, change the 
look of the scroll knob, and set some other options for how scroll bars work with the 
ScrollBar preferences application, as described in “ScrollBar” on page 138.

The simplest way to scroll is to click or press a scroll arrow. But there are lots of other 
ways to scroll:

Do This To

Click a scroll arrow move the contents of the window a little

Press a scroll arrow keep moving the contents of a window a slowly

Drag a scroll knob scroll the contents of the window quickly

Click in a scroll bar scroll all the way in that direction

This scroll knob 
indicates that 
about a third 
of the 
contents of 
the window is 
visible, and 
about two-
thirds of the 
contents are 
out of view, 
below.

This scroll knob indicates that only a small portion of the 
contents of the window is out of sight to the right.
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When you’re working in the Browser, you can also:

Do This To

Press Page Up scroll up a windowful

Press Page Down scroll down a windowful

Press Home scroll all the way to the top

Press End scroll all the way to the bottom

The content of a window also scrolls when you select an item that’s not in view, for 
example, when you use the arrow keys to select items in a Browser window.

Zooming a Window

You can quickly increase the size of a window by clicking its zoom button. In the 
Browser, clicking the zoom button is the same as choosing the Resize to Fit command 
from a window’s Window menu: The window becomes as large as necessary to display 
everything in it. Click the zoom button again to return the window to it’s previous size 
and location. Some applications use the zoom button slightly differently. For example, 
when you click the zoom button in the Workspaces application’s window, it moves the 
window to the lower-right corner of the screen.
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Minimizing a Window

If you begin to have more windows open than is convenient, you can minimize one or 
more windows. Minimizing a window hides all of the window except its tab. To 
minimize a window, double-click it’s tab (but be careful not to double-click the close or 
zoom button). Tabs of minimized windows are initially laid in rows across the bottom of 
the desktop. If you prefer a different organization of minimized windows, you can drag 
tabs to wherever you want on the desktop.

You can 
drag tabs of 
minimized 
windows 
where you 
want them.

Double-
click a 
minimized 
window’s 
tab to 
open the 
window.

Double-
click a 
window’s 
tab to 
minimize 
the window.

Initially, tabs of minimized windows are 
tiled along the bottom of the desktop.
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To restore a minimized window to its original size and location, double-click its tab 
again. Other ways to open minimized windows include:

Type of Window Way to Open It

Folder Double-click its icon: In the dock or in the window 
that contains it.

Document Same as for folder windows. Also, open the document 
with the Open command. If an application has only 
minimized windows, switching to that application by 
double-clicking its icon or choosing it in the application 
list opens one of its windows.

You can click the close button in the tab of a minimized window to close the window. If 
the window contains changes you haven’t saved, you’re asked if you want to save the 
changes before closing the window.

Selecting Items

To work with an item in a window, you first select it. Selected items usually change 
color to show that they’re selected. For example, when you click an icon in a Browser 
window, it becomes darker (or highlighted).

unselected items selected items
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Besides clicking, there are lots of techniques and shortcuts for selecting items. The 
following table summarizes ways you can select items in Browser windows, query 
windows, and some panels, such as the Open and Save panels.

Do This To

Click an item Select it

Drag from an empty Select the items you drag across
place in a window 
across one or more 
items

Type one or more Select the item that starts with that letter or letters
letters

Press an arrow key Select the next item, in the direction of the arrow

Press the Tab key Select the next item, in alphabetical order

Hold down the Shift Select the next item, in reverse alphabetical order
key while you press
the Tab key

Hold down the Shift Select or deselect additional items
key while you click,
drag, or type

Choose Select All Select all the items in the window
from the File menu

Changing Views

Initially, the items in Browser windows are displayed as large icons with their names 
underneath them. If you prefer, you can view the items in the window as small icons 
with their names to the right. You can also view the items in the window in an ordered 
list view, which can tell you additional information about the items in the window. List 
views are also used in query windows, as well as some panels, such as the Open and 
Save panels.

You change views by choosing Icon View, Mini Icon View, or List View from a 
window’s Window menu.
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Working in Icon and Mini Icon View

Icons are easiest to recognize in icon view.

It’s easiest to work with a lot of icons in mini icon view.
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When you’re working in icon view or mini icon view, you can move one or more items 
in a window to a new location in that window—perhaps to group related items in the 
same part of the window. Simply drag an item to the location you want. If more than one 
item is selected, they all move when you drag one of them. If you hold down the 
Command key (usually labeled “Alt”) while you drag icons, they snap to an invisible 
grid when you release the mouse button—this makes the arrangement of icons in the 
window more orderly.

Note: If you drag one or more items so that the cursor is over a folder icon when you 
release the mouse button, you copy or move the items to that folder. For more 
information, see “Moving and Copying Items” on page 48.

In icon view and mini icon view, you can use commands in the Window menu to 
straighten-up the arrangement of all the icons in the window. Choose Clean Up to align 
each icon in the window to the nearest location on the invisible grid. If you hold down 
the Shift key, the Clean Up command changes to Clean Up All. Choosing this command 
sorts the icons in the window in alphabetical order on the grid.

Working in List View

A lot more information about each item is visible in list view

Click a 
red field 
label to 
sort the list 
by that 
field. Shift 
click it to 
sort in 
reverse.
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When you’re working in list view, you can change how the items are ordered in the list. 
Initially, items are sorted alphabetically by name, and the “Name” field title is 
underlined at the top of the list. If you click on another field title, the items in the list are 
sorted in a way that’s appropriate for that field, and the field title you clicked becomes 
underlined. If you click a second time on a field title (or hold down the Shift key while 
you click on a field title the first time), the items are sorted in reverse order.

You can choose the fields you want to see in list view from the Fields menu. Fields 
shown in the window are checked in the menu.

Closing a Window

When you’re done working with the contents of a window, you can close the window to 
make more room for other windows on the desktop. To close a window, click its close 
button. In many applications you can also choose the Close command, which is usually 
in a window’s Window or File menu.

If you’re working in an application where you need to save the changes you make, a 
panel asks if you want to save any unsaved changes when you close a window.

In many Be applications—such as the preferences applications—when you close an 
application’s last (or only) window, the application quits.
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Working with Menus

Be menus contain commands, lists of applications, settings, and other items.

You work with menus in three main places:

1 At the top-left corner of the screen.

The application list and the main application menu, or main menu, are at the top-
left corner of the screen. The application list has the Be logo as its title. It’s 
described in “Switching Applications” on page 60. The main menu contains menu 
items for the active application, that is, the application you’re currently working 
in. The main menu’s title is the logo of the active application.

2 In windows.

Most of an application’s menus are along the tops of its windows.

3 In panels.

Pop-up lists and other controls in panels work very much like menus.

You can navigate menus and choose items from them in a number of ways, using the 
mouse, the keyboard, or a combination of the two.

Note: This section describes how menus behave when you first install the BeOS, but you 
can change a number of ways that fonts look and how they work with the Menu 
preferences application, as described in “Menu” on page 126.
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Navigating Menus by Dragging

You can press a menu title, drag to the menu item you want, and release the mouse 
button to choose that menu item. If you release the mouse button without choosing a 
menu item, the menu closes.

When you drag through menus, you also see the keyboard shortcuts for the items in the 
menu. Keyboard shortcuts are combinations of keys you can press as a shortcut to 
choosing the menu items with the mouse. The  icon represents the Command key 
(either of the keys labeled “Alt” on either side of the space bar on most PC keyboards). 
The  icon represents the Shift key. Choosing menu items from the keyboard is 
described in “Navigating Menus from the Keyboard” on page 40.

To choose a menu item by dragging, press 
the menu title, drag to the item you want, 
and release the mouse button

If a menu item has a keyboard shortcut, it’s 
indicated by icons for the keys you press.

You can’t choose dimmed items, usually 
because they’re not relevant to what’s 
selected in the window.
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Navigating Context-Sensitive Menus

In some applications, such as the Browser, you can open a menu by selecting an item or 
positioning the cursor over it and then pressing a mouse button. For example in the 
Browser, if you position the cursor over an icon in the dock and press the secondary 
mouse button, a menu with items relevant to the item in the dock opens underneath the 
cursor. Context-sensitive menus are also available in the Open and Save panels. You can 
drag to a menu item you want and release the mouse button to choose it. If you don’t 
want to choose one of the items in the menu, drag the cursor out of the menu before you 
release the mouse button.

Initially, the secondary mouse button is the right mouse button on a three-button mouse, 
but you can rearrange the buttons and their roles with the Mouse preferences 
application. See “Mouse” on page 127 for more information.

Navigating Menus by Clicking

You can click a menu’s title to open the menu and view its contents. Then you can click 
a menu item to choose it.

When you click a menu title, the menu stays open until you choose a menu item, click 
another menu title, or click elsewhere on the screen. When you move the cursor (without 
pressing a mouse button) over items in an open menu, menu items highlight underneath 
the cursor and submenus open. You can press the Enter key on the keyboard to choose a 
highlighted menu item.
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When you click a menu title, you see the menu’s triggers. Triggers are characters you 
can type when a menu is open to choose a menu item by typing instead of clicking. 
Triggers are indicated by underlined letters in menu titles and menu items. For more 
information, see “Navigating Menus from the Keyboard” on page 40.

An arrow next to a menu item indicates that it’s a submenu. Move the cursor over a 
submenu title to open it. Then click the menu item you want to choose in the submenu.

Click a menu title to open the menu, then 
click the menu item you want to choose. Or 
move the cursor over an item in an open 
menu and press the Enter key.

The underlined character in a menu item 
indicates its “trigger,” the character you can 
type to choose that menu item when the 
menu is open.
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Navigating Menus from the Keyboard

You can press and release the Command key (either of the keys labeled “Alt” on either 
side of the space bar) to display the triggers for the menu titles in the active window. 
Triggers are underlined letters in menus that indicate the character you can type as an 
alternative to clicking a menu title or menu item. Type the trigger letter for the menu you 
want to open. Then type the trigger letter for the menu item you want to choose.

Most menu items have a trigger. If you want to use the keyboard to choose a menu item 
that doesn’t have a trigger, you can use the arrow keys to select the menu item and then 
press Enter.

When you open a menu with the Command key or by clicking the menu title, you can 
also use the arrow keys on the keyboard to navigate menus. Use the left and right arrow 
keys to open different menus and submenus. Use the up and down arrow keys to 
highlight menu items. When the menu item you want to choose is highlighted, press 
Enter.

To open an application’s main menu, press Command-space (that is, press the Command 
key and the space bar at the same time). To open the application list (so you can switch 
applications), press Command-Tab.

Choosing Menu Items by Shortcut

Many menu items have shortcuts: Combinations of keys you can press to choose a menu 
item, as a shortcut to choosing it by dragging, clicking, or by navigating to the menu 
item from the keyboard. If a menu item has a shortcut, it’s displayed to the right of the 
menu item in the menu. The  icon represents the Command key (either of the keys 
labeled “Alt” on either side of the space bar on most PC keyboards). The  icon 
represents the Shift key. Shortcuts are always displayed in menus as uppercase letters, 
though you only need to press the Shift key along with the Command and letter keys if 
the shortcut includes the  icon.
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Working with the Browser

You use the Browser to organize your work: Files, applications, database items, and so 
on. The Browser is also the main tool you use to start applications.

Understanding the Hierarchical File System

Applications, documents, and other files in the Be file system are stored on disks. 
Because the number of files can become quite large, it’s convenient to sort them into 
related groups. To do this, the BeOS—like many other operating systems—uses the 
metaphor of folders (also called “directories”), where you can keep together related 
files, and even related folders.

In the following illustration, the file Emily (selected at the bottom of the screen) is in the 
system_fonts folder, which is in the fonts folder, which is in the system folder, which is 
on the disk named Boot Disk. (In this guide, boldface is used for the names of files and 
folders.)
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There’s another way of expressing the location of items in this hierarchy that you use, 
for example, when you’re working in the Terminal application: You use an item’s path 
name. A path name is a series of folder names separated by slashes. For example, the 
path name of the Emily font in the illustration is: /system/fonts/system_fonts/Emily. 
The path for the folder the fonts folder is in is often represented as /system. The leading 
slash indicates that the system folder is in the root of the boot disk: That is, on the disk 
you booted from but not in a folder.

This system gets more complicated when you’re working with more than one disk. 
There are also shortcuts to represent items in the same folder and items in folders closer 
to the root of the hierarchy. For more information, see “Terminal” on page 115.

Getting Information About an Item

You can get information about an item in a Browser window or the dock by selecting it 
and choosing Get Info from the File menu. 

The information you get depends on the item. For disks, you get information about their 
capacity and free space. For files, you get information about their size, when they were 
created and modified, and their location in the file system. For applications, you get this 
same information, plus a version number.
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Opening Folders

You double-click a folder to open a window that shows the contents of the folder. The 
title of the folder window is the name of the folder.

A folder that contains another folder is often called the parent of the folder it contains. 
When you’re viewing the contents of a folder in a window, you can open its parent 
folder by choosing Open Parent from the Window menu.

You can also open a folder’s parents from the pop-up menu that opens when you press 
the lower-left edge of a folder window, the area that normally lists the number of items 
in the window.

If you hold down the Control key when you double-click a folder, the folder’s parent 
closes when the folder you double-clicked opens. This is a handy way to reduce the 
number of folders open in a workspace.

Press the lower-left corner of a 
Browser window to open a menu 
that lists the parents of the folder 
whose contents are shown in the 
window.
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If you press the secondary mouse button when the cursor is over a folder icon, a disk 
icon, or an empty area in a folder window, a context sensitive menu opens under the 
cursor. The top item in the menu is submenu that has the same name as the folder the 
cursor is over. All the folders, applications, and other files in the folder the cursor is over 
are arranged hierarchically in the submenu. You can navigate the submenu to choose any 
folder or file to open it.

Press on a 
folder with 
the 
secondary 
mouse 
button to 
open a 
menu you 
can use to 
open a file 
or folder 
the first 
folder 
contains.



Working with the Browser

Be User’s Guide Chapter 2: Learning BeOS Basics  –  45

Working with Disks

In addition to the boot (or “startup”) disk, you can have many disks and their contents 
available in the Browser and in other applications: Additional SCSI or IDE hard disks, 
CD-ROMs, floppy disks, and so on. To make a disk available in the Browser and other 
applications, you mount it.

All currently mounted disks are listed in the BeBox window, which you can open by 
double-clicking the BeBox icon in the dock.

Tip: If you’ve removed the BeBox icon from the dock, you use the Browser’s Find 
command to open a query window, from which you can drag the BeBox icon back to the 
dock, or just open the icon. For more information, see the tip in “Opening a Query” on 
page 57.)

Before you can mount any disk the first time, you must use the Installer application to 
initialize the disk, that is, to prepare it to work with the BeOS. For information on 
initializing disks, see “Installer” on page 100. You can’t mount an uninitialized disk—
even if the disk is a hard disk that was connected to the BeBox and turned on when you 
turned on the BeBox, its icon doesn’t appear in the BeBox window until you initialize it.

You work with mounted disks in much the same way as you work with folders: Double-
click them to open them, drag files onto them to copy the files onto the disk, and so on.

Mounting a Disk

The easiest way to mount a SCSI or IDE hard disk is to have it connected to the 
BeBox—and if it’s an external device, turned on—when you start the BeOS. Icons for 
mounted disks are in the BeBox window, which you open by double-clicking the BeBox 
icon in the dock.

To mount a CD-ROM that has a Be file system on it, simply insert it into the CD-ROM 
drive: The CD is mounted automatically.

To mount a floppy disk, insert it in the floppy disk drive and choose Mount Floppy Disk 
from the BeBox window’s File menu. The disk’s icon appears in the BeBox window, 
where you can work with it in the same way you work with a folder icon.

Note: The current release of the BeOS supports only high-density floppy disks. (These 
are usually labeled “HD”.)
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To mount all disks connected to the BeBox, including hard disks, choose Mount All 
Disks from the BeBox window’s Disk menu.

A disk is also mounted after you initialize it with the Installer application.

Unmounting a Disk

To unmount a floppy disk, CD-ROM, or any other kind of disk, select it in the BeBox 
window and choose Unmount Disk from the Disk menu (or just drag the disk icon to the 
Trash icon). The disk’s icon is removed from the BeBox window, any windows for 
folders on that disk are closed. When you unmount a CD-ROM and some other kinds of 
disks, it’s ejected from its drive automatically. If the disk is a floppy disk or another kind 
of disk that isn’t ejected automatically, press the drive’s Eject button when the drive’s 
light goes out.

Renaming Items

You can rename any file, folder, or other item in a Browser window and in some panels, 
such as the Open and Save panels. To change an item’s name, select the name by 
clicking it and type a new one. You can also select an item in a Browser window and 
choose Edit Name from the window’s File menu to select the name.

You type and edit an item’s name in the same way as you type and edit any other text in 
Be applications. For more information, see “Working with Text” on page 66.

You can name an item anything you want, as long as there’s no other item in the same 
folder with that name already. You can use up to 58 letters, numbers, and symbols—
anything you can type, except the asterisk ( * ), slash ( / ), colon ( : ), and backslash ( \ ) 
characters.

Tip: If you change your mind about renaming a file or folder while editing its name, just 
press the Escape key to restore the original name.
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Creating a Folder

You can create a new folder to store related files and even other folders.

1 Open the folder where you want to create the new folder, so the folder’s window is 
the active window.

For more information on windows, see “Working with Windows” on page 25.

2 Choose New Folder from the folder window’s File menu.

A folder named “New Folder” is created. The folder’s name is selected, so you 
can simply type a name and press Enter to name the folder.

Note: In theory, you can’t create a folder more than 60 folders removed from the root.
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Moving and Copying Items

You can move items (such as a file or folder) from one folder to another. Simply drag the 
item into the window or onto the icon of the folder where you want to move it. You may 
have to arrange the windows on your desktop so both the item you want to move and the 
window or folder where you want to move the item are visible.

If the folder you drag an item onto is on a different disk, the item is copied instead of 
moved. That is, a new copy of the item you drag is created where you dragged it, but the 
original copy remains in the folder where you dragged it from.

If you want to have copies of the item you’re moving in both the source and destination 
folders on the same disk, hold down the Control key (the key labeled “Ctrl” on the left 
side of the keyboard) while you drag the item. This forces a copy whether the 
destination is on the same disk or not.

To move an 
item, drag 
it into the 
window 
where you 
want to 
move it. Or 
drag it onto 
a folder 
icon in a 
window or 
a folder 
icon on the 
dock.

In this example, you could also move the Code Snippets file into 
the Work Files icon in the same window as the Code Snippets 
file, or onto the Work Files icon on the dock. These both would 
have the same effect as dragging the file into the Work Files 
window.
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Another way to copy or move files or folders is to use the Browser’s context-sensitive 
menus. Position the cursor over the item you want to move or copy and press the 
secondary mouse button. In the menu that opens under the cursor, drag to the Move To 
or Copy To submenu and then through the hierarchy of submenus to select the folder 
where you want to copy or move the item under the cursor.

If you’re copying or moving a lot of files, a status window opens with updates on the 
progress of that task. If you’re moving or copying more than one set of files or emptying 
the trash, each such task is listed in the status window. You can click a status bar in the 
Status window and click Cancel to stop that task in midstream, but whatever has been 
moved, copied, or deleted so far stays moved, copied, or deleted—it’s not undone.

Use the 
secondary 
mouse 
button to 
move or 
copy the 
selected 
item to any 
location in 
the file 
system.
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Duplicating Items

You can create a copy of any item by selecting it and choosing Duplicate from its 
window’s File menu. The duplicate is created in the same folder as the original, and has 
the same name, with “copy” appended. If you create more than one duplicate of the 
same item, the duplicates have “copy 2”, “copy 3”, and so on, appended to the original 
name.

Deleting Items

You can delete files, folders, and most other items you see in the Browser by dragging 
them to the Trash icon on the dock. You can also put items in the trash by selecting them 
in a Browser window and choosing the Move to Trash command from the window’s File 
menu. When there are items in the trash, the Trash icon appears to have trash in it:

Items you put in the trash aren’t deleted permanently. You can double-click the Trash 
icon to see what’s in the trash, and drag items back into a Browser folder window if you 
decide you’d rather not delete them after all.

The trash is empty There are items in the trash
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When you’re sure you want to remove items permanently, choose the Empty Trash 
command from the Browser’s main menu.

If you make a habit of putting items in the trash and never emptying it, the trash 
eventually takes up a lot of disk space, so it’s a good idea to empty the trash periodically.

Note: Dragging an item from the dock to the Trash icon doesn’t put it in the trash: It just 
removes the item from the dock.

Working with the Dock

The Dock is a convenient place to store icons of the applications, files, folders, and other 
items you use most often. It’s often easier to double-click an icon in the dock than to find 
the original item in its folder.

An icon in the dock isn’t the real item it represents—the original remains in its folder. If 
you rename the original, the name changes in the dock. Similarly, if you move the 
original, the icon in the dock still represents the original, but in its new location. 
Conversely, you can’t rename or destroy the icon in the dock, you can only open it, 
move it to a new location in the dock, or remove it from the dock.
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Adding Items to the Dock

To add an item to the dock, drag it onto one of the dock’s slots.

If you drag a file onto an application icon in the dock, the application tries to open the 
file. If you drag any item onto a disk or folder icon, the item is moved or copied to that 
disk or folder. If you drag any item into a space on the dock that already has an icon in it, 
but not directly onto the item, both items occupy that space in the dock, and the slot get’s 
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a dog-eared corner to indicate there’s more than one item in that slot. Click the dog-
eared corner to see the other items in that slot.

Drag an icon to the upper-
right corner of a slot in the 
dock (take care not to drag 
the icon onto the icon 
that’s in the slot already).

The “dog-eared” corner 
indicates there’s more than 
one icon in the slot. Click 
the dog-ear to make each 
icon visible in turn.
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Rearranging Items on the Dock

To move an item on the dock to another slot on the dock, drag it to the slot you want.

Removing Items from the Dock

To remove an item from the dock, select it and choose “Remove from Dock” from the 
Browser’s main menu. Or drag the item to the trash (this doesn’t throw out the original 
item in the file system—it just removes the icon from the dock).
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Changing the Dock Display

You can change how the dock displays its contents. You can also hide the dock from 
view.

Initially, items in the dock are displayed as large icons with their names underneath. You 
change how items are displayed by choosing options from the Dock Display submenu in 
the Browser’s main menu.

To hide all but a border of the dock from view, click the left or right border. Click the 
border again to display the whole dock.

Icons 
dock display

Mini Icons with Names 
dock display

Mini Icons 
dock display

Click a 
dock scroll 
button to 
see icons 
that don’t 
fit in the 
current 
dock 
display

In Mini 
Icons dock 
display, the 
main menu 
moves 
under the 
application
 list.

In any 
dock 
display, 
click the 
left or right 
border of 
the dock 
to hide all 
of the 
dock 
except the 
border. 
Click the 
border 
again to 
display the 
whole 
dock.
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Finding Items

You can use the Find command in the Browser’s main menu to search for files, folders, 
and other items in the Be file system (that is, items stored as files on a disk). You can 
also search for entities in the Be database, such as e-mail or the names of audio CD 
tracks you enter in the CDPlayer application. When you choose Find, the Find window 
opens, where you specify in greater or lesser detail the attributes of what you’re looking 
for. These specifications, called queries, are saved in the Be database, so you can reuse 
them later.

To find an item:

1 Choose Find from the Browser’s main menu.

2 Specify the attributes of the item or items you want to find.

Choose the kind of 
item you want to find.

Choose the disk where you 
want to search, or all disks.

Click to add or remove 
attributes for what you 
want to find.

Choose an 
attribute.

Qualify the 
attribute.

Click Find when 
you’ve specified 
what you want 
to find.
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3 Click Find.

A query window opens, listing all the items that match the attributes you set in the 
Find window.

Query windows are very similar to other Browser windows, except they have a 
gray background and only work in list view. You can double-click items to open 
them, drag items to the dock and to other folders, add and remove fields using the 
Fields menu, and so on. (Think twice before dragging items from a query window 
to a location in the file system: Query windows usually contain items from many 
parts of the file system, and once you move them, you can’t move them back as a 
set.)

Caution: Though you can see and edit a text version of the query in the upper part 
of a query window, resist the temptation to experiment. The query language is 
incomplete in the prerelease version of the software and you can easily create an 
irreparable query.

Opening a Query

The Be database saves every query you create—until you decide to delete it. You can 
double-click the Queries icon in the dock to open a window that lists all your queries. 
Double-click a query in the window to open another query window, which shows the 
current result of the saved query.

You can drag queries you don’t want any more from the Query window to the trash.

Tip: The Queries icon is part of the Be database. Because it isn’t a file or folder, you can’t 
find it on a disk. If the Queries icon isn’t in the dock, you can use the Find command to 
search for a BrowserItem named “Queries”. Then you can double-click the Queries icon 
in the resulting query window or drag the icon back onto the dock. You can also use this 
technique to restore the BeBox, People, and Mailbox icons to the dock.
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3 Learning Be 
Application Basics

The BeOS comes with a number of applications, some that you use to create documents, 
some you use to configure how you prefer to work with the BeBox, and others that 
demonstrate the potential of the BeBox.

Most applications are in the /apps folder, but you can also find applications in the dock, 
in the /preferences folder, and in other locations. The applications in the /apps folder 
are described in Chapter 4 of this guide; the applications in the /preferences folder are 
described in Chapter 5.

You start applications, open files, type and edit text, save files, quit applications, and 
perform many other tasks the same way in most applications. This section introduces 
you to these basic techniques.

Starting an Application

You can start an application by double-clicking its icon. Other ways to start an 
application include selecting its icon in the Browser and choosing Open from the File 
menu, and selecting an application icon and pressing Enter.

You also start an application when you open a file—if the application you use with the 
file isn’t already running.

When an application is running, its name is added to the application list—the menu at 
the top-left of the screen that lists all running applications.
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Getting Information About an Application

You can get information about an application by choosing the About command from the 
application’s main menu (the menu with the application’s icon, to the right of the 
application list at the top-left corner of the screen). About commands usually appear in 
the main menu as “About” followed by the name of the application. For example, 
“About Edit” is in Edit’s main menu.

Switching Applications

You can have many applications running at once on the BeBox. The BeOS and the 
applications themselves understand how to share processors, memory, and other 
resources, so many applications can do many things simultaneously.

While all running applications are “active,” in the sense that they’re all doing whatever 
you told them to do, only one application has its main menu to the right of the 
application list in the top-left corner of the screen—the main menu has the application’s 
icon as its title. This is the application that responds to what you type on the keyboard, 
and if it has windows open, one of its windows is the active window.

There are a number of ways to switch among applications. The simplest is to click in a 
window belonging to the application you want to work in. Another simple way is to 
choose an application from the application list—the menu with the Be logo icon at the 
top-left corner of the screen. You also switch applications when you open a file.

You can press Command-Tab to open the application list from the keyboard (the 
Command key is either key labeled “Alt” on most PC keyboards). Then use the arrow 
keys to select an application and press Enter, or type the trigger for an application in the 
menu. (For more information, see “Navigating Menus from the Keyboard” on page 40.)



Quitting an Application

Be User’s Guide Chapter 3: Learning Be Application Basics  –  61

Quitting an Application

When you’re done working with an application, you can quit it. To quit an application, 
choose its Quit command. In most applications the Quit command is in the main menu.

In many applications, closing all an application’s windows causes it to quit.

It’s a good idea to quit an application if you’re not going to be using it for a while. 
Quitting an application frees up resources for the applications you’re still using.

Creating a New File

When you start some applications—such as Edit—they open a blank, unnamed file in a 
window. You can do work in this file and then save it (as described in “Saving a File” on 
page 61). In most applications, you can create and open another new file by choosing 
the New command. The New command is in different locations in different applications, 
but in most applications it’s in the application’s main menu or in the File menu in the 
application’s windows.

It’s important to save a new file as soon as you create work that you don’t want to lose.

Saving a File

When you work in a file, your changes aren’t stored permanently until you save them. If 
you experience a power outage, if the BeBox crashes, or if you accidentally press 
Control-Alt-Delete, any changes you haven’t saved are lost. Saving a file puts a copy of 
the file with your latest changes on a disk, where it’s stored permanently—until you 
change the file and save it again.

If you make changes to a file that already has a name and location on a disk, you save 
changes by choosing the Save command. The Save command is in different menus in 
different applications, but it’s most often each application window’s File menu.
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If you create a new file or make changes to a file that doesn’t already have a name and 
location on a disk, choosing Save the first time opens the Save As panel, where you can 
give the new file a name and pick the folder and disk where you want to save it.

The central portion of the Save panel is a list view of Browser items. You can work in 
this list view in much the same way as you work in a folder or query window in list view 
in the Browser: You can select items, rename them, change how they’re sorted in the list, 
and choose fields you want to view in the panel, and use the secondary mouse button to 
open context-sensitive menus (for more information on list views, see “Changing 
Views” on page 32). 

To view the contents of a folder that contains the folder listed in the Save panel, choose 
a folder name from the pop-up list in the upper-left corner of the Save panel. 

You can use the keyboard to navigate the controls in the Save panel: Press Tab to select 
the list view or the name field as the target for what you type (a gray rectangle surrounds 
the area your typing will affect). When the list view is selected, you can select an item in 
the list by typing the first few characters in its name, use the arrow keys to select items, 
and open a selected folder by pressing Enter (the Save button changes to Open when a 
folder is selected). You can also open the folder that contains the current folder by 
pressing Command–up arrow (the Command key is either of the keys labeled “Alt” on 
most PC keyboards). To close the panel without saving anything, press Escape or 
Command-w (this is the same as clicking the Cancel button). 

The name of the current folder is the title of this pop-up list. 
Press it to choose one of the folders that contains the current folder.

Double-click a folder 
icon to view a list of the 
files and folders it 
contains.

Type a name for the file here.

When you’ve named the file 
and picked the folder where 
you want to save it, click Save.
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When you name a file, select the folder where you want to save it, and click Save, the 
file is stored safely on the disk you selected and the title of the file in its window’s tab 
shows the name you gave the file.

You can also use the Save As command to save a copy of a file with your latest changes 
under a new name or in a different folder or disk. When you do, the original file remains 
unchanged on disk, and the new file with the new name is displayed in the window you 
were working in.

Opening a File

There are many ways to open files. The simplest is to double-click a file’s icon. You can 
also select a file’s icon in the Browser or the dock and choose Open from the File menu, 
or select the file and press Enter.

Most files have an application they’re associated with, usually the application they were 
created in. When you double-click a file, it opens in this application. A file’s icon usually 
resembles the icon of application it’s associated with, so you can usually tell what 
application a file will open in by looking at its icon. If a file doesn’t have an application 
associated with it, you’re asked if you want to use Edit to open the file when you double-
click it.

You can drag a file onto an application icon to open the file in that application—even if 
the file isn’t normally associated with that application. This is a good way to open a file 
in an application it normally isn’t associated with: For example, you can use this 
technique to open a script file you want to read or edit in the Edit application—if you 
just double-click a script file, the script runs, instead of opening in a document window. 
(Of course, the application has to know how to open the file, so you can’t, for example, 
drag an ImageViewer file onto the PlaySound icon.)
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If you’re working in an application, you can open a file with the application’s Open 
command. The Open command is in different menus in different applications, but it’s 
most often in an application’s main menu or File menu. When you choose Open, a panel 
opens where you can select the file you want to open.

The central portion of the Open panel is a list view of Browser items. You work in this 
list view in much the same way as you work in a folder or query window in list view in 
the Browser: You can select items, rename them, change how they’re sorted in the list, 
choose fields you want to view in the panel, and use the secondary mouse button to open 
context-sensitive menus (for more information on list views, see “Changing Views” on 
page 32). 

To view the contents of a folder that contains the folder listed in the Open panel, choose 
a folder name from the pop-up list in the upper-left corner. 

The name of the current folder is the title of this pop-up list. 
Press it to choose one of the folders that contains the current folder.

Double-click the file you 
want to open. Or select 
it and click Open.

Double-click a folder 
icon to view a list of the 
files and folders it 
contains.

In some applications, you can choose 
to view all files, or just the files that are 
relevant to the application you’re 
working in.
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You can use the keyboard to navigate the controls in the Open panel. You can select an 
item in the list by typing the first few characters in its name, use the arrow keys to select 
items, press Tab or Shift-Tab to select the next or previous item, and open a selected 
folder by pressing Enter. You can also open the folder that contains the current folder by 
pressing Command–up arrow (the Command key is either of the keys labeled “Alt” on 
most PC keyboards). To close the panel without opening anything, press Escape or 
Command-w (this is the same as clicking the Cancel button).

When you double-click a file’s icon in the panel (or select the file and click Open), a 
window opens that displays the contents of the file.

Printing

If you have a LaserJet IIp or compatible printer connected to the BeBox parallel port, 
you can print documents in Edit, messages in BeMail, and soon, other kinds of 
documents in other applications.

This first version of printing offered by the BeOS is simple and effective: Choose Print. 
In the panel that opens, type a scale for the pages if you want. Then click Print.

Undoing

In many applications, you can undo your most recent action by choosing Undo from the 
Edit menu. For example, if you delete text in an Edit file accidentally, choose Undo to 
undelete it.
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Working with Text

You use the keyboard and mouse to create and edit text in a lot of locations in the BeOS: 
You edit file names, text files, settings in panels, and so on.

You edit text by selecting the place you want to type and then typing. You can also copy 
text from one place and move it to another, or delete text.

The location on screen where what you type (or text you move) will be entered is 
indicated in two ways. The first is by a blinking vertical bar, called the insertion point. 
The second is by highlighted text you want to replace.

Selecting Text

There are a number of ways to select text.

Do This To

Click Select an insertion point

Double-click Select a word

Triple-click Select a paragraph

Drag across text Select a character at a time

Double-click and drag Select whole words at a time

Triple-click and drag Select whole paragraphs at a time

Hold down the Shift key Extend or reduce a range of 
selected text

In many applications, you can choose the Select All command to select all the text in a 
window or document; the Select All command is usually in an application’s Edit menu.
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Typing Text

You type text in documents, when you name or rename files in the Browser or the Open 
and Save panels, and in many other places.

To type text, click to select an insertion point or select text you want to replace. Then 
type what you want. If you select text, what you type replaces the selection.

Typing Special Characters

You type accented characters, symbols, and other special characters by holding down 
the Option key (the key labeled “Ctrl” on the right side of most PC keyboards) while 
you type one or more other keys. You type most accented characters by typing a dead 
key with the accent you want, followed by the letter you want accented. Dead keys are 
keys that when you press them, don’t place a character on the screen until you type 
another character. For example, to type é, you press Option-e and then you type e.

In the Keymap application, dead keys are indicated by a checked border. The keymap 
application is a good tool to use to find the accents and other special characters you 
want. For more information, see “Keymap” on page 124.

Opt

Hold down the Option key while you type a 
dead key; then type a letter.
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Copying and Moving Text

You can copy selected text and then paste (insert) it, someplace else. Select the text you 
want to copy and choose Copy from a window’s Edit menu. Then select an insertion 
point or text you want to replace and choose Paste from the Edit menu. You can paste 
text in the same document you copied it from, or in any other application where you 
work with text, including the names of items in Browser windows and text fields in 
panels.

If you want to move text rather than copy it—that is, remove the text you select and 
paste it elsewhere—choose Cut from the Edit menu instead of Copy.

Tip: When copying or moving text, be mindful of the spaces before and after what you 
copy, and where you intend to paste it.

Text you cut or copy is stored in a special part of memory, called the clipboard. What 
you last cut or copied remains on the clipboard until you cut or copy something else, so 
you can keep pasting what you cut or copied repeatedly, without having to cut or copy 
the original again.

Moving Text with the Mouse

You can use the secondary mouse button to move selected text by dragging it. When you 
start to drag selected text, the cursor changes shape to help you position the text exactly 
where you want it.
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Initially, the right mouse button is the secondary mouse button on a three-button mouse, 
but you can change which button is the secondary mouse button with the Mouse 
preferences application. For details, see “Mouse” on page 127.

Deleting Text

You can delete text in a number of ways. The simplest is to press the Delete key to erase 
the text to the left of the insertion point letter by letter. (Depending on the keyboard 
you’re using, the Delete key may be labeled “Delete,” “Backspace,” or just have a left-
pointing arrow. See “Using the Keyboard” on page 23 for more information on 
identifying keys on the keyboard.)

If you select text, you can delete all of it at once by pressing the Delete key. Many 
applications also have a Delete command in their windows’ Edit menus. The Delete 
command acts on selected text just like pressing the Delete key.

Select what you want to move and 
then use the secondary mouse 
button to drag it where you want. 
The vertical bar in the cursor helps 
you place the text precisely.

When you release the mouse 
button, the text is moved to 
where you positioned the cursor.
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Navigating Windows and Panels from the Keyboard

In DR8, the BeOS adds support for manipulating the buttons, pop-up lists, sliders, and 
other objects in windows and panels from the keyboard (for information on working 
with menus from the keyboard, see “Navigating Menus from the Keyboard” on 
page 40). Not all applications’ windows and panels take advantage of this support yet 
(for example, the Open and Save panels retain their own form of keyboard navigation, as 
described earlier in this chapter). Most of the applications in /preferences and the 
BeMail application offer keyboard navigation.

When you’re working in a window or panel that supports keyboard navigation, you use 
the Tab key to move the focus of keyboard control from one object (or group of objects) 
to the next. The object that is the focus of keyboard control in a window is typically 
identified with an underline or a similar marking. To move the focus of keyboard control 
in the reverse direction of Tab, press Shift-Tab.

You operate the object in focus in different ways, depending on the object:

• When a button is the focus, press the spacebar as a shortcut to clicking it.

Buttons include large buttons with text labels as well as the “radio buttons” and 
check boxes for options in panels.

• When a pop-up list is the focus, press the spacebar to open the list. Then use the 
arrow keys to select an item in the list and press Enter. When the list is open, you 
can press Escape to close the list without choosing an item in it.

• When a slider is the focus, use the arrow keys to move the slider.

• When a scrolling list of items is the focus, use the arrow keys to select the item 
you want.

• In 8-bit color palettes, use the arrow keys to select the color you want. In 32-bit 
color-pickers, use the tab key to move the focus of keyboard control to one of the 
sliders; then use the arrow keys to move the sliders.
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If a window or panel has a default button, pressing Return is the same as clicking the 
default button, regardless of the focus of keyboard navigation.

If you’re entering text in a field that you need to be able to type a tab character in (such 
as the message area of a BeMail window), press Option-Tab to move the focus to the 
next item in the window (the Option key is the key labeled “Ctrl” on the right side of the 
spacebar on most PC keyboards).
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4 Using Be 
Applications

The BeOS comes with over two dozen applications you can use to create documents, to 
get or share information, and to demonstrate the potential of the BeBox. Most of the 
applications and demos that come with the BeOS are in the /apps folder. This chapter 
explains how to use each application in /apps, in alphabetical order.

The BeOS also comes with a number of applications you can use to customize how the 
BeOS works. These applications are in the /preferences folder, and are described in the 
next chapter.

BeBounce

BeBounce demonstrates how applications can communicate with each other in the 
BeOS. When you start BeBounce, a window with a bouncing ball opens. If you start a 
second copy of BeBounce, its window has no ball, but you can move the windows near 
each other to open a path between them. The ball can bounce from window to window 
through this path. You can’t run more than two copies of BeBounce.

For details on the code that makes BeBounce work, see the article “Opening the 
BeBox,” in the January 1996 issue of MacTech magazine. A copy of the article is 
available in the developers area of the Be web site (http://www.be.com/). Commented 
source code for BeBounce is included with the BeOS, in /develop/projects/BeBounce.
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BeLogo

When you start BeLogo, it opens a window with a 3D rendition of the Be logo, which 
rotates in three dimensions on a black background. The logo is a 3D model, which is 
mathematically rotated at 120 frames per second. BeLogo was designed to take 
advantage of all the CPU resources it can get, so while it’s an interesting way to test the 
power of the BeBox, you may not want to leave it running when you’re trying to get real 
work done.

BeLogo was written long before the creation of the Be 3D Kit, which is demonstrated in 
the Live3D application (as described in “Live3D” on page 103).

BeMail

BeMail is a basic application for creating and reading Internet-style electronic mail—
usually referred to as “e-mail”.

Before you can use BeMail to exchange e-mail with others, you need to use the Network 
and E-Mail preferences applications to configure the BeOS to communicate with an e-
mail server. For more information, see “Network” on page 128, and “E-Mail” on 
page 121.

Checking for Mail

You can tell if you have new mail in a couple of ways. The easiest is to observe the 
Mailbox icon in the dock: The icon changes from an empty mailbox to a mailbox with 
letters in it if you have unread mail:

No unread mail You have unread mail
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You can set E-Mail preferences to check for new mail on a regular schedule, as 
described in “E-Mail” on page 121. You can also check for mail (and send any mail 
you’ve created but haven’t sent yet) by clicking the Check Now button in the E-Mail 
preferences application or in the E-Mail Status window (if that window is open).

The E-Mail Status window tells you how many pieces of e-mail you’ve received since 
you last checked for mail. It also tells you how many pieces of mail you’ve received that 
you haven’t read.

In the BeOS, each piece of e-mail you create or receive is stored as an entity in the Be 
database—not as a file in the file system. To view a list of your mail, you use the 
Browser’s Find command to find “E-Mail” items in the database. Each time you use the 
Find command, the criteria you specify in the Find window is saved as a query in the Be 
database (for more information on the Find command and the Be database, see “Finding 
Items” on page 56).

The BeOS includes five premade e-mail queries. The Mailbox query is initially in the 
dock, but all five are listed in the query window that opens when you double-click the 
Query icon, which is also in the dock. The five premade queries are:

• Mailbox, which lists e-mail sent to you, whether you’ve read it or not.

• In Box, which lists e-mail sent to you that you haven’t read yet.

• Read Mail, which lists e-mail sent to you that you’ve read.

• Out Box, which lists e-mail you’ve created but that hasn’t been sent to the e-mail 
server.

• Sent Mail, which lists e-mail you’ve created and that has been sent to the e-mail 
server.

You’ve received 1 piece of e-mail since you 
last checked for new mail, and there are 
three pieces of e-mail you haven’t read yet.
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When you double-click the icon for an e-mail query, a query window opens with a list of 
e-mail in the database that matches that query. For example, when you double-click the 
Mailbox icon in the dock or in the Queries window, the Mailbox query window opens 
with a list of all the mail that’s been sent to you.

Initially, query windows sort e-mail alphabetically by the name of the person who sent it 
or the person you sent it to, but you can use the Fields menu to add other fields to the 
window and then click the field name to sort mail differently. For example, to sort mail 
in the order it was sent, choose When from the Fields menu and then click the When 
field title in the window. (See “Working in List View” on page 34 for more information 
about sorting items in list view.)

E-mail you haven’t read has 
a “New” status.
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Reading E-Mail

To read a piece of e-mail, double-click it in an e-mail query window, such as the one that 
opens when you double-click the Mailbox icon in the dock.

The sender and subject of the e-mail message are listed at the top of the window, 
followed by the body of the message. If sender enclosed one or more files with the 
message, they’re listed at the bottom of the window. Unlike the body of a message, 
enclosures are stored as files in the Be file system, not in the Be database, so the path 
name of the enclosure is listed after its icon.

E-mail messages typically include a number of lines of information before the body of 
the message. These lines include detailed information about the sender, the addressees, 
and the route the message traveled. Initially, this information is hidden, but you can 
view it by choosing Show Header from the Message menu.

You can use the commands in the Message menu to reply to or forward the message in 
the window. If you choose Reply, a new message window opens with the sender’s e-mail 

The sender and the 
Subject of the e-mail 
are listed here.

The body of the 
message is followed 
by information about 
any enclosures.

Double-click an enclosure to open it. Or 
drag it onto the icon of the application you 
want to use to open it.



BeMail

78  –  Chapter 4: Using Be Applications Be User’s Guide

address entered in the “To” field, “Re:” followed by the original subject in the Subject 
field, and the body of the original message “quoted” in the message area of the window. 
If you choose Forward, a new message window opens with the Subject and quoted body 
of the message. You can then enter your own message and edit the addresses and subject 
as you would any other message you create. If you select text in the body of a message 
before you choose Reply or Forward, only the selected text is included in the new 
message. Enclosures are retained in messages you forward, but not in those you reply to. 
(Creating new e-mail messages is described in the next section).

If you have a LaserJet IIp or compatible printer connected to the BeBox’s parallel port, 
you can use the Print command to print the message.

If you want to save the message as a text file (so you can work with it in the Edit 
application, for example), choose Save as Text File from the File menu to open a 
standard Save As panel (see “Saving a File” on page 61 for more information on saving 
files).

When you’re done reading the message, you can choose Delete from the File menu to 
remove it from the Be database. A panel asks you to confirm that you want to delete the 
message. (If you prefer not to have to confirm the Delete command, choose Expert from 
the User Level submenu in BeMail’s main menu.) If you close the message window 
instead of deleting it, the message is kept in the Be database: It remains in the list of e-
mail in the Mailbox query window, but its status changes from “New” to “Read.”
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Creating E-Mail

You use the BeMail application to create and address new e-mail messages. Start the 
BeMail application to open a new message window, or if BeMail is already running, 
choose New Mail Message from BeMail’s main menu.

You enter the e-mail addresses of the people want to send the message to in the “To” 
field. If you want to send the message to more than one address, enter each address 
followed by a comma. Enter the e-mail addresses of people you want to send a copy of 
the message to in the “Cc” field. You can also enter the addresses of people you want to 
send “blind copies” of the message to in the “Bcc” field: Other recipients can’t tell who 
you “blind cc’d” the message to.

Tip: If you’ve used the Browser’s Create Person command to add people and their e-mail 
addresses to the Be database, you can double-click the People icon in the dock and drag 
an icon for a person from the People query window into the “To” field to enter that 
person’s e-mail address. Or drag an icon from the People window onto the BeMail icon 
to open a new message window with the person’s e-mail address entered automatically.

A common convention when “quoting” parts of other people’s messages in your own is 
to start each line with the greater-than symbol ( > ). You can select text in the message 
area and choose Quote from the Edit menu to add a greater-than symbol to beginning of 
each selected line. You can also remove the greater-than symbols from selected text by 

Enter the e-mail addresses 
of the people you want to 
send the message to.

Enter a subject.

If you want to include files 
with the message, drag 
them into the Enclosures 
field.

Enter the “body” of the 
message.
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choosing Remove Quote. When you forward or reply to a message, the text of the 
message is quoted in this way.

You can include one or more files with your messages as enclosures. Drag any file you 
want to include into the Enclosures area of the message window. You can also use the 
Add command in the Enclosures menu to open a panel where you can select a file you 
want to enclose. If you change your mind, select a file in the list of enclosures and 
choose Remove from the Enclosures menu. (In DR8, the Info command in the 
Enclosures menu isn’t implemented.)

When you’re done creating an e-mail message, you can choose Send Now from the 
Message menu to send the message immediately. Or choose Send Later to store the 
message in the Be database until the next time the Be software checks for new mail (you 
set the schedule for when mail is checked with the E-Mail preferences, as described in 
“E-Mail” on page 121).

Note: Future versions of BeMail will include tools for creating a signature and for 
adding the signature to a message. Signatures are lines of text, typically with your name 
and information on how to reach you, that you add to many of the messages you send.) 
However, in DR8 the Edit Signature and Add Signature commands are always dimmed.

CDPlayer

If you have a CD-ROM drive connected to the BeBox, you can use the CDPlayer 
application to play music and other audio CDs through the internal speaker and line-out 
ports. You can also use CDPlayer to copy audio data from an audio CD to a file on a 
disk.

Note: CDPlayer works best with Toshiba CD-ROM drives. Some of its features—such 
as fast forward, fast reverse, and saving audio data—may not be available if you’re 
working with a drive from another manufacturer.
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Playing CDs

When you start CDPlayer, it opens a window with controls very like those on a home 
CD deck. If you have a CD deck, you’ll recognize the Stop, Play, Back Track, Forward 
Track, Fast Reverse, Fast Forward (or “scan”), Eject, and other buttons.

If you have more than one CD-ROM drive connected to the BeBox, choose the one with 
the CD you want to play from the Devices submenu in CDPlayer’s main menu. You can 
also open a CD-Player window for each CD-ROM drive: Choose the CD-ROM drive 
you want to open a window for from the New Player submenu in CDPlayer’s main 
menu. CD-ROM drives are listed in these two menus by their SCSI IDs.

The Fast Forward and Fast Reverse buttons scan the disk at double speed; you can hear 
what you’re scanning. Holding down the secondary mouse button when you click Fast 
Forward or Reverse scans the disk at quadruple speed.

The volume slider adjusts the output of the CD-ROM drive. You use the Sound 
preferences application to control the input and output volumes for the BeBox, as 
described in “Sound” on page 139.

Note: In the prerelease version of the software, the shuffle button isn’t hooked up.

These buttons are the 
same as on a home CD 
deck: Stop, Play 
(changes to Pause 
when you click it), Back 
Track, Forward Track, 
Fast Reverse, and Fast 
Forward.

You can 
adjust the 
volume from 
the CD drive 
by dragging 
this slider.

Click a track button to jump 
to that track.

Click this button to toggle 
the time display.

These buttons are for 
ejecting the CD, saving 
audio data to disk, 
“shuffle play” (playing 
tracks in random order), 
and toggling between 
playing a CD once or 
over and over again.

Click to display a list of 
tracks and titles.
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If you click the rightmost button in the CDPlayer window, a lower part of the window 
opens with a list of the tracks on the CD. You can replace “Track 1,” “Track 2,” and so 
on with a description of each track—perhaps the title of each track from the play list. 
Click in the Title column and type the description you want. You can also replace “Audio 
CD” at the top of the window with the title of the CD. The information you type is 
stored in the Be database as “AudioCDs” data; the next time you use CDPlayer to play 
that CD, it recognizes the CD and includes the information you typed. You can also use 
the Browser’s Find command to search for AudioCDs data, such as a track or CD title 
you typed in a CD Player window (for more information on the Find command, see 
“Finding Items” on page 56).

Click to show 
and hide the 
track list.

Click in a track 
to type a title.

Type the title of 
the CD here.
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Saving Audio Data

One button you won’t recognize from a CD deck is the Disk button. When you click the 
Disk button, the Save Audio window opens, where you can save some or all of a CD 
track to a file on a Be disk. Choose the audio format you want from the pop-up list: 
“Raw” and AIFF (Audio Interchange File Format) are supported now—WAVE 
(Waveform Audio File Format) files will be supported in the near future.

To save audio data, you need to connect the CD-ROM drive to the BeBox I/O board 
with a “pass-through cable.” For details, see “Connecting a CD-ROM Drive to the I/O 
Board” on page 9.

Drag the green start marker and the red end marker to the starting and ending points in 
the track you want to save. The blue marker shows the current place in the track when 
you’re playing it. The numbers next to the markers indicated the hours, minutes, and 
seconds from the beginning of the track. When the markers surround the section of the 
track you want to save, click the Save button to open a Save panel, where you name the 
audio file and select the folder where you want to save it (for more information on the 
Save panel, see “Saving a File” on page 61).

You can play the tracks you save with the PlayAudio application (in /apps). Simply drag 
the track you want to listen to onto the PlayAudio icon.

You can double-click the CDPlayer icon to start as many copies of CDPlayer as you 
want, so if you have more than one CD-ROM drive connected to the BeBox, you can 
listen to more than one CD at a time.
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Clock

The Clock application is as simple as its name: When you start it up, it displays an 
analog clock. Clock has a number of faces. Click in the clock face to switch among 
them. If you prefer not to see a second hand, click in the face with the secondary mouse 
button—click again to restore the second hand. You can also uncheck the Show Seconds 
command in the main menu to hide the second hand.

You set the date and time with the Time preferences application, as described in “Time” 
on page 140.

Connect

You use the Connect application to communicate with computers and other kinds of 
devices. You can use Connect to connect to a device directly, via a cable that connects 
the BeBox directly to the device, or via a modem.

When you start Connect, a blank window opens, and there is no connection established 
(if you type in the window, parrot, one of the command-line tools Connect uses, 
reminds you that no connection established).

Setting Communications Parameters and other Preferences

Before you establish a connection, you need to set the baud rate (the speed at which 
you’ll exchange information), parity, and other communications parameters using the 
Settings menu. You can also use the Settings menu to change the colors in the window, 
the window size, and other preferences. Choose Save as Defaults to use these settings 
each time you start Connect.

Click to switch face styles. Click with the secondary 
mouse button to hide or show the second hand.
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Note: Serial ports 1 and 2 are reliable up to 155200 baud. Serial ports 3 and 4 are 
reliable up to 38400 baud.

If you connect to a number of different kinds of devices that require different settings, or 
if you prefer to use different color schemes as a reminder of which device you’re 
connected to in which Connect window, you can choose Save as Settings File from the 
Settings menu to save the current settings in a Connect Settings file. Whenever you want 
to connect to a device using those settings, you can double-click the settings file to open 
a Connect window with those settings in effect.

Connecting Directly to a Device

If you connect the BeBox to another device by attaching a cable (typically a “null 
modem” cable) to a BeBox serial port and to a serial port on the other device, you can 
use Connect to exchange messages between them.

When the cable is connected and you’ve set the communications parameters, choose 
Connect Directly from the Connections menu.

When you click Connect in the Connect Directly panel, what you type in the Connect 
window is sent out the serial port you chose. Any messages the other device sends 
across the cable also appear in the window.

Choose the BeBox serial port the device is 
connected to.

Then click Connect.
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Connecting to a Device via a Modem

If you have a modem connected to one of the BeBox serial ports, you can use Connect to 
dial the modem and establish a connection with another device that’s connected to a 
modem.

When the modem cable is connected and you’ve set the communications parameters, 
choose Connect via Modem from the Connections menu.

Enter the phone number for the other device’s modem in the Phone Number field. Don’t 
forget to enter a 9 or other number if you normally need to dial a number to get an 
outside line. Also be sure to enter 1 and the area code if you’re dialing long distance.

If you need to log in to the device you’re connecting to, enter your user name and 
password.

Connect uses the /system/connect/dial-o-rama script with the /bin/ali utility to 
establish a connection with devices via modem. If you want to use another script, enter 
its path name in the Dialing Shell Script field.

Different modems require different commands to establish connections with other 
modems. The Modem Init. String initially contains a general-purpose set of modem 
commands. You can replace this string with another if you wish (see the modem’s 
owner’s guide for information on the commands it uses).
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Choose the serial port the modem is connected to from the pop-up list at the bottom of 
the window.

When you’ve entered the appropriate information in the Connect via Modem window, 
click Connect to dial the modem and establish the connection. When the modems 
establish the connection, what you type in the Connect window is sent to the other 
device. Any messages the other device sends also appear in the window.

Disconnecting

When you’re done communicating through a serial port with Connect, choose 
Disconnect from the Connections menu. The connection is severed, and you can 
establish a new connection through the serial port with Connect or with another 
application.

Dominos

Dominos is an application that demonstrates the BeOS Game Kit, which is new in DR8. 
When you start Dominos, it takes over the screen of the current workspace with a 3200-
pixel by 3200-pixel game board. Dominos then plays the game of Dominos with itself, 
adding tiles until the board is filled. The red numbers on the lower right of the screen 
show you how many dominos have been played.

When Dominos can’t find any new locations for tiles, the game ends. You can then use 
the arrow keys on the numeric keypad to move around the board and view the results. In 
a typical game, Dominos plays about 2600 tiles in six or seven minutes.

You can switch workspaces to leave Dominos to amuse itself while you get back to work 
(for more information about working with multiple workspaces, see “Workspaces” on 
page 117). To quit Dominos, press Command-Q.

Complete, commented source code for Dominos is in the /develop/projects/Dominos 
folder.
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Edit

Edit is a Be text editor. You can use it to read, create, and edit text (ASCII) and script 
files.

Edit is not a word processor: It doesn’t wrap long lines to fit in a window, you can’t 
change font and paragraph settings for individual words or paragraphs, or do most of the 
other things you may be used to doing in a word-processing application. But Edit is 
great for editing programs and shell scripts.

You type text, copy and paste, type symbols and other special characters, just as you do 
anywhere you work with text in the BeOS. For details, see “Working with Text” on 
page 66.

If you have more than one Edit file open at once, you can switch from one to another by 
clicking in the window of the file you want to work in. You can also choose the name of 
the open file you want to work in from any Edit file window’s Document menu.

Changing the Font

You can display an Edit file using any font. Choose the font, style, and size you want 
from the Font menu.

Note: Changing the font in an Edit file isn’t the same as setting a font in a word 
processor—the font you choose is used for all the characters in the file.

For information on adding additional fonts to the BeBox, see “Adding Fonts” on 
page 141.

Automatically Indenting Lines

When you’re writing code, it’s often convenient to have lines that follow an indented 
line be indented automatically when you press Enter. Initially, Edit files are set to act 
this way. To end a series of automatically indented lines, press the Delete key at the 
beginning of the fist line you don’t want indented.

You can turn off this behavior by choosing Auto Indent from the Settings menu (this 
unchecks Auto Indent in the menu).
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Indenting and Unindenting Lines

You can indent selected lines by choosing Indent from the Edit menu.

Unindent selected lines by choosing Unindent from the Edit menu.

Changing the Width of Tabs and Indents

Initially, when you press Tab or indent lines with the Indent command, each Tab 
character or indent moves lines four characters to the right. You can choose to indent 
eight characters instead of four by choosing “Tab Size of 8” from the Tab Setting 
submenu in the Settings menu. Or you can set the width you want by choosing Tab Size 
Other, entering a number for the width you want, and clicking OK. When you change 
the tab setting, all indented lines move to match the new setting.

Select the lines you want to indent

Then choose Indent from the Edit 
menu to indent the selected 
lines.
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Commenting and Uncommenting Lines

You can select lines in the programs you write and “comment them out,” that is, add the 
appropriate character or characters to the beginning of lines that you don’t want to get 
compiled, but rather to serve as comments.

The characters prepended to lines when you choose Comment depend on the kind of file 
you’re editing, which Edit determines by the file’s extension: the period and following 
characters at the end of the file’s name.

File Extension Comment 
Character(s)

.c, .h, or .cpp //

.a ;

All others #

You can remove the comment characters from the beginnings of selected lines by 
choosing Uncomment from the Edit menu.

Select the lines you want to indent

Then choose Comment from 
the Edit menu to prepend 
the appropriate comment 
characters to the selected lines.
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Finding Text

You can find a string of characters in an Edit file.

1 Choose Find from the Edit menu.

2 Type the string of characters you want to find.

3 Check any Find options.

Check Search Backwards to search for the characters in the file that are before the 
insertion point (in lines with lower line numbers), rather than after the insertion 
point.

Check Wrap-Around Search to keep searching for the characters from the 
beginning of the file, after the search reaches the end of the file (this works the 
other direction if you have Search Backwards checked).

Check Case-Sensitive to search for characters that match the capitalization of 
what you typed in the Find panel. Otherwise, searching for “Cornichon” finds 
both “Cornichon” and “cornichon”.

4 Click Find.

The first occurrence (after the insertion point) of the characters you’re searching 
for is selected in the window. If the characters aren’t found, the insertion point 
doesn’t move.

You can choose Find Again from the Edit menu to search for the next occurrence 
of the characters.

As a shortcut to using the Find command, you can select the characters you want to 
search for and choose Find Selection to find the next occurrence of those characters in 
the file.
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Replacing Text

You use the Replace command to automate replacing one string of characters with 
another string.

1 Choose Replace from the Edit menu.

2 In the Replace panel, type the string of characters you want to replace and the 
string of characters you want to replace them with.

3 Check any Replace options.

The Search Backwards, Wrap-Around Search, and Case-Sensitive options work 
the same as in the Find panel.

Check Replace in All Windows if you want to replace the string in all open Edit 
documents when you click Replace All.

4 Click Replace to replace the next occurrence of the string. Or click Replace All to 
replace all occurrences of the string at once.

You can repeat the last replacement by choosing Replace Same from the Edit menu.

Showing Line Numbers

You can display a column that shows the number of each line in an Edit file by choosing 
Show Line Numbers from the window’s Settings menu. Choose Show Line Numbers 
again to hide the line numbers.
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Going to a Specific Line by Line Number

You can move the insertion point to the beginning of any line in an Edit file. Choose Go 
To Line from the Edit menu and in the panel that opens, type the line number you want 
to go to and click OK.

Creating and Using Markers

You can create and name markers in your Edit files that make it easy to jump directly to 
the location of the marker.

1 Select an insertion point where you want to create the marker. Or select text to use 
it as the marker name.

2 Choose Create Marker from the Markers menu.

3 Type a name for the marker.

If you had text selected when you chose Create Marker, that text is inserted in the 
Create Marker panel. You can keep that text as the name of the marker or edit it.

4 Click OK.

The marker (which is invisible) is inserted at the insertion point or beginning of 
the text selection, and the name of the marker is added to the Markers menu.

Once you’ve created a marker, you can go directly to its location by choosing the name 
of the marker from the Markers menu.

You can choose Alphabetize Markers from the Markers menu to list the names of 
makers alphabetically, rather than by their order in the file.
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Deleting Markers

You can delete one or more markers when you’re done with them.

1 Choose Delete Marker from the Markers menu.

A panel opens with a list of the markers in the file.

2 Click a marker and click Delete.

The name of the marker is removed from the list in the panel, and the marker is 
removed from the file.

3 Delete more markers if you want. Then click Done.

Creating a Script File

Script files are text files that take advantage of the Be shell, bash. You can write a script 
file in Edit and then save it as a script file by choosing the Convert to Script File 
command from Edit’s File menu.

You run a script file by double-clicking it.

To edit an existing script file, drag its icon onto the Edit application (you can’t double-
click it to open it, because double-clicking it runs the script).

For more information about the Be shell, see “Terminal” on page 115.
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Flight

Flight is a simple flying and shooting game.When playing Flight, you fly across a barren 
landscape and shoot down unarmed helicopters (for 1 point) and other players (for 10 
points), while trying to avoid crashing (losing 5 points), shooting down a team mate 
(granting the other team 10 points), or getting shot down yourself. Flight works best if 
you set the screen resolution to 800 × 600 or higher (see “Screen” on page 135). At 
lower resolutions, you can’t see all of Flight’s windows without overlapping. You can 
play Flight alone, with two players on the same BeBox, or as network game with up to 
eight players.

Preparing for Battle

When you start Flight, a darkened window opens: Dawn doesn’t break until you start a 
game.

To set up a solo player (or a single entrant in a network game), choose the item from the 
Control menu that matches whether you’ll control your flight using the keyboard, using 
a joystick connected to the upper joystick port on the back of the BeBox, or a joystick 
connected to the lower joystick port. Then ally yourself with the yellow or purple team 
by choosing the appropriate item from the Options menu.

To set up two players, choose Second Player from the Play menu and then set the control 
and team alliance for each player using the Control and Options menus in each window.
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Engaging Battle

To start a game, choose Play Game from the first player’s Play menu (only the first 
player can start and stop the game). To host a network game, choose Play NetGame. To 
join a network game hosted by another BeBox, choose Join NetGame.

When the game begins, Flight’s main window provides a cockpit view of a plane flying 
through a landscape populated by unarmed helicopters. The crosshairs in the center of 
the window are for aiming your shooter.

If you’re using a joystick, see the instructions that came with it to learn how to steer, 
change speed, and shoot.

If you’re using the keyboard, use the arrows in the numeric keypad to steer, but think of 
a joystick as you use the up and down arrows: The up arrow points your nose down. Use 
the left and right arrow keys to the left of the numeric keypad to increase and decrease 
your speed. Shoot by pressing the right Shift key.

Each player can choose Map from the View menu to open a window that shows his 
position in the landscape. Yellow and purple team players are represented by crosshairs. 
Unarmed helicopters are represented by black dots. The other commands in the View 
menu control how wide a view is displayed in the window.

Yellow and 
purple team 
scores.

Shoot down 
an unarmed 
helicopter for 
1 point.

Your speed, 
from 300 to 
1500.

The number of 
surviving 
unarmed 
helicopters.
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If you find it hard to fly, you can choose Crash on Ground from the Options menu at any 
time: When it’s unchecked, you plow along the surface instead of crashing.

A game of Flight can’t be said to have a real conclusion: Each player has an unlimited 
supply of ammunition and is reincarnated endlessly. However, the landscape does seem 
bleaker when the last unarmed helicopter is gone.

FontChart

FontChart opens a window with a chart of the characters in a font.

You can use the secondary mouse button to drag a character or the text from any of the 
fields in FontChart to another application. For example, you can drag a character from 
the FontChart window onto a key cap in the Keyboard application, or into an Edit 
document.

These fields display the character you type (or 
click in the chart) in the current font, plus the 
character’s code in hexadecimal and decimal.

The bit field shows raw binary 
data from the keyboard as 
you press and release keys

The Key field shows the raw keyboard key 
number in decimal.

Click or type a character.
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At the bottom of the window, the bit field shows the raw keyboard key number, in binary 
form, as you press and release keys singly or in combination. This information is useful 
for game developers and others who rely on raw keyboard data.

You can choose the Keyboard ID command from FontChart’s Edit menu to see the ID 
number of the keyboard connected to the BeBox.

The prerelease version of the Be software uses the same symbol set as the Macintosh 
operating system. For more information on symbol sets, see “Keymap” on page 124.

FontDemo

FontDemo shows off the BeBox’s speed and versatility with fonts. When you start up 
FontDemo, two windows open: A window that displays some sample text and a Controls 
window.

Use the Size scroll bar to change the size of the font in the Display window. Use the 
Shear scroll bar to shear (or slant) the text. Use the Rotation scroll bar to rotate the text.
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Type the text you want to display in the field above the Cycle Fonts button.

Select the font you want to use for the text in the Display window in the upper scrolling 
list. Select a symbol set from the lower scrolling list.

Click Cycle Fonts to have FontDemo select the available fonts in order. You can use the 
other controls while FontDemo cycles through the fonts.

IconWorld

IconWorld is an application for editing the icons of applications and their associated 
files. You also use it to assign application resources. Using IconWorld is explained in 
“Creating Resources for a Be Application” on page 159.

ImageViewer

You can use ImageViewer to open and view two kinds of image files: Color TIFF 
(Tagged Image File Format) files and files in the image file format used by the BeOS. 
The custom Be image file format is the file format of “screen dumps,” the images of the 
screen you can create by pressing the Print Screen key. ImageViewer is also useful for 
converting image files to a format that’s compatible with Adobe Photoshop on a 
Macintosh, and for showing off the Be drag-and-drop metaphor.

For information about creating screen dumps and ImageViewer’s role in the process, see 
Appendix A, “Creating Screen Dumps.”

To show off the Be drag-and-drop metaphor, open an image file (a screen dump or one 
of the files in the /optional/images folder on the BeOS CD-ROM) and select an area you 
like by dragging across it. Then drag the selected area to a Browser window: A new 
image file is created, called clip. You can double-click the new file to see that it contains 
just the area you selected.
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Installer

The Installer application has two purposes: Preparing disks so you can use them with the 
BeBox and installing the BeOS. Installing the BeOS is described in Installing 
Developer Release 8 of the BeOS, the booklet that accompanies this user’s guide.

Initializing or Formatting a Disk

You can use the Installer to prepare IDE, SCSI, and floppy disks for use with the BeBox 
by initializing them or—if necessary—by formatting them.

Note: The current release of the BeOS only supports high-density floppy disks. (These 
are usually labeled “HD”.)

Initializing a disk prepares it to work with the Be file system. You must initialize a disk 
before you can mount it the first time and store Be files on it. It only takes a few seconds 
to initialize most disks. 

You may need to format a disk if it has never been set up to work with a computer or if it 
has been damaged. Most disks come preformatted, so it’s rare that you’ll ever need to 
format one. It can take a very long time to format a disk: The better part of an hour for 
large disks. After the Installer formats a disk, it also initializes it.

If you’re not sure whether you need to format a disk, try initializing it first. The Installer 
inspects the disk and lets you know if you need to format it.

Caution: Both initializing and formatting a disk erase everything on the disk (in fact, 
initializing a disk is a good way to erase it quickly), so make sure you’ve backed up any 
files you want to keep before you initialize or format a disk.
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1 If you’re initializing or formatting a SCSI or IDE disk, make sure it’s connected to 
the BeBox.

You can connect up to two IDE disk drives to the BeBox and up to seven SCSI 
disk drives. Depending on the number of disks you connect to the BeBox and how 
they’re connected, you may need to configure each IDE disk as a “single,” 
“master,” or “slave” disk or configure each SCSI disk with a unique SCSI ID and 
terminate it correctly. For more information, see the owner’s guides that came 
with the disks and Chapter 1, “Assembling the BeBox.”

Uninitialized disks don’t appear in the Browser.

2 Double-click the Installer application.

3 Choose Initialize or Format from the left pop-up menu. Then choose the disk you 
want to initialize or format from the right pop-up menu.

If a disk was previously initialized on a BeBox, it appears by name in the right 
pop-up menu. If a disk hasn’t been initialized, it appears in the pop-up menu by its 
device name:

Device Name Description

ide - master The single IDE disk connected to the BeBox, or the master IDE 
disk if there are two connected.

ide - slave The slave IDE disk, if there are two IDE disks connected to the 
BeBox.

scsi - id n The SCSI drive set to SCSI ID number n (n can be from 0 
through 6)

floppy disk The disk in the floppy disk drive.

Choose Initialize 
(or Format).

Then choose the disk you want to 
initialize (or format) and click Begin.
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4 Click Begin. Then click Initialize (or Format) in the panel that warns you that 
initializing (or formatting) the disk will erase it.

When the disk is initialized, a message informs you that it’s now available in the 
BeBox window. Floppy disks are named “fd” when you format them. Other disks 
are named “NewDisk.”

You can now initialize another disk, install the BeOS, or quit the Installer.

Kaleidoscope

Kaleidoscope is a simple line-drawing application: It opens a window where it draws 
patterns of colored lines as fast as it can. It’s interesting to see the effect of multiple 
Kaleidoscope windows on the BeBox’s performance.
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Live3D

Live3D is an application that offers three demonstrations of the 3D Kit. The 3D Kit 
makes its debut in a preliminary version in DR8.

When you start Live3D, a window opens with an image of a spinning spacecraft. This 
image is a 3D Kit model, which is being rendered in real time, with light sources that 
move as well. Choose Stellar Pulse or Be Logo II from Live3D’s main menu to open a 
window with one of the other 3D Kit demonstrations.

You can drag an object in a Live3D window by any point to rotate it in three dimensions. 
Use the keyboard arrow keys to move the “camera”: The left and right arrow keys 
between the main part of the keyboard and the numeric keypad move the camera 
forward and back; the four arrow keys on the numeric keypad (on the 2, 4, 6, and 8 keys) 
move the camera up and down and left and right. The models continue to be rendered in 
real time as you drag an object or move the camera. To stop the automated movement of 
the models and the light sources, uncheck Pause in the main menu. 

Complete, commented source code for Live3D and its three demos are in the 
/develop/projects/Live3D folder. For a detailed discussion of the 3D Kit, see the white 
paper, “Welcome to the 3D World,” on the Be web site: 
http://www.be.com/developers/3DWhitePaper.html.
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Magnify

The Magnify application displays a greatly enlarged image of the area of the screen next 
to the cursor. This is useful for inspecting the pixel-by-pixel details of icons and other 
objects on the screen.

When you double-click Magnify, it opens a window that displays an area 32 pixels high 
by 32 pixels wide. If you want a different-sized window, start Magnify by typing 
Magnify’s path name in a Terminal window, followed by a space and the number of 
pixels per side you want for Magnify’s window. For example, type /apps/Magnify 100 
in a Terminal window to open a 100-pixel by 100-pixel window. The number you type 
must be a multiple of four.

Initially, Magnify uses a grid pattern to separate the pixels in its window. You can choose 
Show Grid from Magnify’s main menu to hide the grid.



Mandelbrot

Be User’s Guide Chapter 4: Using Be Applications  –  105

Mandelbrot

The Mandelbrot application demonstrates the power of the BeBox by drawing images 
based on the “Mandelbrot set,” a set of mathematical formulas invented by Benoît 
Mandelbrot, the Polish mathematician. Mandelbrot takes advantage of the two PowerPC 
microprocessors in the BeBox by using one CPU to compute the odd lines in the image 
and the other to compute the even lines.

It’s interesting to zoom in on areas of the image in the window. Drag across an area you 
like to recalculate the image so the area you dragged across fills the window. You can do 
this indefinitely. To zoom out, hold down the Shift key and click in the window.

You can choose a color palette from the Palette menu. You can choose the level of 
iteration you want from the Iterations menu. The higher the number you pick, the more 
precise—and time-consuming—are the calculations used to draw the image. Higher 
numbers are more important as you zoom further into an area of the image.
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Midi

Midi is an application for playing MIDI (Musical Instrument Digital Interface) files on a 
MIDI synthesizer. (If you don’t have a MIDI synthesizer connected to the MIDI-1 Out 
port on the BeBox, MIDI will play MIDI files, but you won’t be able to hear them.) You 
open a MIDI file by dragging it onto the Midi application icon, which opens the MIDI 
window.

A number of MIDI files are included in the /optional/midi folder on the BeOS CD-
ROM.

The full MIDI window is only visible if you’re using a screen grid that’s 800 pixels wide 
by 600 pixels tall. You set the screen grid with the Screen preferences application, as 
described in “Screen” on page 135.

Note: When you first copy a MIDI file onto the BeBox, it doesn’t have a MIDI file icon 
and isn’t associated with the Midi application until the first time you drag the file to the 
Midi application.
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Each track in the MIDI file is represented by a vertical set of controls. You can play a 
track as a solo, mute the track, pan the track between the left and right audio channels, 
adjust its volume, and see it play on the keyboard, all by adjusting the controls for that 
track.

You can synchronize the beginning and end of the MIDI track with other application’s 
files by dragging the clock icon to or from the Midi application’s scroll bar.

Note: Be has arranged with Igor’s Software Laboratories to develop a software MIDI 
synthesizer for the BeOS. This will allow you to play MIDI files on the BeBox without a 
hardware MIDI synthesizer attached. Be will make the software MIDI synthesizer 
available to everyone running the BeOS as soon as Igor’s is done, possibly before the 
next release of the BeOS: Watch the Be web site for the announcement.

Click the left arrow to return to the beginning of the MIDI file; drag the 
square to where you want to start playing; click the right arrow to start 
playing the file.

Type a 
different 
tempo 
here

Click S to 
play a 
track solo; 
Click M to 
mute the 
track.

Click K to 
see the 
track play 
on the 
keyboard.

Drag the 
red dot to 
pan from 
left to right.

Drag to 
adjust a 
track’s 
volume
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Minesweeper

Minesweeper is game you may be familiar with. When you start Minesweeper, a 
window opens with a grid of squares, representing a mine-infested sea. You play 
Minesweeper by finding and flagging the mines in the sea as quickly as you can, while 
trying not to blow up a mine.

When you click in a square, a number tells you how many mines are in the eight squares 
adjacent to it. With practice, you can determine from the numbered squares where the 
mines are. You flag a square you know contains a mine by clicking on it with the 
secondary mouse button (initially the right mouse button, though you can change that as 
described in “Mouse” on page 127). If you want to flag a square as a possible mine, you 
can mark it with a question mark by clicking it with the secondary mouse button twice; 
click again to clear the question mark.

The number at the top left of the window tells you how many mines remain unflagged. 
The seconds that have elapsed since you clicked the first square are displayed at the top 
right.

If you click on a square that hides a mine, the game is over: The smiling face turns to a 
frown and all the mines are displayed.

If you flag all the mines, you win. If you had one of the best winning times, a panel 
prompts you to enter your name. You can choose Best Times from Minesweeper’s main 
menu to see who the current leaders are and how well they did.

To start a new game, whether you won or lost, click on the face.

As you get better, you may want to increase the challenge. Choose Intermediate or 
Expert from the main menu to start a game with a larger, more perilous sea.
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MiniPlayer

MiniPlayer is a basic audio CD player—the antidote to CDPlayer’s bells and whistles. If 
you just want to listen to a CD, MiniPlayer can handle it without taking up a lot of 
screen real estate.

MiniPlayer’s controls are a subset of those in the CDPlayer application. For information 
about MiniPlayer’s controls and menu items, see “CDPlayer” on page 80.
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NetPositive

If you’ve used the Network preferences to establish a direct Ethernet or a PPP 
connection to the Internet, you can use NetPositive to surf the world-wide web (for 
information on Network, see “Network” on page 128). Even if you’re not connected to a 
network, you can use NetPositive to read HTML documents on disk, such as the HTML 
editions of The Be Book, the reference to the Be API, and Metrowerks’ CodeWarrior 
Documents for Be. (HTML, the Hyper Text Markup Language, is the formatting 
language used for world-wide web documents, or “pages.”)

When you start NetPositive, a window opens with a starting page.

You navigate the world-wide web by clicking links, text or icons that open other web 
pages. Text that is a link is marked with an underline. You can tell whether an icon or 
other art is a link by observing the text field at the top of the window: If the text in the 
field changes when you position the cursor over an icon, it’s a link. This is also a 
convenient way to tell what page a link refers to.

You can open a page directly if you know its URL (Universal Resource Locator). These 
start with http:// and are followed by the unique address of a page. For example, the 
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Be, Inc. home page’s URL is http://www.be.com Type the URL for a page in the text 
field at the top of the NetPositive window to go to that page. If you choose Open 
Location from NetPositive’s main menu, you can type a URL for a page and click Open 
to open a new NetPositive window with that page.

You can open an HTML file that’s on disk by choosing Open File from NetPositive’s 
main menu. This is how you open the starting pages of the on-line documentation. 
Another easy way to open an HTML file is to drag it onto NetPositive’s icon.

You can click the left-pointing arrow button at the top of the NetPositive window to go 
back to the last page you had open. Click the right-pointing arrow to go forward again.

Some world-wide pages take a long time to open, because they contain large graphics or 
other large pieces of information or because they’re coming from a computer connected 
to a slow part of the Internet. You can stop loading a page by clicking the square button 
to the right of the arrow buttons at the top of the NetPositive window.

NetPositive can play QuickTime movies that were saved using the Cinepak compressor 
with the “Playable on other computers” option checked (that is, they’re “single-fork” or 
“flattened” movies). If you have QuickTime movies of this kind, you can transfer them 
to the BeOS, add the “.mov” extension to the ends of their file names, and drag them 
onto the NetPositive icon to play them. Most movies have information about how fast 
they should be played. If you check Fast Movies in NetPositive’s main menu, 
NetPositive plays movies as fast as it can. If Fast Movies is unchecked, NetPositive tries 
to play movies at the speed they were designed to be played.

NetPositive displays parts of icons and other art as it gets them. Initially it draws them 
with a “venetian blind” effect: Drawing the whole piece of art at increasing resolution as 
it gets it. But you can uncheck Dither in NetPositive’s main menu to have NetPositive 
draw art at full resolution, starting from the top of the piece of art and moving to the 
bottom.
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PlaySound

You can listen to an audio file by dragging it onto the PlaySound icon. PlaySound can 
use the DAC (Digital-to-Audio Converter) circuitry on the BeBox I/O board to play 
audio files in “raw,” AIFF (Audio Interchange File Format), and WAVE (Waveform 
Audio File Format) format. 

When you drag a sound file onto the PlaySound icon, a small window opens with a Stop 
button. Click Stop to stop playing the sound. Depending on the Sound preferences 
application settings and the devices connected to the BeBox, you hear the audio file on 
the internal BeBox speaker or on a device connected to the line-out ports (see “Sound” 
on page 139 for more information).

A number of sound files are included in the /optional/sounds folder on the BeOS CD-
ROM.

PoorMan

PoorMan is a simple but effective world-wide web server. A web server is an application 
that makes a web site available to a network: Either to a company network or, if the 
network is configured to allow it, to the whole Internet. PoorMan can host a web site 
made up of files in HTML, JPEG, and GIF formats. HTML (the Hypertext Formatting 
Language) is the formatting language used for world-wide documents, or “pages.” JPEG 
and GIF are graphics file formats commonly used for illustrations in world-wide web 
pages.

When you start PoorMan, a window opens with a status area and two buttons. When you 
click Start, PoorMan looks for a “home page” (the starting point for a web site) named 
index.html in a folder named /public_html on the boot disk. If they don’t exist, 
PoorMan creates them. The index.html file PoorMan creates is a very simple web page 
in HTML format.
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When PoorMan is running, others on your network can use their web browsers to view 
the pages on your site. Depending on how your network is set up, they may be able to 
simply type your BeBox’s hostname or IP address to open your site’s home page (the 
/public_html/index.html file).

Each time someone browses a page or image on your web site, the “hit” is recorded in 
the total in PoorMan’s window. Click “Clear Hits” to return the count to zero.

Unfortunately, you can’t use NetPositive to browse the pages PoorMan is serving on the 
same BeBox (though you can use NetPositive to browse pages PoorMan is serving on 
other BeBoxes on a network). For more information about NetPositive, see 
“NetPositive” on page 110.

Pulse

The Pulse application shows you the relative load on the BeBox’s two PowerPCs—an 
on-screen version of the information displayed by the two LED arrays on the front of the 
BeBox. Pulse also shows you the model and clock speed of the BeBox CPUs.

ROMUpdater

Part of the BeOS system software is actually on a programmable “flash ROM” chip on 
the BeBox motherboard. If Be sends you a file with updated software for the flash ROM, 
you update the ROM chip by dragging the update file onto the ROMUpdater application.

Nothing happens if you simply double-click ROMUpdater.

Click a numbered button to “turn off” one of 
the CPUs. If you click both buttons, you’ll 
have to restart the BeBox!
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SCSIProbe

You can use SCSIProbe to find out information about SCSI devices. When you start 
SCSIProbe, a window opens that lists each SCSI device connected to the BeBox. The 
BeBox itself is always at SCSI ID 7. Other SCISI devices are listed in the window, in 
order of their SCSI IDs. In the Type column, hard disks are listed as “DISK” and CD-
ROM drives are listed as “ROM.”

If you can’t read all the text in a column, you can make a column wider by dragging a 
column divider. Hold down the Option key (the key labeled “Ctrl” to the right of the 
spacebar on most PC keyboards) while you click on a column divider to restore it to its 
original position.

To ensure that all devices are listed, click the Update or Mount button.

You can cause the drive light on a SCSI device to flash by clicking it’s corresponding 
number in the ID column. This makes it easier to determine which physical disk is at a 
particular SCSI ID.

SCSIProbe was originally written as a Macintosh control panel, and some features of 
this port are available in the BeOS version but not recommended: The Update button 
changes to Reset if you hold down the Option key, but clicking Reset resets the SCSI 
bus, which will likely crash the BeOS. In addition, only the BeBox SCSI bus appears if 
you press the ID column title.
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Terminal

The Terminal application opens a window where you can work with the Be shell. The 
Be shell is a UNIX-style, command-line environment based on bash (the Bourne-Again 
Shell, created by Brian Fox and Chet Ramey).

Most of the programs you work with in a Terminal window are in the /bin folder. 

You can open as many Terminal windows as you want: Just keep double-clicking the 
Terminal icon or choose Start New Terminal from the Terminal menu. The Switch 
Terminals command in the Terminal menu makes another open Terminal window the 
active window, so you can cycle through them quickly from the keyboard by pressing 
Command-g.

You can use the commands in the Settings menu to customize how Terminal displays the 
text in its window:

• Choose traditional dimensions (in characters) for the current window from the 
Window Size submenu.

• Choose a font and font size Terminal uses to display the text in its window from 
the Font submenus, but note that only monospaced fonts are included in the menu 
(Terminal relies on the constant character widths of monospaced fonts to align 
text and to display other text effects). Also note that Kate, the font Terminal uses 
initially, is only available in one size.

• Set the number of space characters Terminal substitutes for Tab characters by 
choosing a number from the Tab Width submenu.

• Choose Color to open a panel where you can set the foreground and background 
colors of text, selected text, and the text cursor.

Choose Save as Defaults to use the current settings every time you start Terminal. You 
can also use the Save as Settings File command to create a Terminal settings file. You 
can double-click a Terminal settings file to start Terminal with the saved settings in 
effect.
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You can use the keyboard to scroll the contents of the Terminal window:

Press To scroll

Shift–up arrow Up one line

Shift–down arrow Down one line

Shift–page up Up one windowful

Shift–page down Down one windowful

The default shell environment is set by the /system/profile file. You can modify the 
environment by making a copy of that file, changing it, and saving it in the root folder of 
the boot disk with the name, .profile.

Learning About bash and the Programs in the /bin Folder

Explaining how to work on a UNIX-style command-line is beyond the scope of this 
user’s guide. In fact, there are lots of good books on the subject available in any book 
store with a well-stocked section on computers.

A copy of the man pages for bash and for a great many of the programs in /bin are 
included in HTML format in the /documentation/Shell Tools/HTML folder. Man 
pages are the traditional, descriptive (if terse) documentation for UNIX-style programs. 
You can read the man pages by opening the index.html file (it’s in the HTML folder) 
with NetPositive’s Open File command (for more information on NetPositive, see 
“NetPositive” on page 110). The index.html file contains an alphabetical list of the man 
pages, with links you can click to open the man page you want to read. Because the man 
pages make heavy use of the <pre> HTML code, you may also find them readable in a 
text editor, such as Edit. 

When you’re working in Terminal, you can also get a small amount of information about 
many of the programs in /bin (often enough to get by) by entering the name of the 
program followed by the --help flag (that’s two hyphens followed by “help”). Enter help 
in Terminal to read about bash itself.



Workspaces

Be User’s Guide Chapter 4: Using Be Applications  –  117

Workspaces

When you first start working with the BeBox, you have one workspace: A desktop and a 
set of windows that open on it, which you arrange to suit your projects. With the 
Workspaces application, you can arrange up to 32 such workspaces.

When you first start Workspaces, a window with nine panes opens. Each pane represents 
a workspace, with a miniature version of the dock and each window open in that 
workspace. Click in a pane to switch to that workspace. You can also switch workspaces 
by holding down the Command key while you press the function key that corresponds to 
that workspace (counting from left to right, top to bottom in the Workspaces window): 
Command-F1 to switch to the first workspace, Command-F2 to switch to the second, 
and so on.

The workspace you’re currently working in is called the active workspace. When you 
open a window it opens in the active workspace. Many windows can be open in only one 
workspace at a time. This is true for Edit document windows and the windows that open 
when you start most of the preferences applications. If a window is already open in a 
workspace and you open it again, you switch to the workspace where the window is 
already open. Other applications and their windows behave differently. For example, 
when you start the Clock application, the Clock window opens in all workspaces (this is 
also true for the Workspaces application itself). A third model is offered by folder 
windows in the Browser: They open in the active workspace when you double-click 
their folder icons, even if they’re already open in another workspace.
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If a window is open in more than one workspace, you can move it to a different location 
in each workspace. However, changing the size of a window, minimizing it, or closing it 
in one workspace does the same to all copies of the window in all workspaces.

You can drag an application’s icon into a pane in the Workspaces window to start it in 
that workspace.

You can use the Screen application to give each workspace a different desktop color—
this can help keep them distinct. The resolution (number of pixels on the screen) and 
color depth (bits per pixel) also only apply to the current workspace. See “Screen” on 
page 135 for more information.

If you want to work in more or fewer workspaces, choose the number you want from the 
Workspaces submenu in the Workspaces applications’ main menu. If you increase or 
decrease the number of workspaces, panes are added or removed from the Workspaces 
window in order, starting from the bottom right. You can’t reduce the number of 
workspaces if it would remove a workspace that has open windows: Close any open 
windows first. Avoid the higher prime numbers of workspaces—the Workspaces 
window can’t lay them out very legibly.

Every workspace is represented by a pane in the Workspaces 
window. The pane for the active workspace has a black 
border. Click in a pane to switch to that workspace.

Every open window is represented in 
miniature, with as much of its title as 
fits.

Drag a window from one pane to 
another to move it to that 
workspace.

The windows for some applications, 
such as the Workspaces application 
itself, open in all workspaces.
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5 Customizing the 
BeOS

The BeOS comes with a number of applications you use to configure and customize the 
BeOS. These applications are in the /preferences folder. You can also customize the 
BeOS by adding files that appear as images on the Be desktop or that add functionality, 
such as fonts and add-ons. This chapter describes the applications in the /preferences 
folder in alphabetical order. It then shows you how to customize the BeOS by adding 
fonts, add-ons, and other files.

Boot

A chip on the BeBox motherboard stores information about the disk you prefer to boot 
(or “start up”) from—that is, if you have more than one SCSI or IDE disk connected to 
the BeBox, which disk you want the BeBox to try load system files from first, before 
trying any other SCSI or IDE disk. You can change the boot preference with the Boot 
preferences application. (For more information on how the BeBox looks for a boot disk, 
see “Selecting a Boot Disk” on page 16).

When you start Boot, a window opens that lists each mounted disk by the name (for 
information on mounting disks, see “Working with Disks” on page 45). The current boot 
disk is marked with a bullet ( ). If the configuration of one of the disks in the list (that 
is, a master or slave IDE disk or SCSI disk at a specific SCSI ID) matches the current 



Boot

120  –  Chapter 5: Customizing the BeOS Be User’s Guide

boot preference, it’s selected in the list. You can change the boot preference to match the 
configuration of a mounted disk by clicking a name in the list.

You can choose Expert from the pop-up list at the top of the Boot window to view the 
boot preference as it’s stored on the BeBox motherboard: That is, by SCSI or IDE disk 
configuration rather than by the name.

In Expert view, you can use the buttons and pop-up lists to change the boot preference to 
any possible configuration of IDE or SCSI disk—even the configuration of a disk that 
isn’t currently mounted. For SCSI disks, only the built-in SCSI bus is typically 
available, and unless you have a SCSI drive with more than one disk in it, the LUN 
(Logical Unit Number) should be left at 0.

If you change the boot preference, the BeBox will try to boot from the disk you selected 
the next time you start the BeBox.

To find out the SCSI IDs of SCSI disks connected to the BeBox, you can use the 
SCSIProbe application, which is described in “SCSIProbe” on page 114.
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E-Mail

You use the E-Mail preferences application to configure the Be software that sends and 
receives e-mail. To send and receive e-mail, you need an e-mail account on a POP (Point 
Of Presence) or SMPT (Simple Mail Transfer Protocol) server, which you connect to via 
an Ethernet network or PPP connection (you set up an Ethernet or PPP network 
connection with the Network preferences, as described in “Network” on page 128).

When you start the E-Mail preferences application, the E-Mail window opens.

1 Enter information about your e-mail account.

Your user name and password are the name and password you use when you log 
into your e-mail service provider. Typically, your name is the first part of your e-
mail address: For example, if your e-mail address is me@mycompany.com or 
me@myserviceprovider.com, your user name is “me”.

For most e-mail accounts, the POP host and SMTP hosts are the same: The IP 
address or the host name of the computer that stores and forwards the e-mail you 
send and receive.

If you’re not sure what to enter in the Account Info fields, ask your system 
administrator or Internet service provider.
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2 Use the pop-up menus in the Mail Schedule area to set when and how often to 
send mail you’ve created and to check for and download new mail.

Initially, the E-Mail preferences are set to exchange mail every 15 minutes, from 
9:00 am to 5:00 pm, weekdays. If you want to exchange mail around the clock, set 
the From and To times to the same time.

3 Check options for how you want to be notified when you receive new mail.

4 If you have another application that you want to use to compose and read mail, 
drag it on top of the current icon in the Mail Reader area of the E-Mail window.

You can also use the Select button to open a panel where you can select the 
application you want to use.

Initially, you use the BeMail application (in the /apps folder) to compose and read 
mail, as described in “BeMail” on page 74. The BeMail application offers basic e-
mail features; as third-party developers create more sophisticated e-mail 
applications, you can use them instead.

5 Click Save.

If you checked “Show status window,” the E-Mail Status window opens with 
information about the number of e-mail message you’ve received since you last 
checked for new mail and the number of e-mail messages you haven’t read yet.

You read and create e-mail messages with the BeMail application, which is described in 
“BeMail” on page 74.
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Keyboard

When you press a key on the keyboard, a character appears on-screen (or some other 
action takes place). If you hold down a key, the BeOS waits a brief moment and then 
acts as if you were repeatedly pressing that key. For example, if you press and hold 
down a character key when the insertion point is in a text field, a character appears in the 
field and then after a brief delay, more copies of that character appear. You can use the 
Keyboard application to increase or decrease the delay after you first press a key before 
the key repeats, and how quickly a key repeats once it starts repeating.

Click Revert to restore the key repeat settings that were in effect when you first started 
the Keyboard application. Click Defaults to restore the settings that were in effect when 
you first installed the BeOS.

Drag to make keys repeat faster or slower.

Drag to make the delay before keys repeat shorter 
or longer.
Test your settings by typing here.
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Keymap

The Keymap application opens a window that shows you the current keymap, that is, the 
character you see on screen when you press each key. You can type on the keyboard or 
click keys in the Keymap window to see the resulting character in the field at the top of 
the Keymap window. If you press one or more modifier keys (such as Shift, Option, or 
Control) on the keyboard or click them in the Keymap window, the keycaps change to 
show you what characters are mapped to the keys when the modifier keys are pressed.

Different fonts map characters to different keys. You can choose a font from the Font 
menu to see that font’s mapping in the Keymap window. This is also a useful way to 
look for characters you don’t use very often, such as bullets, accents, or other special 
characters.

The prerelease version of the BeOS comes with two preset keymaps: “Qwerty,” the 
standard keymap in the U.S.; and Dvorak, a popular alternative keymap. You can switch 
between those two keymaps by choosing one from the Map menu.

You can create a custom keymap by using the secondary mouse button to drag 
characters to the keys you want to map them to. You can also use the secondary mouse 
button to drag characters from other applications, such as FontChart.
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Each keymap is made up of nine mapping tables: A table of what each key produces 
when you type it with no modifier key pressed, or with the Shift, Control, or Option key 
pressed, plus all the possible combinations of these keys.

If you use the tertiary mouse button to drag a character from one keycap to another, you 
actually drag all 9 characters associated with that key in the nine tables in the keymap.

You can save a keymap by choosing Save or Save As from the File menu. To use a 
keymap you’ve saved, drag the keymap file into the Keymap window.

Choose Save As System from Keyboard’s File menu to save the keymap in the Keyboard 
window as a special keymap file, /system/settings/key_map, which is used as the 
default keymap each time you start the BeOS.

You can revert to the default keymap at any time by choosing System Startup from 
Keymap’s Map menu. If you delete the /system/settings/key_map file, you revert to the 
BeOS’s idea of a default keymap the next time you restart the BeOS.

The “Interface Kit” chapter of The Be Book, the reference to the Be API, includes 
information about keymaps of interest to programmers.

You can choose a symbol set from the Symbol Set menu. Symbol sets are conventions 
for what characters are used in fonts and keymaps. Different computers and countries 
use different symbol sets. If you’re having trouble reading a document that was created 
on another kind of computer, try switching to the symbol set used by that computer.



Menu

126  –  Chapter 5: Customizing the BeOS Be User’s Guide

Menu

You can use the Menu preferences application to change the color and other aspects of 
the appearance of menus throughout the BeOS. You can also use Menu to change how 
menus behave. When you start Menu, a window opens with a set of controls that look 
like an open menu. You can “choose” items from this menu to customize the menus in 
the BeOS.

Choose a font from the Font menu and a font size from the Font Size menu that you 
want to use in menus. The menu in the Menu window changes right away to reflect your 
choices.

If you uncheck Click to Open, you can’t open a menu or submenu by clicking its title: 
You can only drag through menus. (For more information on navigating menus in these 
ways, see “Working with Menus” on page 36.)

If you check Always Show Triggers, triggers for menu titles, commands, and other menu 
items are always visible, even when you’re dragging through menus, rather than just 
when you’re navigating menus from the keyboard or clicking menus and submenus to 
open them. (For more information about triggers, see “Working with Menus” on 
page 36.)

Choose Color Scheme to open a panel where you can select the colors you want to use 
in menus. When you click a color in the panel (if you’re using 8-bit color) or drag one of 
the red, green, or blue color component sliders (if you’re using 32-bit color), the Menu 
preferences window changes to show how the highlighting and other uses of color in 
menus will appear. (For more information setting 8-bit and 32-bit color, see “Screen” on 
page 135.)

You can choose one of three styles of menu item separators from the Separator Style 
submenu.
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Click Revert to restore the Menu preferences settings that were in effect when you first 
started the Menu application. Click Defaults to restore the settings that were in effect 
when you first installed the BeOS.

Changes you make in the Menus preferences take effect in other applications the next 
time you start them (or in the case of the Browser, the next time you start the BeOS).

Mouse

You can use the Mouse application to set your preference for a number of ways a mouse 
works with the BeBox. You can set whether you’re using a one-, two-, or three-button 
mouse and which buttons you want to use as the primary, secondary, and tertiary mouse 
buttons (for more information on the role of the mouse and mouse buttons in the BeOS, 
see “Using the Mouse” on page 22). You can set how quickly you have to click the 
mouse button before the BeBox interprets two clicks as a double-click. You can also set 
how rapidly the cursor moves across the screen when you move the mouse.

When you start up the Mouse application, the Mouse window opens.

Choose the number of 
buttons on your mouse. 

Press a mouse button in the diagram to 
choose whether you want it to act as a 
primary (1), secondary (2), or tertiary (3) 
mouse button

Click to revert to the default settings.

Use this text to test your double-click setting.

Drag this slider to 
adjust the interval 
before the BeBox 
interprets two 
clicks as a double-
click.

Drag this slider to 
adjust how 
rapidly the cursor 
moves when you 
move the mouse.
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Network

You use the Network application to configure how the BeOS communicates with other 
computers. You can configure the BeOS to communicate across an Ethernet network 
connected to an Ethernet network adapter in the BeBox. You can also configure the 
BeOS to communicate using PPP (the Point-to-Point Protocol) through a serial port, via 
a modem or via a direct cable connection to the serial port on another computer.

You can configure multiple network interfaces—for example, if you have more than one 
network adapter installed in the BeBox. However, it’s up to the software you’re using to 
know which interface to use.

Important: Before you start, be sure to let your network administrator or Internet service 
provider know you’re connecting a new computer to the network. Your network 
administrator or service provider will also provide you with information you’ll need to 
enter in Network.

Configuring Network Basics

1 Start up the Network application.

2 Enter information about yourself, the BeBox, and the network.

You may need to ask your network administrator for some of the information 
requested by the Network window.
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• In the Domain Name field, enter the name of your network domain.

• In the Primary Nameserver field, enter the IP address of your network’s 
primary DNS server, if it has one.

If your network doesn’t have a DNS server, or if you or your network 
administrator decide you don’t want to use it, you can create a copy of 
/system/hosts-sample, name it /system/hosts, and then edit the copy in the 
Edit application so it lists the names and IP addresses of the computers you 
want to connect to. Your network administrator may have a standard hosts file 
for all the machines on your network.

• In the Secondary Nameserver field, enter the IP address of your network’s 
secondary (or backup) DNS server, if it has one.

• In the Hostname field, enter a name for the BeBox (most network 
administrators let you pick this name).

• If you want to allow users on other computers to use the ftp utility to put and 
get files from your BeBox, check the Enable FTP Server option.

• If you want to allow users on other computers to use the telnet utility to 
connect to the BeBox, check the Enable Telnet Server option.
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• In the User Name field, enter the name you want to use when connecting to 
the BeBox from another computer. (You can’t use ftp or telnet to connect to 
the BeBox from another computer unless you enter a name in the User Name 
field.) The user name you enter is also used as the default user name when you 
run ftp on the BeBox.

• Click the Password button to open a panel where you enter the password you 
want to use when connecting to the BeBox from another computer using ftp or 
telnet. Because the Password panel doesn’t display the text you type for your 
password, it asks you to enter the password twice to make sure you don’t 
make a mistake while typing.

• In the Router field, enter the name of the “smart” router on your network, if it 
has one.

Adding an Ethernet Network Interface

If you added an Ethernet network adapter in the BeBox (as described in“Adding a 
Network Adapter” on page 6), you use the Network application to configure the BeOS 
to use it.

1 Click Add Ethernet.

A panel opens with a list of the Ethernet adapters supported by the current release 
of the BeOS.
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2 Click the kind of Ethernet adapter you’re using and click Add.

A panel opens where you enter information about the Ethernet network adapter 
installed in the BeBox and about the network it’s connected to. You may need to 
check with your network administrator for this information.

3 In the IP Address field, type the IP address of the network adapter card in your 
BeBox.

This number uniquely identifies the BeBox computer on the network.

4 In the IP Netmask field, type the netmask for your class of network, if required.

5 Depending on the Ethernet card you’re using, choose the IRQ, port, and other 
settings that match the configuration of the network adapter.

6 Click OK.

The new network interface is added to the scrolling list at the top of the Network 
window.
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Adding a PPP Network Interface

You can configure the BeOS to communicate with a network using PPP (the Point-to-
Point Protocol). PPP is the protocol many Internet service providers offer to subscribers 
who connect via modem. If you want to communicate directly with a computer that can 
host a PPP connection, you can also configure the BeBox to communicate with that 
computer though their serial ports, using a cable called a “null modem cable.”

If you’re setting up the BeBox to work with an Internet service provider, review these 
instructions and check with your service provider to determine the correct settings.

1 Click Add PPP.

2 If your service provider establishes your IP address each time you connect (this is 
sometimes called “dynamic addressing”), make sure “Obtain from server” is 
checked. Otherwise, uncheck this option and type the IP address assigned to you 
(this is sometimes called “static addressing”).

3 Choose the serial port the modem or null modem cable is connected to.

4 Choose the speed at which you want to communicate through the serial port.

Note: Serial ports 1 and 2 are reliable up to 155200 baud. Serial ports 3 and 4 are 
reliable up to 38400 baud.
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5 If you’re connecting the BeBox directly to another computer via a null modem 
cable connected to the two computers’ serial ports, check “Direct connection.” If 
you’re using a modem to call a service provider, uncheck this option and type the 
phone number of the service provider.

Type the number exactly as you would dial it: If you normally have to dial a 
number to get an outside line, type that number first, and don’t forget to include a 
1 and an area code if it’s a long distance call. For more information, see the 
modem’s owner’s guide.

6 If your service provider uses PAP (the Password Authentication Protocol), leave 
the “UNIX style” option unchecked. If your service provider uses a more 
traditional “UNIX style” method to log you in, check that option and enter your 
user name and password.

7 Check the “Display chat when connecting” option if you want to observe the 
messages the BeBox and the host computer exchange as a connection is 
established.

8 Unless you’re debugging a PPP problem with assistance from Be, it’s best to leave 
the “Log all bytes sent/received” option unchecked.

If you check this option, all bytes sent and received during each PPP session are 
stored in two files, /system/ppp-write.log and /system/ppp-read.log. Because 
these files are never erased, they can grow very large.

9 Click OK.

The new PPP interface is added to the list at the top of the Network window.

Saving Network Settings and Restarting the Network Software

Once you’ve configured the settings in the Network window and added the network 
interfaces you need—or if you make any changes—click the Save button. Your changes 
are saved and a panel asks if you want to restart the network. Click Restart to restart the 
BeBox’s networking software so the new settings take effect right away (otherwise, the 
settings don’t take effect until the next time you restart the BeOS).
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Changing the Modem Initialization String

If you use Network to set up a PPP connection via a modem, Network stores a generic 
modem initialization string in the /system/settings/network file (along with the other 
network settings). This string should work for modems that understand the “Hayes AT” 
command set, which most modems use. If you need to use a different string for your 
modem, you can use the Edit application to open the network file and edit the string: 
It’s in the line that starts “CHAT_SCRIPT.”

The Be PPP software relies on the following modem settings:

• Disable echo (also known as “full duplex”) between the BeBox and the modem

• Determine the serial port rate by the rate of the last AT command

• Enable hardware flow control (CTS and RTS) between the BeBox and the modem

• Disable software flow control between the BeBox and the modem

If you’re using a U.S. Robotics Sportster modem, replace the entire “CHAT_SCRIPT” 
line with the line:

CHAT_SCRIPT = \dATE0Q0&B1&H1&R2&I0 OK ATDT\p CONNECT

If you’re using a Motorola Bitsurfr ISDN modem, replace the entire “CHAT_SCRIPT” 
line with the line:

CHAT_SCRIPT = \dAT&F&C1&D2S0=0%A2=95@B0=2%A4=0 OK ATDT\p CONNECT

Note that each time you click Save in the Network application, it edits the 
/system/settings/network file, so you will need to restore your edits to the file using the 
Edit application.

Another way to send an initialization command to a modem is to use the Connect 
Directly command in the Connect application, which is described in “Connect” on 
page 84. Some modems allow you to save an initialization command as a default when 
you turn them on.

For more information about modem initialization strings, see your modem’s user’s 
guide.
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Screen

You use the Screen application to set how the BeOS, graphics card, and monitor interact 
to display the BeOS. You also use Screen to set the color of the desktop.

Setting the Screen Resolution, Colors, and Refresh Rate

Initially, the BeBox works with the graphics card and monitor to display a screen 
resolution of 640 pixels horizontally and 480 pixels vertically, using 8 bits of color data 
per pixel (sometimes referred to as the “screen depth”), with a refresh rate (the number 
of times per second the screen is redrawn) of 60.1 Hz. If you have a graphics card and 
monitor that can accommodate a higher resolution, more colors per pixel, or a faster 
refresh rate, you can change these settings with the Screen preferences application.

For information about what kinds of graphics cards work with the BeBox and DR8, see 
“Adding a Graphics Card” on page 5 and the Be web site (http://www.be.com).

When you start up the Screen application, the Screen window opens.

You change a setting by choosing from the pop-up lists, or by dragging the Refresh Rate 
slider, and then clicking OK in the panel that asks you to confirm the change. You can 
also adjust the refresh rate by pressing the left or right arrow key on the keyboard—this 
technique is useful to fine-tune the best-looking refresh rate.

Warning: You risk damaging the monitor and even starting a fire if you select a 
resolution, number of colors per pixel, or refresh rate the monitor isn’t designed to 
support. Read the owner’s guides that come the monitor and graphics card to find out 
what combinations of settings are safe for the monitor.
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If your graphics card or monitor can’t support a setting you make, you may not be able 
to read anything on the screen—but if you wait a few seconds, the screen reverts to the 
previous setting if you don’t click OK.

You can uncheck Confirm Changes in Screen’s main menu, so you don’t have to click to 
confirm each setting change in a panel. If you do this and then change a setting that 
makes the screen unreadable, you can use keyboard shortcuts for commands in Screen’s 
main menu to restore the default settings: Command-d for Default Resolution and 
Command-r for Default Refresh Rate. Or in a pinch, press Command-Control-Shift-F12 
to restore all default settings except desktop color (this shortcut works at any time, even 
when Screen isn’t running, though the default settings aren’t saved unless Screen is 
running).

If you choose a very high resolution, a panel warns you that you risk damaging your 
monitor if it can’t support that setting. If you’re entirely certain that your graphics card 
and monitor can support any resolution, number of colors, or refresh rate you choose, 
you can uncheck Confirm High Resolution in Screen’s main menu to circumvent these 
warnings, but be warned: This is a Be-tested way to destroy expensive monitors!

The changes you make to the resolution and number of colors only affect the active 
workspace, so if you’re working with more than one workspace (as described in 
“Workspaces” on page 117), you can set a different resolution and number of colors for 
each workspace.
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Adjusting the Screen Size and Position

When Screen is the active application, you can adjust the size of the screen image on the 
monitor by holding down the Shift key while you press the up or down arrow key. You 
can adjust the position of the screen image by holding down the Control key (the key 
labeled “Ctrl” in the lower-left corner of most PC keyboards) and pressing the up, down, 
left, or right arrow key. To restore the default screen size and position, choose Default 
Position from Screen’s main menu.

Setting a Desktop Color

The desktop—the “background” of the screen—is initially solid blue, but you can pick a 
different color with the Screen application.

If you choose 8 bits of color information per pixel, the lower portion of the Screens 
window shows the 256 colors you can choose from for a desktop color (at 8 bits per 
pixel, you can display up to 28 (that is, 256) colors on the screen at one time). Click the 
color you want.

If you choose 32 bits of color information per pixel, the lower portion of the Screen 
widow offers three sliders, for the red, green, and blue components of the over 16 
million colors you can display on the screen at one time (only 24 of the 32 bits are used 
for color information, and 224 equals 16,777,216). Drag each slider until you find a 
combination that produces the color you want.

If you’re using the Workspaces application to work in more than one workspace (as 
described in “Workspaces” on page 117), the color you pick only affects the active 
workspace—the one where you’re using Screen—so you can give each workspace a 
distinct desktop color.

You can also display an image on the desktop, instead of a solid color, as described in 
“Displaying an Image on the Desktop” on page 143.
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ScrollBar

Initially, many windows in the BeOS use “proportional scroll bars,” as described in 
“Scrolling the Items in a Window” on page 27.

If you don’t like proportional scroll bars, you can use the ScrollBar application to set 
your preference to a fixed-size scroll knob and make some other choices about how 
scroll bars look and behave.

Click the arrow style, knob style, and knob type you prefer. Drag the green arrow to 
adjust the minimum scroll knob size. Click Defaults to return all the settings to the way 
they were when you first installed the BeOS. The settings you make in ScrollBar affect 
windows when you next open them.
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Sound

You can use the Sound application to select the input and output sources and volumes of 
a number of audio features on the BeBox.

When you start up the Sound application, the Sound window opens. The arrangement of 
the features in the Sound window shows you they relate to one another.

Use the controls on the left side of the Sound window to select an input to the ADC (the 
Analog-to-Digital Converter circuitry in a chip on the BeBox I/O board), and the 
“loopback” signal from the ADC to the DAC (the Digital-to-Analog Converter).

Use the controls on the right side of the Sound window to control the inputs to and the 
volume of the line-out ports, the headphone port, and the speaker.

Drag a slider to adjust the volume of an input or output feature, or check a Mute box to 
turn it off. If a slider is split into left and right channels, you can use the secondary 
mouse button to adjust the channels independently.

Drag a slider up or down 
to increase or decrease 
volume. Use the 
secondary mouse 
button to adjust the 
volume of the left or right 
channel independently.

Click a mute box to 
mute that feature.
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Time

Clock circuitry on the BeBox motherboard keeps the time, even when the BeBox is 
turned off. You set the date and time on the BeBox with the Time application. When you 
start Time, a window opens with the BeBox’s notion of the current date and time. Click 
the component of the date or time you want to change and then set the correct date or 
time using the controls for that component: Adjust the date or time using the small 
arrows; type an hour, minute, or second; or directly click a date on the calendar. Your 
changes take effect immediately.

Click the part of the 
date or time you want to 
change and then click 
the arrows to change 
the current date or time.
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Adding Fonts

The BeBox includes a TrueType font renderer, which displays TrueType-format fonts on 
the screen at virtually any size. A small set of TrueType fonts is included with the BeOS. 
They’re stored in the /system/fonts/ttfonts folder. Two bitmap fonts used by the Be 
software, Emily and Erich, are stored in the /system/fonts/system_fonts folder. (A third 
bitmap font, Kate, is built into the system software.)

You can purchase additional TrueType fonts in PC (not Macintosh) format and install 
them on the BeBox, so they’re available in applications that work with fonts, such as 
Edit and FontDemo. A few kinds of TrueType fonts don’t work on the BeBox, but most 
do.

1 Copy the TrueType fonts you want to onto a Macintosh, UNIX, Windows, or DOS 
computer’s disk.

If you’re using a recent version of the Macintosh operating system, you can just 
insert the disk the font came on in the floppy disk drive and copy the fonts you 
want onto your hard disk. For more information, see the Macintosh User’s Guide 
or on-line help.

2 Use ftp to copy the fonts to the BeBox.

If you don’t have a network set up, you can also use tar to copy the fonts to the 
BeBox using a floppy disk. For more information about ftp and tar, see 
Appendix B, “Transferring Files to and from the BeOS.”

3 Move the fonts to the /system/fonts/ttfonts folder on the BeBox.

4 Make sure the fonts have the .ttf extension (uppercase letters don’t work).

5 Restart the BeBox.
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Adding Drivers and Add-Ons

You can add software to the BeBox that make it work with new kinds of devices or with 
familiar devices in new ways. This kind of software is called a driver. You can also add 
software that extends the functionality of existing applications. This kind of software is 
called an add-on.

Adding a driver or add-on is as simple as copying it into the appropriate folder in the 
/system folder on the boot disk.

For the purposes of adding them, there are two kinds of drivers: Graphics card drivers 
(sometimes called “graphics drivers”) and all other kinds of drivers.

Adding a Driver

To add a graphics card driver, copy it into the /system/add-ons/app_server folder and 
restart the BeBox.

Caution: Don’t replace, rename, or delete the supervga file in the /system/add-
ons/app_server folder, or you won’t be able to restart the BeBox.

Installing a graphics card in the BeBox is described in Chapter 1, “Assembling the 
BeBox.”

To add any other kind of driver, copy it into the /system/drivers folder and restart the 
BeBox.

Adding an Add-On

To add an add-on, create a folder in the /system/add-ons folder with the same name as 
the application the add-on adds onto (for example, the BeOS comes with an add-on for 
the Browser in the /system/add-ons/Browser folder). Then copy the add-on into that 
folder. The add-on is available immediately.

In most applications, the functionality the add-on provides is one or more commands in 
an Add-Ons menu. For example, the MakeArchive add-on adds the Make Archive 
command to the Add-Ons submenu in most Browser windows’ File menus. You can use 
the Make Archive command to make a tar archive of selected files or folders.
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Displaying an Image on the Desktop

You can display an image file on the desktop, instead of a solid color.

1 Use an application on another platform (such as Photoshop on a Macintosh) to 
save an image file in OS/2 BMP format.

You can use any size image as a desktop image, as long as the width of the image 
is divisible by 4. However, if you use an image that’s not the same size as the 
resolution you use on the BeBox—such as 640 × 480, 800 × 600, or 1024 × 768 
pixels—the image will be cropped if it’s larger, or repeated if it’s smaller than the 
screen.

2 Use ftp or tar to place a copy of the image file on the BeBox.

For information on ftp and tar, see Appendix B, “Transferring Files to and from 
the BeOS.”

3 Name the image file DesktopImage and place it in the /system folder.

4 Restart the BeBox.

Unlike desktop colors, which can be different in each workspace, the same desktop 
image appears in all workspaces.

Caution: Displaying an image file on the desktop takes up a lot of RAM: 1.6 MB for a 
24-bit image. So if memory is tight, use a solid color instead.
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6 Developing Be 
Applications

You have a number of choices for how you develop applications for DR8 of the BeOS:

• You can use the BeOS version of Metrowerks’ CodeWarrior BeIDE (Be 
Integrated Development Environment), which is in the /develop folder. (This 
bundled version limits your source files to 68K.) Using BeIDE is described in 
“Developing Applications on the BeBox” on page 147. 

• You can purchase the unlimited version of BeIDE from Metrowerks (visit the 
Metrowerks world-wide web site to learn how: http://www.metrowerks.com).

• You can use the command-line development tools, in the /develop/tools folder, as 
described in “Using the Tools from the Command Line” on page 150.

• You can use the Macintosh version of CodeWarrior 9 to develop Be applications 
on a Macintosh and then move them to the BeOS, as described in “Developing Be 
Applications on a Macintosh” on page 153.

You also have some choices for how you debug applications:

• You can use the preliminary BeOS version of the Metrowerks source-level 
debugger, which is in the /develop/debugger folder.
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• You can use the cross-debugger for the Macintosh and it’s accompanying BeOS 
“nub,” which are in the /optional/macintosh/Cross-Debugger folder on the 
BeOS CD-ROM. Using the cross-debugger is described in “Using the Cross-
Debugger” on page 154.

• You can use the Be assembly language debugger, /bin/db, as described in “Using 
the Be Debugger” on page 167.

Other applications you use on the BeBox when developing applications are:

• Terminal, the application you use to work with the Be shell, which is described in 
“Terminal” on page 115.

• Edit, the Be text editor, which is described in “Edit” on page 88.

• AppModeler, the graphical tool for building an application’s user interface, which 
is in /develop/AppModeler.

In addition to this guide, you’ll want to refer to:

• The Be Book, the reference to the Be API, which is included in HTML format in 
the /documentation/The Be Book folder. You can read the HTML edition of The 
Be Book with NetPositive (as described in “NetPositive” on page 110) or with any 
other world-wide web browser. The Be Book is provided in other formats you can 
print or work with on other platforms in the /optional/documentation/The Be 
Book folder on the BeOS CD-ROM.

• CodeWarrior Documents for Be, the Metrowerks documentation for BeIDE and 
the other components of the Be development environment. The 
/documentation/Metrowerks/HTMLDocs folder contains the HTML edition of 
CodeWarrior Documents for Be.

Caution: The development environment won’t work as described in this chapter unless 
you carefully follow the directions in Installing Developer Release 8 of the BeOS, the 
booklet that accompanies this user’s guide.
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Developing Applications on the BeBox

Developer Release 8 of the BeOS comes with a copy of the Metrowerks development 
environment for the BeBox. You can use this environment to develop applications in two 
ways: By using BeIDE, the CodeWarrior Integrated Development Environment for the 
BeBox, or by using the compiler and linker (mwcc, mwld) and the make command in a 
Terminal window.

About the Development Environment on the BeBox

BeIDE, the folders for the headers, libraries, tools, some sample projects, and other 
parts of the Be development environment are in the /develop folder. The folders in the 
/develop folder are described below:

• /develop/AppModeler contains the first version of the AppModeler application, 
for building an application’s user interface.

• /develop/debugger contains the Metrowerks symbolic debugger. This 
preliminary version is not for the faint of heart.

• /develop/headers contains three folders:

• The be folder groups the Be header files by kit (or similar software 
categorization). For example, the app folder contains the header files for the 
Application Kit, storage files define the Storage Kit, and so on. The be folder 
also contains BeHeaders, a precompiled, tokenized version of all the Be 
header files. 

• The gnu folder contains GNU headers.

• The posix folder contains headers for the POSIX-compliant functions that are 
included with the BeOS. It also contains the ANSI C headers.
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• /develop/libraries contains libdll.a, the Be run-time support library. It also 
contains:

• libfl.a, the GNU flex library. flex is a lexical analyzer.

• librx.a, the GNU regular-expression parsing library.

• libtermcap.a, the GNU terminal-handling library.

• ralloc.a, a malloc debugging library.

• scalls.o, a system-call library for graphics drivers, which will not be 
necessary after DR8.

• libmoto.o, an optimized PowerPC library from Motorola, which is described 
in /documentation/libmoto.

• /develop/plugins contains an add-on used by the BeIDE editor.

• /develop/tools contains the compiler, linker, and disassembler: mwcc, mwld, and 
mwdis. Other development tools are found elsewhere on the disk. For example, 
make is in /bin.

• /develop/projects contains folders of sample applications, including HelloWorld, 
BeBounce, an S3 display adapter driver (complete with a ReadMe and lavishly 
commented sources), a skeleton driver project, and the sources for the 
MakeArchive Browser add-on. Each folder contains sources, a makefile, and a 
BeIDE project file.

/system/lib contains an additional Be library: libbe.so, the shared library that includes 
the Be kits and the standard C library.
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Using BeIDE

BeIDE is based on the CodeWarrior IDE for the Macintosh; they work in much the same 
way. BeIDE is documented in the HTML edition of CodeWarrior Documents for Be, 
which you can read with NetPositive. To start, use NetPositive’s Open File command to 
open /documentation/metrowerks/HTMLDocs/index.html.

To create your own application or other project using BeIDE, it’s easiest to copy the 
sample project folder (in /develop/projects) that most closely matches the kind of 
project you want to create. Rename the project file (it has a “.proj” extension) to match 
the name of your project (keeping the .proj extension), and replace the existing source 
files with your own.

Double-click the project file you just renamed to start BeIDE and to open a project 
window. In the project window, select the source files for the project you copied and 
choose Remove Files from the project window’s Project menu. Then use the Project 
menu’s Add Files command to add the source files for your project.

Choose Settings from BeIDE’s main menu to open the Settings window. Under Project, 
click PPC Project and replace the file name of the project you copied with the file name 
of your project, and type your application’s signature in the Creator field (for more 
information on application signatures, see “Creating an Application-Information 
Resource” on page 160). Click Access Paths and make sure the Project and System 
paths include all the headers and libraries you rely on in your code. Refer to the 
CodeWarrior Documents for Be to learn more about these and other settings. When 
you’re done, click the Save button and then close the Settings window.

Now you’re ready to build your application: Choose Make from the project window’s 
Project menu. BeIDE compiles and links your project. The compiled application is 
saved in the project folder, along with an “.xMAP” file for debugging (see “Using the 
Be Debugger” on page 167).

If you’re creating an application, you’ll probably want to give it an icon and other 
resources. To learn how, see “Creating Resources for a Be Application” on page 159.
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Using the Tools from the Command Line

You can use the Metrowerks tools, mwcc and mwld, to build applications on the BeBox 
from the command line in the Terminal application. These tools and the disassembler, 
mwdis, are documented in CodeWarrior Documentation for Be. This approach is 
steeped in tradition: To build an application, you edit “make” files and invoke 
command-line driven tools.

Preparing the Makefile

The easiest way to build an application is to copy the sample project (in 
/develop/projects) that most closely matches the type of project you want to build, 
remove the example sources, and add your own. 

Edit the project-building instructions, that are contained in the makefile file in the 
project folder. The essential steps are these (using the makefile from HelloWorld as an 
example):

• Replace the line

app = HelloWorld

with

app = MyApplication

where “MyApplication” is, of course, the name of your application. 
(Notwithstanding the example set by HelloWorld, the name of the folder in which 
your code lives needn’t match the name of your application.)
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• In the CPPOBJS section, replace the HelloWorld object files with your own:

CPPOBJS = \
$(OBJ)/HelloView.o \
$(OBJ)/HelloWindow.o \
$(OBJ)/HelloWorld.o

Pay particular attention to the backslash characters. Neighboring lines must be 
separated by a backslash that immediately precedes the carriage return; the last 
line mustn’t have a backslash:

CPPOBJS = \
$(OBJ)/MyApp.o \
$(OBJ)/MyWindow.o \
$(OBJ)/MyView.o \
$(OBJ)/MyOtherView.o \
$(OBJ)/MyMisc.o

• Near the bottom of the file is a list of compiler instructions that take the form:

$(OBJ)/HelloView.o: HelloView.cpp HelloView.h
$(CC) $(INCLUDES) $(CFLAGS) -o $@ -c HelloView.cpp

In general, you create an instruction of this form for each file that you placed in 
the CPPOBJS section, substituting your file names for HelloWorld’s. The first line 
lists the file’s “dependencies”: The file to the left of the colon depends on the files 
that are listed (on that same line) to the right of the colon. For example, if 
HelloView.h changes, HelloView.o will be automatically regenerated the next 
time you build the application.
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You can list any number of dependencies. You don’t need to match the object file’s 
name. For example, let’s say you have a header file (we’ll call it misc.h) that all of 
the source files in your application look at. You would add the file to the list of 
dependencies for each of the source file entries:

$(OBJ)/MyApp.o: MyApp.cpp MyApp.h misc.h
$(CC) $(INCLUDES) $(CFLAGS) -o $@ -c MyApp.cpp

The second line in the entry is (usually) a list of compiler instructions.

After you’ve edited the makefile, you’re ready to build your application.

Building the Application

To build an application, you start the Terminal application, cd to the folder where your 
application lives, and enter make:

cd MyAppDir
make -map MyApp.xMAP

The make program reads the makefile, then invokes the compiler (mwcc) and linker 
(mwld) according to the instructions that it finds there. 

To start from scratch, type:

make clean

This removes the executable file and all previously compiled object files.

If you’re creating an application, you’ll probably want to give it an icon and other 
resources. Each time you compile your application, you need to add the resources to the 
application file. To learn how, see “Creating Resources for a Be Application” on 
page 159.
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Developing Be Applications on a Macintosh

You can use CodeWarrior 9 on a Macintosh to develop applications for the BeOS. To 
develop applications for DR8, you also need to install the Macintosh version of the DR8 
headers and libraries, as described in Installing Developer Release 8 of the BeOS.

Using the CodeWarrior IDE

The CodeWarrior IDE is documented in Inside CodeWarrior 9, which is available from 
Metrowerks. However, stepping through the simple process of building the sample 
HelloWorld application is a good way to familiarize yourself with using CodeWarrior to 
build a Be application.

Create a folder on the Macintosh where you will keep your Be project files. Then 
transfer the six source files (the three files that end in “.cpp” and the three that end in 
“.h”) from the /develop/projects/HelloWorld folder on the BeBox to the new folder on 
the Macintosh, using a file transfer utility, such as ftp or tar (see Appendix B, 
“Transferring Files to and from the BeOS,” for more information). Make sure you 
transfer the files as text files, or use a file-typing utility on the Macintosh (such as 
ResEdit or FileTyper) to set their file types as “TEXT”, so CodeWarrior will be able to 
open them.

Double-click the CodeWarrior IDE to start it and choose New Project from the File 
menu. In the dialog box that prompts you to name your project, select Be Application 
from the pop-up list, type a name for your project (typically the same name as your 
application, but with a “.π” extension—in this case, HelloWorld.π), and save the new 
project in the folder where you transferred the HelloWorld source files. A project 
window opens for your new project.

Choose Add Files from the Project menu and in the dialog box that appears, double-
click each of the “.cpp” files and then click Done. This adds the HelloWorld sources to 
the project window. Note that the stationery includes BeHeaders.pch, the source file for 
the precompiled headers, so you will generate the precompiled header file (BeHeaders) 
when you build the project.

Choose Preferences from the Edit menu. In the dialog box that appears, click PPC 
Project and replace “BeApp” in the File Name field with the name of your application, 
HelloWorld in this example. Then click OK.
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Now you can build your application: Choose Make from the Project menu. The IDE 
precompiles the Be headers first. Then it compiles and links HelloWorld.

The compiled application and two symbol files are saved in the same folder as the 
project file and sources. You use the symbol file with the “.xMAP” extension to debug 
the application on the BeBox (as described in “Using the Be Debugger” on page 167), 
or the symbol file with the “.xSYM” extension to debug your application with the cross-
debugger on the Macintosh (as described in “Using the Cross-Debugger” on page 154).

Transferring An Application to the BeBox

Once you’ve built an application, you can transfer it to the BeBox using ftp or tar (as 
described in Appendix B, “Transferring Files to and from the BeOS”), or by using the 
Metrowerks cross-debugger (as described in the next section). If you transfer the files 
using ftp or tar, don’t forget to transfer the symbol file for debugging (it’s the file with 
the “.xMAP” extension).

Using the Cross-Debugger

There is a preliminary version of the Metrowerks symbolic debugger for the BeOS in 
the /develop/metrowerks/debugger folder, you may find it more convenient to use the 
cross-debugger on the Macintosh. The Macintosh cross-debugger works with a “nub 
application” on the BeBox to transfer the application you developed on the Macintosh to 
the BeBox, either across an Ethernet network or across a direct serial connection. Then 
you can use the commands and other tools in the cross-debugger on the Macintosh to 
run, stop, and debug the application on the BeBox. 

If you’re planning to communicate between the Macintosh and the BeBox across an 
Ethernet network, test the connection with ftp or another utility to make sure you can 
transfer files successfully, before you try to set up the cross-debugger and the nub. (For 
more information, see “Using ftp” on page 199.)

Caution: The connection between the cross-debugger and the Nub is fragile. Follow the 
instructions in this section carefully or you will likely crash both the Macintosh and the 
BeBox when you try to use the cross-debugger.



Developing Be Applications on a Macintosh

Be User’s Guide Chapter 6: Developing Be Applications  –  155

Setting Up the Nub on the BeBox

1 Double-click the nub: It’s named Nub.

The nub is in the /develop folder, if you copied it from the 
/optional/macintosh/Cross-Debugger folder on the BeOS CD-ROM when you 
installed the BeOS on the BeBox, as described in Installing Developer Release 8 
of the BeOS.

2 Choose Settings from the File menu in the MetroNub window.

3 Click the Misc. tab in the NubSettings window and click TCP/IP, if you’re using 
an Ethernet network, or Serial, if you’ve connected the Macintosh and BeBox 
directly by their serial ports.

4 If you’re using a serial connection, click the Serial tab and replace the “3” in 
“serial3” with the number of the serial port you’re using on the BeBox to connect 
to the Macintosh.

5 If you’re using an Ethernet network, it’s best to leave the TCP/IP Port Number in 
the TCP/IP tab at its default setting: 4712. This matches the default setting on the 
Macintosh cross-debugger.

6 Leave the Files tab alone for the moment.

7 Close the NubSettings window.

The nub stores your settings in the Be database. If its settings seem to get scrambled, or 
if the nub stops working, you can remove all the nub settings from the Be database using 
the Terminal application: cd to the folder that contains the nub and enter Nub -reset

Caution: If you quit the Nub application, you must restart the BeBox before you can 
start it again and establish a connection with the Macintosh cross-debugger.
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Setting Up the Cross-Debugger on the Macintosh

Once you’ve set up the nub on the BeBox, you can set up the cross-debugger on the 
Macintosh.

1 Double-click the cross-debugger. It’s named MW Debug XPPC-1.4.3d1.

The cross-debugger is in the same folder as the IDE, if you followed the 
instructions in Installing Developer Release 8 of the BeOS.

2 In the dialog box that asks you to select a SYM file, click Cancel.

3 Choose Target Preferences from the Edit menu and uncheck the “Automatically 
launch applications when SYM file opened” and “QC-aware” options. Then click 
OK.

4 Choose Cross-PPC Preferences from the Edit menu. If you’re using an Ethernet 
network, click TCP/IP and type the IP address of the BeBox in the Address field 
and leave the “Port no” field set to 4712—unless you had to change the port in the 
Be nub. If you’re using a direct serial connection, click Serial and click the button 
that matches the port the serial cable is connected to: Modem Port or Printer Port. 
Then click OK.

The cross-debugger is set up. You can leave it running, or quit it and restart it later, when 
you’re ready to debug an application.
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Debugging Applications

Using the CodeWarrior symbolic debugger is explained in Inside CodeWarrior 9, the 
documentation available from Metrowerks. But in outline, the process of debugging a 
Be application is fairly simple.

1 Make sure you’ve set up the cross-debugger on the Macintosh and the nub on the 
BeBox, as described above.

2 Create a folder for your application on the BeBox. Put a copy of the resource file 
for the application in the same folder (if you’ve already created one) and give the 
resource file the same name as the application, but add the “.rsrc” extension.

Creating resources and resource files is described in “Creating Resources for a Be 
Application” on page 159.

3 Start the nub on the BeBox (if it’s not already running), choose Settings from the 
MetroNub window, click the Files tab in the NubSettings window, and click Add. 
In the Add Program window that opens, type the name of your application and 
“Save” it in the folder you created in the previous step. Then close the 
NubSettings window.

Note: You must click in the Save panel’s file name field to save a file in an empty 
folder.

Though no file is saved in the folder yet, “saving” in this way tells the nub where 
to save the file it receives from the cross-debugger on the Macintosh.

4 Compile your application using the CodeWarrior IDE on the Macintosh.

5 On the Macintosh, drag your application’s symbol file onto the cross-debugger 
icon.

The application’s symbol file has the same name as the application, but with an 
“.xSYM” extension. The code for your application is displayed in the cross-
debugger windows.

6 Choose Run.

If there isn’t a copy of your application in the folder on the BeBox you specified 
in the nub, the cross-debugger transfers a copy to the BeBox and starts to execute 
the program, stopping at the main() function. When the connection is established 
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between the cross-debugger and the nub, the message in the MetroNub window 
on the BeBox changes from “Waiting” to “Connected.”

7 Set breakpoints if you want them.

Places in your code where you can set breakpoints are indicated by a small dash in 
the column to the left of the code. Click a dash to set a breakpoint there—the dash 
turns to a red dot.

8 Choose Run again.

The cross-debugger starts the application on the BeBox, and the message in the 
MetroNub window changes from “Connected” to “Debugging.”

9 When you’re done debugging your application, choose your application’s Quit 
command on the BeBox to quit it.

Caution: If you quit the nub while it’s connected to the cross-debugger, you will 
crash the nub. Always quit the cross-debugger on the Macintosh before you quit 
the nub.
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Creating Resources for a Be Application

Once you have your application on the BeBox, you need to provide it a number of 
resources, including:

• Icons that represent the application and its documents

• A unique signature that identifies the application

• Other information that will inform the way the application starts (or “launches”) 
and the way it communicates with other applications

An application’s resources are stored at the end of the executable portion of the 
application file. You can also store resources as separate files—with no required 
extension, though it’s convenient to give them “.rsrc” extensions—so you can add them 
to an application when you need them. (Be application resources must be set up on the 
BeBox; you can’t do it on the Macintosh. Be resources are not the same as a Macintosh 
resource fork.)

However, you don’t have to recreate an application’s resources each time you recompile 
the application. You can set them up once in a standalone file and leave them on the 
BeBox. When you recompile your application, you copy them into the new version of 
the recompiled application file (as described in “Adding Resources to Applications” on 
page 165).

You create and edit resources in either format—as parts of application files or as 
separate resource files—with the IconWorld application, as described in the next 
section. You also use three of the tools in /bin to list the resources in a file, remove the 
resources from a file, or copy the resources from one file to another, as described in 
“Adding Resources to Applications” on page 165.
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Using IconWorld

You create or open an application or resource file in IconWorld in a number of ways:

• Drag an application or a standalone resource file onto the IconWorld icon.

• First start IconWorld, then drag the icon for the application or resource file into 
the IconWorld window.

• Start IconWorld and use the Open command in the IconWorld window’s File 
menu to open an application or a standalone resource file. (Note that the Open 
command opens the resource portion of a file, not the data portion. Therefore, it 
won’t give you access to an image stored in a raw data file. To import a raw image 
into IconWorld, drag the file into the IconWorld window.)

• Start IconWorld and create the resources from scratch, or by copying in raw image 
data.

If you open an application file in IconWorld, the icons and other resources you create 
are added to the end of the file when you choose Save, so the resources are assigned to 
that application. If you open a standalone resource file, the resources are simply stored 
in the file when you choose Save: They aren’t assigned to an application until you add 
them to one. IconWorld’s Save As command always creates a standalone resource file, 
even if you started by opening an application.

IconWorld can deal with only one application or resource file at a time; each time it 
opens an application or resource file, it closes the one it previously had open.

Creating an Application-Information Resource

IconWorld has an App Info menu, which you can use to set up an application-
information resource for an application. This resource is of type ‘APPI’ (for “application 
information”), hence the name of the first item in the menu—Create APPI. To create or 
edit resources for a new or existing application or resource file, make sure this item is 
checked in the menu (by choosing it if it isn’t checked). None of the other items in the 
App Info menu have any effect unless Create APPI is checked.
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After Create APPI, the menu has three sections:

• Choose a launch behavior for your application—Single Launch, Multiple Launch, 
or Exclusive Launch. If you don’t make a choice, Single Launch is the default.

• Turn on the Background App flag if your application doesn’t display a user 
interface, and Argv Only if doesn’t respond to messages.

• Set the application’s identifying signature. IconWorld expects the signature to be a 
constant formed from up to four concatenated characters, such as ‘abcd’ or 
‘SLiM’. If you type numerals, such as “7890”, the numbers will form the 
multicharacter constant ‘7890’, not the integer 7,890.

To make sure the signature is unique, contact the Be Developer Support group 
(DevSupport@be.com). You will soon be able to register your resources on the 
Be world-wide web site: http://www.be.com.

For documentation on launch behaviors and the other flags, refer to “Application 
Information” in the “Application Kit” chapter of The Be Book.

Creating Icons

There are two ways to create icon resources using IconWorld. You can draw the icon in 
IconWorld, either from scratch or by modifying another icon, or you can import a raw 
bitmap file that was created elsewhere. The raw bitmap must be fully specified 24-bit 
color data.

Every icon must have both a large 32 pixel × 32 pixel version and a small 16 pixel × 16 
pixel variant. The Browser lets users choose whether to view the larger icon or the 
smaller “mini-icon.” It displays the larger one by default, but always uses the smaller 
one in list views in Browser windows and in Open and Save panels.

IconWorld assumes the drawing model discussed in “The Interface Kit” chapter of The 
Be Book. It would help to know something about that model—including high and low 
colors, patterns, and transparent pixels—before proceeding.
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Drawing Icons

The main IconWorld window has areas where you can draw both a large icon and its 
smaller counterpart. The icon pair is treated as a unit and share a single file type, as 
discussed below.

Along its right edge, the IconWorld window lists the icons and their file types. Only the 
larger icon of the pair is shown. When an icon in this list is selected, its large and small 
variants are displayed in the drawing areas. The list marks the current item by 
highlighting its border. (To start, before an application or resource file has any resources, 
an empty square is marked.)

Towards the bottom, the window displays the current icons, both large and small, in their 
actual sizes. It shows the icons as they are drawn and also as they will be highlighted by 
the Browser. Highlighting is accomplished by systematically darkening selected colors.

Icon list

Unhighlighted (as drawn)

Actual size

Highlighted

Large icon (32 x 32)

Small icon (16 x 16)
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IconWorld displays three palettes you can use for drawing icons—one of colors, one of 
tools, and one of patterns.

• Patterns are combinations of the high color (called the “front” color by 
IconWorld) and a low color (called “back”) as explained in “The Interface Kit” 
chapter in The Be Book. The default pattern is the solid high color, but you can 
pick another from the Patterns palette.

• The Colors palette lets you choose the high and low colors for whatever pattern 
you pick. The primary mouse button sets the high color and the secondary mouse 
button sets the low color (initially, these are the left and right mouse buttons, but 
you can change that as described in “Mouse” on page 127).

• The Tools palette has tools for drawing icons and for selecting portions of what is 
drawn. They should be fairly self-explanatory. Try them out to see how they work.

IconWorld gives you a transparent background to draw on. Transparency doesn’t have a 
hue, so it’s displayed on screen as white (you can think of it as a clear sheet of plastic 
laid over a white surface). In the Colors palette, the transparent color is the white square 
located at the right bottom corner.

As you draw an icon, keep an eye on how it will be highlighted. You’ll notice that pixels 
that are truly white (opaquely white) become darker when highlighted, just like other 
colors, but transparent pixels remain transparent (they stay white).

In general, you’ll want the pixels around the outside boundary of the image to be 
transparent, and pixels inside—including those that are white—to be opaque (to have a 
true color). In this way, only the image will appear to be highlighted, not the 
background. If white portions inside the image don’t darken when the image is 
highlighted, they’ll appear to be transparent and not part of the image at all.

You can think of icons as being imaged in OP_OVER mode and placed over a white 
background, so that transparency always lets that white color show through.
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Importing Icons

You can also import images into IconWorld as 24-bit color bitmaps. Drag a raw data file 
into IconWorld’s main window.

An easy way to create a raw 24-bit color bitmap is to use ResEdit or your favorite paint 
application on the Macintosh. After the icon is drawn, you need to paste it into a 32 × 32 
or a 16 × 16 document in Adobe Photoshop, or any other program that can export 24-bit 
raw bitmap data.

When creating a new file in Photoshop, set both the width and height to 32 pixels for the 
larger icon or 16 pixels for the smaller, set the resolution to 72 pixels/inch, and select 
RGB Color mode. 

Once the icon is in a correctly sized Photoshop document, choose Save As from the File 
menu, name your icon, choose Raw from the pop-up list, and click Save. Then in the 
dialog box that appears, type 0 in the Header box, click the Interleaved Order option, 
and click Save (the other options don’t matter).

Repeat this process so you have one raw file for the 32 × 32 bitmap and another for the 
16 × 16 bitmap.

After you transport the files to the BeBox (using ftp or tar, as described in Appendix B, 
“Transferring Files to and from the BeOS”), simply drag the files into the IconWorld 
window.

Although their colors will be adapted to the Be color map, IconWorld should display the 
images as you drew them. However, it interprets all white pixels as being transparent. 
Look at the way the image will be highlighted; everything that’s white stays white. 
White areas inside the image will appear to be part of the background, as holes you can 
see through. If there are truly white areas inside the image, you’ll need to repaint them 
with a shade of opaque white chosen from the Colors palette.

Setting File Types

When you save an application or resource file, IconWorld installs both the large and 
small icons in resources (of type ‘ICON’ for the large icon and ‘MICN’ for the mini-
icon).

If the icon represents the application itself (if it should be displayed for the executable 
file), its type should be ‘BAPP’. If the icon represents a kind of document or other file 
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that the application creates, its type should be identical to the type the application 
assigns to those files. Types and application signatures are assigned to files by calling 
BFile’s SetTypeAndApp() function. See the BFile class in “The Storage Kit” chapter of 
The Be Book for details.

Each saved icon needs to be associated with a file type (not to be confused with the 
‘ICON’ and ‘MICN’ resource types). The Browser uses the icon to represent files of that 
type. The file type is a multicharacter constant that, along with the application’s 
signature, uniquely identifies files belonging to the application. The constant is formed 
from four concatenated characters; you can type these characters in the space beneath 
the icon in the list along the right side of main window.

For example, the document type for the Edit application is ‘TEXT’. The Midi 
application associates its files with the ‘MIDI’ type. These types are local to the 
application—they have meaning only within the scope of the application’s signature. 
Only the signature needs to be unique between applications.

Adding Resources to Applications

You add resources to an application in one of three ways:

• Open the application itself in IconWorld and create or edit its resources. Then 
choose Save. The resources are added to the end of the application file, replacing 
any resources that were there to begin with.

• Create or edit resources in IconWorld and then use the Save As command to name 
and save the resources in a standalone resource file. Then in a Terminal window, 
type:

copyres resourcefile application

to copy the resources in resourcefile into the application file (replacing any 
existing resources).
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• Have BeIDE or the Metrowerks cross-debugger add the resources to the 
application for you: Use IconWorld to create a resource file, and use the Save As 
command to save a resource file with the same name as the application, but with 
the “.rsrc” extension. Place the file in the folder on the BeBox where you saved 
your application with BeIDE or where the cross-debugger transfers the 
application you developed on the Macintosh. Then each time you compile and 
link your application with BeIDE or use the cross-debugger, the resources are 
copied from the resource file to the application.

You can use copyres to copy resources from any application or resource file into any 
other application or resource file. Simply type copyres file1 file2, where file1 contains 
the resources you want to copy and file2 is the file to which you want to add the 
resources. If file2 already has resources, they’re replaced. If file2 doesn’t exist, copyres 
creates a resource file with that name. If you use the -a flag with copyres, a copy of the 
resources in file1 are appended to the existing resources in file2, only replacing file2 
resources if the same resources are in file1.

Two other applications in /bin are useful when working with resources: listres and 
stripres. In a Terminal window, type listres filename to view a table of the resources in 
filename. Type stripres filename to remove all resources from filename and store them 
in a standalone resource file named filename.rsrc.

Getting the Icons to Be Recognized

When you add resources to an application, the Browser should immediately display 
your application with its new icons. However, a known bug sometimes prevents it from 
doing this. To force the Browser to display the new icon, open a Terminal window, cd to 
the folder that contains the application, and enter setfile followed by the name of the 
application.
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Using the Be Debugger

The Be debugger lets you examine and alter the state of a running (or crashed) 
application. The Be debugger displays assembly language instructions. See “Using the 
Cross-Debugger” on page 154 for information on the Metrowerks symbolic debugger.

In order to be debugged, an application must be accompanied by a symbol file. Symbol 
files, which are distinguished by their “.xMAP” extensions, are created automatically 
when you compile your applications (they’re created by the mwld program). When you 
copy your application into a folder on the BeBox, be sure you copy the application’s 
symbol file into the same folder.

Entering the Debugger

There are two ways to enter the debugger: You can fall into it, or force your way in. 

• To fall into the debugger, your application must crash. Or, put more intelligibly, 
when an application crashes, it automatically enters the debugger. You can declare 
exceptional cases in your own code by using debugger() function defined in the 
Kernel Kit or the ASSERT() and DEBUGGER() macros defined by the Support Kit. 
See the Kernel Kit and Support Kit documentation in The Be Book for details.

• To force your way into the debugger, you launch the db program. Normally, you 
launch db from the command line (you can also launch db by double-clicking its 
icon in a Browser window—it lives in the /bin folder). Launched from the 
command line, db accepts an argument that names the application that you want 
to debug. For example, to debug the MyApp application, you would launch db as 
follows:

$ db MyApp

If MyApp is already running (and is a single-launch-only application), the 
debugger will “attach to” the running application. Otherwise, db causes a new 
image of the application to be launched and then takes over. 

The argument to db can also be a thread identifier. For example, let’s say MyApp 
is running and the id of its main thread is 87 (information that you got from 
running ps). To attach to the thread, we invoke db thus:

$ db 87
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Debugger Windows

When you enter the debugger, a new Terminal-like window appears. The title of the 
window will look something like this:

Team 40 Debug 2

Team 40 signifies that the team that’s being debugged is team 40. A team is the group of 
threads that belong to the same application (see the thread documentation in the Kernel 
Kit chapter of The Be Book if you need a more detailed description of teams). Debug 2 
is simply an identifier for the window.

The team designation implies that the scope of the debugging process is team-wide. And 
so it is: Even though you may have invoked the debugger by telling it to attack a specific 
thread, the debug process that’s running in a particular window has access to all the 
threads that belong to the designated team. You can switch between the threads in the 
team through debugger commands, as explained in a later section.

Each team that you debug is presented in its own window, and in only one window. If 
you seperately invoke db on each of two threads that belong to the same team, the 
second invocation will “appear” in the window that was produced by the first invocation. 

Using the Debugger

A debugger window displays, initially, the assembly code instruction to which the 
debugger is currently “pointing.” The pointed-to instruction will not yet have been 
executed. (The format of the instruction display is described in the section “Instruction 
Display” on page 170.)

Immediately below the instruction display is the debugger prompt. The prompt displays 
the name of the thread that you’re debugging, followed by a colon. For example, if 
you’re debugging MyApp’s main thread, the prompt would look like this:

MyApp:

To this prompt you type commands that let you examine and manipulate your 
application. The section “The Commands” on page 171 lists and describes all the 
debugger commands that are currently implemented. 
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Conventions

Some debugger commands take arguments; typically, these arguments are address or 
data values. The following rules apply to the interpretation of the values that you pass to 
the debugger (in the following examples, the debugger prompt is shown as “db:”):

• Numeric values are taken as hexadecimal. For decimal interpretations, prepend 
‘#’. For example, “#16” (decimal 16) is the same as “10” (hexadecimal 10).

• Numeric values can be arithmetic expressions. db knows how to add, subtract, 
divide, and multiply, and can group expressions.

• An expression without a command displays the value in hexadecimal, decimal, 
and as a string.

• Register identifiers (r0...r31, pc, lr, and so on) can be used in expressions. Also, 
register values can be set directly. For example:

db: pc = 800003b0

sets the program counter to the instruction located at the absolute address 
0x80003b0.

• Symbols can be used in expressions. db performs auto-completion on 
unambiguous partial symbol names.

• Symbol names that look like hexadecimal numbers can be distinguished with a 
backquote; for example, 

db: ‘abc

finds the symbol “abc”, not the number 0xabc.
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• The most recently entered address is represented by a dot ( . ). For example,

db: il 80000248 #4
...
db: il . #8
...
db: il . #16
...

displays, successively, four, eight, and sixteen instructions starting at address 
0x80000248.

• The circumflex character ( ^ ) following an address performs indirection.

Instruction Display

The output of commands that display instructions follows this format:

function:
+offset:hexDumpoparg1, arg2, ..., argN

The ingredients are:

• function is the name of the function that the thread (the thread that the debugger is 
examining) is currently executing.

• offset is the location of the current instruction, given as a hexadecimal offset into 
the function.

• hexDump is the instruction itself, encoded as a hexadecimal machine instruction.

• op and arg1, arg2, ... argN is the instruction presented in a more readable form. op 
is the instruction’s assembly language operator (such as lwi, addi, bc, and so on). 
The arg values are the operator’s arguments.

If the instruction’s location isn’t within 64k of a recognizable symbol, the function: line 
is omitted, and the instruction’s absolute address is given (in place of the +offset value).
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The Commands

General Commands

Command Meaning

h Help; display the list of db commands.

cv value Convert value from decimal to hex, or from hex to decimal 
(as value does or doesn’t have a prepended ‘#’).

a Repeat the previous command verbatim.

<Enter> Continue the previous command. (Exactly what 
“continuing” means depends on the command.)

es Exit to Shell; attempts to exit the current application (which 
can be perilous).

exit A synonym for es.

Displaying and Setting Memory, Registers, and Symbols

Command Meaning

dm address count Display count bytes of data starting at the given address. 

sm address value Set the data at the given address to value.

db | dh | dw address Display address as a byte, half-word, or full-word.

sb | sh | sw address value Set address as the byte, half-word, or full-word given by 
value.

wh address Tell where address is (as an offset into a function or a 
portion of memory, for example).

regs Display the contents of the CPU registers.

set symbol value Sets the value of symbol. You can use this command to 
create new symbols.

sd prefix Symbol dump; display the symbols whose names start with 
prefix (case insensitive).
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svd Displays all symbols, but in order of their values.

smd prefix Symbol method dump; display the symbols whose method 
names start with prefix.

Displaying Frames and Instructions

Command Meaning

sc Stack crawl; list the frames on the stack.

il address [ count ] List count instructions starting at address; count defaults to 
5.

ip [ address ] List a page of instructions starting at address; the argument 
defaults to pc – 20.

Stepping and Breaking

Command Meaning

s Step one instruction.

so Step one instruction without entering a function call.

t Same as so.

g Go; continue without stopping until the program hits a 
breakpoint (or exits).

gt address Go to; continue until the instruction at address is met. (This 
creates a one-shot breakpoint.)

mr “Magic Return”; runs until returned form the saved return 
address in the current frame (usually the current function, 
unless it is a “leaf” routine with no stack frame).

br [ address ] Set a breakpoint at address. Without the argument, this 
displays all breakpoints.

cb address Clear the breakpoint at address.

cab Clear all breakpoints.
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Accessing Other Threads in the Team

Command Meaning

ps Display information about the threads in this team.

nx Switch to the “next” suspended thread in the team.

stch Toggle the “stop-child” state. If child stopping is on, 
threads that are (subsequently) spawned by this thread are 
suspended at their first instruction. A spawned thread 
assumes the stop-child state of its parent.
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7 The BeBox Ports

The BeBox is designed to facilitate a wide variety of I/O (input/output) connections. There 
are industry-standard and custom ports on the motherboard, some accessible on the back 
panel of the BeBox and some from inside. There are also a number of ports on the Be I/O 
board, most of which are available from the back panel.

This chapter describes the internal and external BeBox ports. The ports are illustrated 
from the perspective of a user looking into them. If a port has a label on the motherboard 
or I/O board, the label is included in parentheses in the title of the section that describes 
the port.

For information on opening the BeBox to access the internal ports, connecting internal and 
external devices, and devices that are compatible with the BeBox, see Chapter 1, 
“Assembling the BeBox.”
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Internal Ports

A number of BeBox ports, including those for internal disk drives, are available only by 
opening the BeBox.

The BeBox Motherboard
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Logic Analyzer Probe Interrupts
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PCI/ISA
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Controller
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Serial
UARTs
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I/O Board Connector
Geekport™ Fuses

Battery

603
CPU

603
CPU

TM
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Internal BeBox Motherboard Ports

Front Panel Port (J1)

Pin I/O Signal Name Pin I/O Signal Name

1 O PowerLED+ 2 NA PowerLED–

3 O DiskLED+ 4 NA DiskLED–

5 I Interrupt SW 6 NA GND

7 I Reset SW 8 NA Reset RTN

9 O LED_D0 10 NA +5V

11 O LED_D1 12 NA +5V

13 O LED_D2 14 NA +5V

15 O LED_D3 16 NA GND

17 O LED_D4 18 NA GND

19 O LED_D5 20 NA GND

21 O LED_D6 22 NA GND

23 O LED_D7 24 NA GND

25 NA Reserved 26 NA Reserved

Speaker Port (J2)

Pin I/O Signal Name Pin I/O Signal Name

1 O SPEAKER + 2 O SPEAKER –

1
2

25
26

12
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Logic Analyzer Probe Port (J3)

The pin-out for the logic probe interface is available upon request from Be, Inc.

Be can supply a card and analyzer set-up libraries that connect the CPU bus to an 
HP 1660A.

Please contact Be developer support (e-mail: devsupport@be.com) for information on 
using this port.
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Floppy Disk Drive Connector (J4)

The 32-pin floppy connector is compatible with industry-standard, 3.5-inch floppy disk 
drives and flat-ribbon cables.

Pin I/O Signal Name Pin I/O Signal Name

1 NA GND 2 O DEN0

3 NA GND 4 NA N/C

5 NA GND 6 O DEN1

7 NA GND 8 I –INDEX

9 NA GND 10 O –MTR0

11 NA GND 12 O –DR1

13 NA GND 14 O –DR0

15 NA GND 16 O –MTR1

17 NA GND 18 O –DIR

19 NA GND 20 O –STEP

21 NA GND 22 O –WDATA

23 NA GND 24 O –WGATE

25 NA GND 26 I –TRK0

27 NA GND 28 I –WP

29 NA GND 30 I –RDATA

31 NA GND 32 O –HDSEL

33 NA GND 34 I –DSKCHG

1
2

33
34
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SCSI-II Connector (J5)

The internal 50-pin SCSI-II connector is compatible with industry-standard SCSI devices 
and flat-ribbon cables.

Pin I/O Signal Name Pin I/O Signal Name

1 NA GND 2 I/O SD0–

3 NA GND 4 I/O SD1–

5 NA GND 6 I/O SD2–

7 NA GND 8 I/O SD3–

9 NA GND 10 I/O SD4–

11 NA GND 12 I/O SD5–

13 NA GND 14 I/O SD6–

15 NA GND 16 I/O SD7–

17 NA GND 18 I/O SDP–

19 NA GND 20 NA GND

21 NA GND 22 NA GND

23 NA Reserved 24 NA Reserved

25 NA N/C 26 NA Term Power

27 NA Reserved 28 NA Reserved

29 NA GND 30 NA GND

31 NA GND 32 I/O ATN–

33 NA GND 34 NA GND

35 NA GND 36 I/O BSY–

37 NA GND 38 I/O ACK–

39 NA GND 40 I/O RST–

41 NA GND 42 I/O MSG–

43 NA GND 44 I/O SEL–

45 NA GND 46 I/O C/D–

47 NA GND 48 I/O REQ–

49 NA GND 50 I/O I/O–

1
2

49
50
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IDE Connector (J6)

The 40-pin internal IDE connector is compatible with industry-standard IDE devices and 
flat-ribbon cables.

Pin I/O Signal Name Pin I/O Signal Name

1 O –RESET 2 NA GND

3 I/O D7 4 I/O D8

5 I/O D6 6 I/O D9

7 I/O D5 8 I/O D10

9 I/O D4 10 I/O D11

11 I/O D3 12 I/O D12

13 I/O D2 14 I/O D13

15 I/O D1 16 I/O D14

17 I/O D0 18 I/O D15

19 NA GND 20 NA KEY PIN

21 O DMARQ [5] 22 NA GND

23 O DIOW– 24 NA GND

25 O DIOR– 26 NA GND

27 NA N/C (IORDY) 28 O BALE–

29 I DMACK– [5] 30 NA GND

31 I INTRQ (IRQ 14) 32 I IOCS16–

33 O DA1 34 NA N/C (PDIAG)

35 O DA0 36 O DA2

37 O CS1FX– 38 O CS3FX–

39 I DASP– 40 NA GND

1
2

39
40
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DRAM SIMM Slots (J7 through J14)

The BeBox uses PC-standard, 72-pin, 60-nanosecond, fast-page mode SIMMs.

The BeBox can use SIMMs that are either 32 or 36 bits wide. Though you can use parity 
SIMMs, parity isn’t supported in the current release of the BeOS.

For more information on adding SIMMs to the BeBox, see “Adding Memory” on page 4.

PCI Slots (J16,17,18)

The BeBox uses PC-standard PCI connectors for a 32-bit, 5V card. 3.3V is supplied to the 
connector, as per the PCI specification. For more information about the PCI specification, 
see the PCI Specification, revision 2.0 or higher, or PCI System Architecture by Tom 
Shanley and Don Anderson (Mindshare), ISBN 1-881609-08-1.

Interrupts: INT A, B, C, and D are bused together on each slot. Each slot connects to both 
the legacy interrupt controller (inside the PCI-ISA bridge) and the Be Interrupt Controller.

ISA Interrupt Be Interrupt 
IDSEL (82378) (Master/Slave)

J16 AD13 PCI1 DH11

J17 AD14 PCI2 DH12

J18 AD15 PCI3 DH13

ISA Slots (J19 through J23)

The BeBox uses PC-standard, 16-bit ISA slots and timing. The timing is generated by the 
Intel 82378 PCI-ISA bridge. On-board I/O devices are isolated by buffers on the 
motherboard.

Please refer to the ISA Specification or ISA System Architecture by Tom Shanley and Don 
Anderson (Mindshare), ISBN 1-881609-05-7.
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Power Connectors (J15)

The power connectors are compatible with industry-standard PC devices.

P8 Power Connector:

Pin Signal Name

1 GND

2 GND

3 –12V

4 +12V

5 +5V

6 Power Good

P9 Power Connector:

Pin Signal Name

1 +5V

2 +5V

3 +5V

4 –5V

5 GND

6 GND

1616

P9P8
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Internal I/O Board Port

CD-ROM Drive Pass-Through Connector

The CD-ROM drive pass-through cable connector on the I/O board is compatible with the 
pass-though port on a MediaVision ProAudio Spectrum 16 sound card.

Pin I/O Signal Name

1 NA N/C

2 I CD Audio Right

3 I CD Audio Shield Return

4 I CD Audio Left

5 NA N/C

15
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External BeBox Ports

Many of the BeBox ports are available from the back panel. (In the following illustration, 
the power supply fan vents and power sockets are rotated 180 degrees.)

Be, Inc.
Menlo Park, CA
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Parallel Port (J27)

The Be parallel port is a PC-standard parallel port. It supports EPP and ECP modes.

Pin I/O Signal Name Pin I/O Signal Name

1 O –STB 14 O –AFD

2 I/O Data 0 15 I –ERR

3 I/O Data 1 16 O –INIT

4 I/O Data 2 17 O –SLIN

5 I/O Data 3 18 NA GND

6 I/O Data 4 19 NA GND

7 I/O Data 5 20 NA GND

8 I/O Data 6 21 NA GND

9 I/O Data 7 22 NA GND

10 I –ACK 23 NA GND

11 I BUSY 24 NA GND

12 I PE 25 NA GND

13 I SLCT

SHELL NA Chassis GND

112

25 13



External BeBox Ports

Be User’s Guide Chapter 7: The BeBox Ports  –  187

Keyboard Connector (J25)

The Be keyboard port is a PC-standard keyboard port.

Pin I/O Signal Name

1 I/O Clock

2 I/O Data

3 NA Reserved

4 NA GND

5 NA +5VDC (Fused)

SHELL NA Chassis GND

12

3
4

5
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External SCSI-II Connector (J26)

The external SCSI-II connector is a PC-standard, compact 50-pin connector.

Pin I/O Signal Name Pin I/O Signal Name

1 NA GND 26 I/O SD0–

2 NA GND 27 I/O SD1–

3 NA GND 28 I/O SD2–

4 NA GND 29 I/O SD3–

5 NA GND 30 I/O SD4–

6 NA GND 31 I/O SD5–

7 NA GND 32 I/O SD6–

8 NA GND 33 I/O SD7–

9 NA GND 34 I/O SDP–

10 NA GND 35 NA GND

11 NA GND 36 NA GND Sense*

12 NA Reserved 37 NA Reserved

13 NA N/C 38 O Term Power

14 NA Reserved 39 NA Reserved

15 NA GND 40 NA GND

16 NA GND 41 I/O ATN–

17 NA GND 42 NA GND

18 NA GND 43 I/O BSY–

19 NA GND 44 I/O ACK–

20 NA GND 45 I/O RST–

21 NA GND 46 I/O MSG–

22 NA GND 47 I/O SEL–

23 NA GND 48 I/O C/D–

24 NA GND 49 I/O REQ–

25 NA GND 50 I/O I/O–

SHELL NA Chassis GND

* Pin 36 must be externally connected to ground to disable on-board SCSI termination.

1

26

25

50
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Headphone Port

The headphone port is compatible with standard stereo headphones with 3.5 mm jacks.

Contact Signal Name

Sleeve Common

Ring Right

Tip Left

Microphone Port

The microphone port is compatible with standard microphones with 3.5 mm jacks.

Contact Signal Name

Sleeve Common

Ring Right

Tip Left

Line-In Left Port

The four BeBox audio ports are line level, not microphone level; they’re compatible with 
standard audio equipment.

Contact Signal Name

Sleeve Common

Tip Left
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Line-In Right Port

Contact Signal Name

Sleeve Common

Tip Right

Line-Out Left Port

Contact Signal Name

Sleeve Common

Tip Left

Line-Out Right Port

Contact Signal Name

Sleeve Common

Tip Right



External BeBox Ports

Be User’s Guide Chapter 7: The BeBox Ports  –  191

MIDI-In Ports

Pin I/O Signal Name

1 NA N/C

2 NA N/C

3 NA N/C

4 I MIDI RXDAT +

5 I MIDI RXDAT –

Shell N/A N/C

MIDI-Out Ports

Pin I/O Signal Name

1 NA N/C

2 NA Cable Shield

3 NA N/C

4 I MIDI RXDAT +

5 I MIDI RXDAT –

Shell N/A Chassis Ground

12

3
4

5

12

3
4

5
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Serial Ports

Pin I/O Signal Name

1 I DCD

2 I SIN

3 O SOUT

4 O DTR

5 NA Signal GND

6 I DSR

7 O RTS

8 I CTS

9 I RI

SHELL NA Chassis GND

1

9

5

6
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GeekPort

The GeekPort is a custom I/O port designed for the BeBox.

Pin I/O Signal Name Pin I/O Signal Name

1 NA DGND 20 I/O PA0

2 I/O PA1 21 I/O PA2

3 I/O PA3 22 I/O PA4

4 I/O PA5 23 I/O PA6

5 I/O PA7 24 NA AGND

6 NA DGND 25 I A/D_0

7 NA +5V (Fused) 26 I A/D_1

8 NA Power GND 27 I A/D_2

9 NA +12V (Fused) 28 I A/D_3

10 NA Power GND 29 0 D/A_0

11 NA –12V (Fused) 30 0 D/A_1

12 NA Power GND 31 0 D/A_2

13 NA +5V (Fused) 32 0 D/A_3

14 NA DGND 33 NA AGND

15 I/O PB0 34 I/O PB1

16 I/O PB2 35 I/O PB3

17 I/O PB4 36 I/O PB5

18 I/O PB6 37 I/O PB7

19 NA DGND SHELL NA Chassis Ground

119

2037
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Joystick Ports

The BeBox has two standard PC joystick ports. You can connect a single joystick to each 
connector, or two joysticks to each connector (for a total of four) using standard Y cables.

Pin I/O Signal Name Pin I/O Signal Name

1 NA +5V 9 I/O +5V

2 I BTN0_0 10 I BTN1_0

3 I X_0 11 I X_1

4 NA GND 12 NA GND

5 NA GND 13 I Y_1

6 I Y_0 14 I BTN1_1

7 I BTN0_1 15 NA +5V

8 NA +5V SHELL NA Chassis Ground

18

915
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IR Ports

The IR (infrared) ports are a new feature of the BeBox. The connector is a 4-pin DIN type.

Each IR port supports input, output, or I/O devices. The interface is designed so that a 
single IR LED may be connected between pin 3 (+5V) and pin 1(IROUT), without 
additional external components. 

Pin I/O Signal Name

1 I/O IROUT

2 I IRIN

3 NA +5V(Fused)

4 NA GND

SHELL NA Chassis Ground

Mouse Port

The BeBox mouse port is compatible with PC-standard, PS/2 mice.

Pin I/O Signal Name

1 I/O Data

2 NA Reserved

3 NA GND

4 NA +5V(Fused)

5 I/O Clock

6 NA Reserved

SHELL NA Chassis Ground

3

12

4

3

12

4

56
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A Creating Screen 
Dumps

You can capture images of the BeBox screen (“screen dumps”) and open them in the 
ImageViewer application. You can also convert the screen dumps you create into a 
format that’s understood by Adobe Photoshop on the Macintosh and in other 
applications.

Capturing a Screen Dump

To capture a screen dump, press the Print Screen key. This saves a Be ImageViewer file 
with an image of the screen in the root folder of the boot disk. The first dump you 
capture in this way is named screen1, the second screen2, and so on. You can double-
click these files to view them in ImageViewer.

The size of the screen dump matches the resolution of the screen: 640 × 480, 800 × 600, 
and so on (for more information on setting the screen resolution, see “Screen” on 
page 135). 

Converting a Screen Dump to Raw Format

If you want to work with a screen dump or other ImageViewer file on a Macintosh, you 
can save it in a “raw” format, which you can open in Adobe Photoshop and other image-
editing applications.
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To convert an ImageViewer file, double-click it to open it in the ImageViewer 
application on the BeBox. Then choose the “Export to 24 Bits” command from the 
ImageViewer window’s File menu. This saves a raw version of the file in the root folder 
of your boot disk, with the name screen.raw.

Opening a Raw ImageViewer File in Photoshop

Once you’ve converted an ImageViewer file to raw format, you can use ftp or tar to 
move it to a Macintosh (for more information, see Appendix B, “Transferring Files To 
And From the BeOS”).

When the raw file is on the Macintosh, start Photoshop, choose Open from its File 
menu, and double-click the file you want to open.

In the dialog box that appears, enter the width and height in pixels that matches the 
resolution of the BeBox screen when you created the screen dump: 640 × 480, 800 × 
600, and so on. Enter 3 in the Count box and make sure Interleaved is checked and the 
Depth is set to 8 Bits. Then click OK.

The Be file opens in Photoshop, where you can edit it, save it in other formats, and do 
any other work you want.
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B Transferring Files 
to and from the 
BeOS

There are two ways to transfer files to and from the BeBox and a Macintosh or other 
computer: Over a network or serial cable with ftp or with a floppy disk using tar.

Using ftp

You can use ftp, the “file transfer protocol” utility, to transfer files between a Macintosh 
(or any other computer that can run ftp) and a BeBox. To use ftp on a BeBox, you need 
to install an Ethernet adapter (as described in “Adding a Network Adapter” on page 6) or 
a null modem cable between the BeBox and another computer. You also need to use 
Network to configure the BeBox to communicate with the network or null modem cable 
(as described in “Network” on page 128). 

ftp software is part of the BeOS, but you need to obtain ftp software for the Macintosh or 
other computer you want to exchange files with. There are a number of ftp packages 
available for the Macintosh. One good one, called Netpresenz (the successor to another 
good program, called FTPd), is available as “shareware” from a number of ftp and 
world-wide web sites on the Internet. (Shareware is software you can download and try 
out for free, but if you decide to keep it, you pay a small fee to its author.) Netpresenz 
makes it possible to get files from a Macintosh using ftp on another computer, such as 
the BeBox. Another good shareware application is Anarchie. Anarchie makes it possible 
to get files from another computer that can host an ftp session. To find an Internet site 
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where you can get a copy of Netpresenz and Anarchie, visit ftp.share.com/peterlewis 
(an ftp site) or http://www.share.com/peterlewis (a web site).

You start ftp on the BeBox by double-clicking the Terminal application (in /apps) and in 
the window that opens, typing ftp followed by the IP address of the computer you want 
to connect to. If you have a DNS server on your network, or if you’ve set up a 
/system/hosts file, you can use the names and aliases in that file instead of the address:

ftp hostname

If ftp can find the other computer on the network and establish a connection, ftp displays 
a message such as:

Connected to hostname.node.com
220 Peter’s Macintosh FTP daemon v2.2.0 awaits your command.

ftp then asks you to log in to the other computer:

Name (default hostname:default username):_

Supply your name as you’re known on the other computer and press Enter. ftp then asks 
for a password, if required:

Password:_

The password you supply here is the one that you use on the other computer. 

After the password is verified, you can transfer files between the two machines. To do 
this, you type ftp commands at the prompt.

The first command you should type is help:

ftp> help

This lists all the commands ftp recognizes. For more help on a specific command, type 
help command:

ftp> help cd
cd change remote working directory
ftp>

When examining the commands, keep in mind that the local computer is the BeBox; the 
remote computer is the one on the other end of the Ethernet or serial cable.
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Among the most commonly used commands are:

bin To transfer files in binary mode (required for the Macintosh)
cd To change directories on the remote machine
ls To list the contents of remote directories
get To retrieve a single file from the remote machine
mget To retrieve more than one file
put To transfer a file to the remote machine
mput To transfer more than one file
prompt To use mget or mput for many files, without approving each file
quit To end the ftp session

For example, to transfer the files MyApp and MyApp.xMAP from the Projects folder 
on the Macintosh to the MyAppProject directory on the BeBox:

ftp> bin
200 Type set to I, binary transfer mode [macbinary disabled].
ftp> lcd /MyAppProject
Local directory now BeHardDisk:/MyAppProject
ftp> cd /MacHardDisk/Projects
250 “/MacHardDisk/Projects” cd successful.
ftp> prompt
Interactive mode off.
ftp> mget MyApp*
local: MyApp remote: MyApp
200 PORT command successful.
150 Binary transfer started (144k).
226 Transfer complete.
146693 bytes received in 1.63 seconds (89775 bytes/sec)
local: MyApp.xMAP remote: MyApp.xMAP
200 PORT command successful.
150 Binary transfer started (70k).
226 Transfer complete.
71282 bytes received in 1.28 seconds (55515 bytes/sec)
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Using suntar

If you have a Macintosh and BeBox but they aren’t connected to an Ethernet network or 
with a null modem cable, you can use the tar utility to transfer files via floppy disk. tar is 
included with the BeOS, but you need to obtain a copy of suntar—the free Macintosh tar 
utility. You can download suntar from http://www.be.com (the Be web site) or 
ftp.be.com/pub/OtherUtilities (on the Be ftp site).

In suntar, you can do everything you need to do using the commands in the Write menu:

1 Choose “Create new tar archive” from suntar’s Write menu.

A dialog box prompts you to insert a disk.

2 Choose the “Write data fork...” command (Macintosh resource forks are of no use 
on the BeBox). In the dialog box that appears, select the file you want to transfer 
and click Open. Or click Write Folder to write all the files in the current folder, or 
Write Selected Files to open a dialog box where you can select more than one file.

You can choose “Write data fork...” as many times as necessary to put everything 
you want into the archive.

3 Choose the “End of writing” command and quit suntar.

The disk is ejected.

4 On the BeBox, double-click Terminal (in /apps), insert the disk, and type:

tar xv

The files in the archive are copied onto the BeBox.



Be User’s Guide Appendix C: Troubleshooting  –  203

CTroubleshooting

If you’re having trouble with the BeBox, you may be able to narrow down or even fix 
the problem by reviewing the symptoms and suggestions in this appendix. If the 
suggestions in this appendix fail to solve the problem, contact Be customer service at 
custservice@be.com.

Trouble Booting

Utter Darkness

Check that you have a working power outlet: Unplug the BeBox and plug in 
something a lot simpler, like a lamp. If the power outlet is controlled by a switch, make 
sure the switch is turned on.

Check that the voltage switch is set correctly for your area: The voltage switch is a 
small sliding switch next to the BeBox power, as described in “Connecting External 
Devices” in Chapter 1.
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Sound but No Light, or Vice Versa

Check that all cables and cards are firmly connected: Following the instructions 
in Chapter 1 of this guide, open the BeBox and make sure that all cables, cards, and 
SIMMs are firmly seated in their connectors and slots. Then reassemble the BeBox and 
make sure that all external cables and the power cord are securely connected to the 
correct ports.

Watch that memory passes the memory test: When you first turn on the BeBox it 
performs a memory test: It trys writing to and reading from each pair of installed 
SIMMs. As it tests writing to a pair of SIMMs, the left LED array on the front of the 
BeBox illuminates in a rising and falling pattern; as it tests reading from a pair of 
SIMMs, the right LED array illuminates in the same way. If you don’t see this LED 
pattern, first check that all SIMMs are firmly seated in their sockets. Then try swapping 
out SIMMs to see if you can identify a bad one.

Check that all the cards you added are compatible with the BeBox: Revisit 
Chapter 1 of this guide and the products are of the Be world-wide web site 
(http://www.be.com/products) to make sure any cards you’ve added to the BeBox are 
the exact models supported in DR8.

Make sure SCSI disks are correctly terminated and don’t have ID conflicts: 
Review the instructions in Chapter 1, particularly “Adding an Internal Disk Drive” on 
page 7,“Connecting a SCSI CD-ROM Drive” on page 13, and the SCSI disks’ owner’s 
guides, and make sure each SCSI device has a unique SCSI ID and is terminated (or not 
terminated) correctly.
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Use the boot selection screen to check for bootable disks: If you hold down any 
key immediately after you turn on the BeBox, the boot selection screen opens, as 
described in “Selecting a Boot Disk” on page 16. The boot selection screen lists all disks 
it can find that have a plausible /system folder on them.

Watch for disks to be recognized on a terminal: Connect a terminal to the BeBox, as 
described in “Connecting a Terminal” below, and watch for messages about disks being 
found.

Check the contents of the floppy and CD-ROM drives: The BeBox tries to boot 
from a floppy and then a CD-ROM drive if it can find anything resembling a functional 
/system folder on one of them.

Try using a default screen setting: You can force the BeOS to revert to the default 
screen settings when booting if you hold down the spacebar as soon as the Be logo 
disappears. Or if you’re already booted but the screen is a mess, press Command-
Control-Shift-F12, using the modifier keys on the left side of the keyboard, to force the 
BeOS to revert to default screen settings.

Rebuilding the Database

If the BeBox boots but the Browser never starts, you may have a corrupted Be database. 
You can rebuild the database by selecting the “Erase their databases” option in the boot 
selection screen, which opens if you press any key immediately after turning on the 
BeBox (for more information on the boot selection screen, see “Selecting a Boot Disk” 
on page 16).

Caution: Rebuild the Be database only as a last resort. Rebuilding the database erases all 
information you’ve added to it: You lose all your e-mail, your window layouts, your 
arrangement of icons on the dock, your database of audio CDs, and all other information 
you’ve stored in the Be database.
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Trouble After Booting

An unpleasant window with “Team” in the title opens: This is the Be Debugger 
window. It opens when an application crashes. If you wrote the application, refer to 
“Using the Be Debugger” on page 167. If you didn’t write the application, try typing es 
and pressing Enter to close the Debugger window and to quit the crashed application 
cleanly. Then it’s usually a good idea to save any open files and restart the BeOS.

An application goes south, but others don’t seem affected: You can force an 
application to die a violent death by holding down the keys labeled “Ctrl,” “Alt,” and 
“Shift” on the right side of the keyboard while you choose the application from the 
application list. Then it’s usually a good idea to save any open files and restart the 
BeOS.

The BeOS freezes up: You have to restart the BeOS. First try pressing the keys labeled 
“Ctrl,” “Alt,” and “Del” at the same time. If that doesn’t work, reset the BeBox by 
pressing the Reset and Interrupt buttons at the same time, as described in “Resetting the 
BeBox” on page 19.

When you try to shut down or restart, a panel informs you that an application isn’t 
responding: This usually happens when an application has crashed, though it can be 
because an application is actually still finishing something you asked it to do. When you 
get tired of waiting, click Blow It Away in the panel.

An application that uses the new Game Kit crashes: The creator of the game kit 
included an escape hatch for rogue games: Press press Command-Control-Shift-F12, 
using the modifier keys on the left side of the keyboard, to escape from the game.
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Connecting a Terminal

The BeOS system software and applications send information out serial port 4 if you 
hold down the F1 key on the keyboard for a few seconds after turning on the BeBox. If 
you have a computer or terminal with a serial port, you can connect it to serial port 4 on 
the BeBox using a “null modem” cable and see these messages. Set the terminal’s 
communications parameters to 19200 baud, 8 data bits, no stop bits, and no parity.

Note: The messages applications send out the serial port are often misleading and 
alarmist; many of them were written by people for whom English is not their first 
language. So it’s best to take what you see on a terminal with a grain of salt.
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